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Introduction

Why does the world need Yet Another Web Framework?

 

This is the question that is most likely on your mind — or perhaps it’s what you were thinking when you saw this book sitting on the shelf. We each asked ourselves this many times over the last few years.

 

Indeed there are many frameworks out there today flavored with every buzzword the industry can think of. In short, it’s easy to be skeptical. Yet as we, the authors, delve deeper into the latest and greatest web framework, we’re each starting to realize just how far the industry has come in the last 10 years.

 

Rob began programming for the Web with Classic ASP in 1997 and was giddy with excitement. When .NET came out, he remembers running around his office, stopping everyone from working and explaining that the world just tilted on its axis.

 

We all feel the same way about ASP.NET MVC. Not because it’s “something different” but because it offers developers the ultimate chance to “do it their way.” You don’t like the way the platform renders the View? Change it! Just about every part of the ASP.NET MVC Framework is “swappable” — if the shoes pinch, get different shoes. Don’t like ties? Why not a bow tie? You’re totally in control.

 

ASP.NET MVC is a web framework that comes with a bunch of conventions to make your life easier when you follow them, but if you don’t want them, the framework is quick to step out of your way so that you can get your work done in the way you like.

 

This book is going to go into the “out-of-the-box” experience you’ll have with ASP.NET MVC, but more importantly you’ll learn practical ways that you can extend ASP.NET MVC with your own magic — then hopefully share that magic with others.

 

Because of this extensibility and attention to “doing it your way,” we’re happy to embrace Yet Another Web Framework and hope you are willing to come along with us for the ride.




Who This Book Is For 

This book is for web developers who are looking to add more complete testing to their web sites, and who are perhaps ready for “something different.”

 

In some places, we assume that you’re somewhat familiar with ASP.NET Web Forms, at least peripherally. There are a lot of ASP.NET Web Forms developers out there who are interested in ASP.NET MVC, so there are a number of places in this book where we contrast the two technologies. Even if you’re not already an ASP.NET developer, you might still find these sections interesting for context, as well as for your own edification, as ASP.NET MVC may not be the web technology that you’re looking for.

 

It’s worth noting, yet again, that ASP.NET MVC is not a replacement for ASP.NET Web Forms. Many web developers have been giving a lot of attention to other web frameworks out there (Ruby on Rails,

Django), which have embraced the MVC (Model-View-Controller) application pattern, and if you’re one of those developers, or even if you’re just curious, this book is for you.

 

MVC allows for (buzzword alert!) a “greater separation of concerns” between components in your application. We’ll go into the ramifications of this later on, but if it had to be said it in a quick sentence:  ASP.NET MVC is ASP.NET Unplugged. ASP.NET MVC is a tinkerer’s framework that gives you very fine-grained control over your HTML and JavaScript, as well as complete control over the programmatic flow of your application.

 

There are no declarative server controls in MVC, which some people may like, others may dislike. In the future, the MVC team may add declarative view controls to the mix, but these will be far different from the components that ASP.NET Web Forms developers are used to, in which a control encapsulates both the logic to render the view and the logic for responding to user input etc. Having all that encapsulated in a single control in the view would violate the “separation of concerns” so central to this framework. The levels of abstraction have been collapsed, with all the doors and windows opened to let the air flow freely.

 

The final analogy we can throw at you is that ASP.NET MVC is more of a motorcycle, whereas ASP.NET Web Forms might be more like a minivan, complete with airbags and a DVD player in case you have kids and you don’t want them to fight while you’re driving to the in-laws for Friday dinner. Some people like motorcycles, some people like minivans. They’ll both get you where you need to go, but one isn’t technically better than the other.




How This Book Is Structured 

This book is divided into three very broad sections, each comprising several chapters.

 

The first third of the book is concerned with introducing the MVC pattern and how ASP.NET MVC implements that pattern.

 

Chapter 1 starts off with a description of the Model-View-Controller pattern, explaining the basic concepts of the pattern and providing a bit of its history. The chapter goes on to describe the state of the MVC pattern on the Web today as it is implemented by various frameworks, such as ASP.NET MVC.

 

Chapter 2 covers the ways that ASP.NET MVC is different from ASP.NET Web Forms and how to get ASP.NET MVC up and running.

 

Chapter 3 explores the structure of a standard MVC application and covers what you get out of the box. It covers some of the conventions and the digs a little under the hood to take a look at the entire request lifecycle for an ASP.NET MVC request.

 

Chapter 4 digs deep into routing to describe the role that URLs play in your application and how routing figures into that. It also differentiates routing from URL rewriting and covers a bit on extending routing and writing unit tests for routes.

 

Chapter 5 takes a look at controllers and controller actions — what they are and how to write them. It also covers action results, which are returned by controller actions and what they are used for.

 

Chapters 6 -7 cover views and view engines, and then add a little flavor on top by examining the role that AJAX plays in your views.

The second third of the book focuses entirely on advanced techniques and extending the framework.

 

Chapter 8 goes into detail on action filters, which provide an extensibility point for adding cross-cutting behaviors to action methods.

 

Chapter 9 covers security and good practices for building a secure application.

 

Chapter 10 covers various approaches to building and interacting with different types of services made available over the Web.

 

Chapter 11 provides a brief introduction to Test Driven Development (TDD) as it applies to ASP.NET MVC. It then goes on to examine real-world patterns and practices for building applications that are testable.

 

The final part of the book covers guidance and best practices as well as providing a look ahead at the future of the ASP.NET MVC platform.

 

Chapter 12 goes into detail on how Web Forms and MVC fit together and covers ways to have the two coexist in the same application, as well as how to migrate an app from Web Forms to MVC.

 

We tried to organize the book in such a way that when you read it in order, each chapter builds on the previous one. If you already familiar with ASP.NET MVC you might skip directly to Chapter 4 and go from there.




What You Need to Use This Book 

To use ASP.NET MVC, you’ll probably want a copy of Visual Studio. You can use Visual Studio 2008 Web Developer Express SP1 or any of the paid versions of Visual Studio 2008 (such as Visual Studio 2008 Professional). If you’re going to use the Web Developer Express edition of Visual Studio, you need to confirm that you’re using SP1. ASP.NET MVC requires that you use Web Application Projects (WAPs) rather than Web Site Projects, and this functionality was added in SP1 of Web Developer Express.

 

You will also need to make sure that you have the .NET Framework 3.5 installed at minimum. The runtime does not require .NET 3.5 SP1 to run.

 

The following list shows you where to go to download the required software.

•  Visual Studio or Visual Studio Express: www.microsoft.com/vstudio or   www.microsoft.com/express  
•  ASP.NET MVC: www.asp.net/mvc  




Conventions 

To help you get the most from the text and keep track of what’s happening, we’ve used a number of conventions throughout the book.

Occasionally the product team will take a moment to provide an interesting aside, for bits of trivia, and those will appear in boxes like this:

Product Team Aside: Boxes like this one hold tips, tricks, trivia from the ASP.NET Product Team or some other information that is directly relevant to the surrounding text.



Tips, hints and tricks to the current discussion are offset and placed in italics like this.

 

As for styles in the text:•  We highlight new terms and important words when we introduce them.
•  We show keyboard strokes like this: Ctrl+A.
•  We show file names, URLs, and code within the text like so: persistence.properties.
•  We present code in two different ways:



In code examples, we highlight important code that we want to emphasize with a gray background.



The gray highlighting is not used for code that’s less important in the present context, or has been shown before.






Source Code 

The main nerddinner.com code download is hosted at codeplex and the most up-to-date code will always be available at http://www.codeplex.com/nerddinner. The original nerddinner.com code that matches the code used in the book is hosted at wrox.com from the book page.

 

As you work through the examples in this book, you may choose either to type in all the code manually or to use the source code files that accompany the book. All of the source code used in this book is available for downloading at www.wrox.com. Once at the site, simply locate the book’s title (either by using the Search box or by using one of the title lists) and click the Download Code link on the book’s detail page to obtain all the source code for the book.

Because many books have similar titles, you may find it easiest to search by ISBN; this book’s ISBN is 978-0-470-38461-9.



Once you download the code, just decompress it with your favorite compression tool. Alternately, you can go to the main Wrox code download page at www.wrox.com/dynamic/books/download.aspx to see the code available for this book and all other Wrox books.




Errata 

We make every effort to ensure that there are no errors in the text or in the code. However, no one is perfect, and mistakes do occur. If you find an error in one of our books, like a spelling mistake or faulty piece of code, we would be very grateful for your feedback. By sending in errata you may save another reader hours of frustration, and at the same time you will be helping us provide even higher-quality information.

 

To find the errata page for this book, go to www.wrox.com and locate the title using the Search box or one of the title lists. Then, on the book details page, click the Book Errata link. On this page, you can view all errata that has been submitted for this book and posted by Wrox editors. A complete book list including links to each book’s errata is also available at www.wrox.com/misc-pages/booklist.shtml.

 

If you don’t spot “your” error on the Book Errata page, go to www.wrox.com/contact/techsupport.shtml  and complete the form there to send us the error you have found. We’ll check the information and, if appropriate, post a message to the book’s errata page, and fix the problem in subsequent editions of the book.




p2p.wrox.com 

For author and peer discussion, join the P2P forums at p2p.wrox.com. The forums are a Web-based system for you to post messages relating to Wrox books and related technologies and interact with other readers and technology users. The forums offer a subscription feature to e-mail you topics of interest of your choosing when new posts are made to the forums. Wrox authors, editors, other industry experts, and your fellow readers are present on these forums.

 

At http://p2p.wrox.com you will find a number of different forums that will help you not only as you read this book but also as you develop your own applications. To join the forums, just follow these steps:1. Go to p2p.wrox.com, and click the Register link.
2. Read the terms of use, and click Agree.
3. Complete the required information to join as well as any optional information you wish to provide, and click Submit.
4. You will receive an e-mail with information describing how to verify your account and complete the joining process.


You can read messages in the forums without joining P2P, but in order to post your own messages, you must join.



Once you join, you can post new messages and respond to messages other users post. You can read messages at any time on the Web. If you would like to have new messages from a particular forum e-mailed to you, click the Subscribe to this Forum icon by the forum name in the forum listing.

 

For more information about how to use the Wrox P2P, be sure to read the P2P FAQs for answers to questions about how the forum software works as well as many common questions specific to P2P and Wrox books. To read the FAQs, click the FAQ link on any P2P page.




1

NerdDinner

The best way to learn a new framework is to build something with it. This first chapter walks through how to build a small, but complete, application using ASP.NET MVC, and introduces some of the core concepts behind it.

 

The application we are going to build is called “NerdDinner.” NerdDinner provides an easy way for people to find and organize dinners online (Figure 1-1).

 

NerdDinner enables registered users to create, edit and delete dinners. It enforces a consistent set of validation and business rules across the application (Figure 1-2).

Figure 1-1
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Figure 1-2
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Visitors to the site can search to find upcoming dinners being held near them (Figure 1-3):

Figure 1-3
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Clicking a dinner will take them to a details page where they can learn more about it (Figure 1-4):

Figure 1-4
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If they are interested in attending the dinner they can log in or register on the site (Figure 1-5):

Figure 1-5
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They can then easily RSVP to attend the event (Figures 1-6 and 1-7):

Figure 1-6

[image: 007]

Figure 1-7
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We are going to begin implementing the NerdDinner application by using the File ⇒ New Project command within Visual Studio to create a brand new ASP.NET MVC project. We’ll then incrementally add functionality and features. Along the way we’ll cover how to create a database, build a model with business rule validations, implement data listing/details UI, provide CRUD (Create, Update, Delete) form entry support, implement efficient data paging, reuse the UI using master pages and partials, secure the application using authentication and authorization, use AJAX to deliver dynamic updates and interactive map support, and implement automated unit testing.

 

You can build your own copy of NerdDinner from scratch by completing each step we walk through in this chapter. Alternatively, you can download a completed version of the source code here: http://tinyurl.com/aspnetmvc.

 

You can use either Visual Studio 2008 or the free Visual Web Developer 2008 Express to build the application. You can use either SQL Server or the free SQL Server Express to host the database.

 

You can install ASP.NET MVC, Visual Web Developer 2008, and SQL Server Express using the Microsoft Web Platform Installer available at www.microsoft.com/web/downloads.




File ⇒ New Project 

We’ll begin our NerdDinner application by selecting the File ⇒ New Project menu item within Visual Studio 2008 or the free Visual Web Developer 2008 Express.

 

This will bring up the New Project dialog. To create a new ASP.NET MVC application, we’ll select the Web node on the left side of the dialog and then choose the ASP.NET MVC Web Application project template on the right (Figure 1-8):

Figure 1-8

[image: 009]

We’ll name the new project NerdDinner and then click the OK button to create it.

 

When we click OK, Visual Studio will bring up an additional dialog that prompts us to optionally create a unit test project for the new application as well (Figure 1-9). This unit test project enables us to create automated tests that verify the functionality and behavior of our application (something we’ll cover later in this tutorial).

Figure 1-9

[image: 010]

The Test framework drop-down in Figure 1-9 is populated with all available ASP.NET MVC unit test project templates installed on the machine. Versions can be downloaded for NUnit, MBUnit, and XUnit. The built-in Visual Studio Unit Test Framework is also supported.

The Visual Studio Unit Test Framework is only available with Visual Studio 2008 Professional and higher versions). If you are using VS 2008 Standard Edition or Visual Web Developer 2008 Express, you will need to download and install the NUnit, MBUnit, or XUnit extensions for ASP.NET MVC in order for this dialog to be shown. The dialog will not display if there aren’t any test frameworks installed.


We’ll use the default NerdDinner.Tests name for the test project we create, and use the Visual Studio Unit Test Framework option. When we click the OK button, Visual Studio will create a solution for us with two projects in it — one for our web application and one for our unit tests (Figure 1-10):

Figure 1-10
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Examining the NerdDinner Directory Structure 

When you create a new ASP.NET MVC application with Visual Studio, it automatically adds a number of files and directories to the project, as shown in Figure 1-11.

Figure 1-11
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ASP.NET MVC projects by default have six top-level directories, shown in the following table:

[image: 013]

ASP.NET MVC does not require this structure. In fact, developers working on large applications will typically partition the application up across multiple projects to make it more manageable (for example: data model classes often go in a separate class library project from the web application). The default project structure, however, does provide a nice default directory convention that we can use to keep our application concerns clean.

 

When we expand the /Controllers directory, we’ll find that Visual Studio added two controller classes (Figure 1-12) — HomeController and AccountController — by default to the project:

Figure 1-12

[image: 014]

When we expand the /Views directory, we’ll find three subdirectories — /Home, /Account and /Shared — as well as several template files within them, were also added to the project by default (Figure 1-13):

Figure 1-13
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When we expand the /Content and /Scripts directories, we’ll find a Site.css file that is used to style all HTML on the site, as well as JavaScript libraries that can enable ASP.NET AJAX and jQuery support within the application (Figure 1-14):

Figure 1-14
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When we expand the NerdDinner.Tests project we’ll find two classes that contain unit tests for our controller classes (Figure 1-15):

Figure 1-15
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These default files, added by Visual Studio, provide us with a basic structure for a working application — complete with home page, about page, account login/logout/registration pages, and an unhandled error page (all wired-up and working out of the box).


Running the NerdDinner Application 

We can run the project by choosing either the Debug ⇒ Start Debugging or Debug ⇒ Start Without Debugging menu items (Figure 1-16):

Figure 1-16
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This will launch the built-in ASP.NET web server that comes with Visual Studio, and run our application (Figure 1-17):

Figure 1-17
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FIgure 1-18 is the home page for our new project (URL: /) when it runs:

Figure 1-18
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Clicking the About tab displays an About page (URL: /Home/About, shown in Figure 1-19):

Figure 1-19
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Clicking the Log On link on the top right takes us to a Login page shown in Figure 1-20 (URL: /Account/LogOn)

Figure 1-20
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If we don’t have a login account, we can click the Register link (URL: /Account/Register) to create one (Figure 1-21):

Figure 1-21
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The code to implement the above home, about, and login/register functionality was added by default when we created our new project. We’ll use it as the starting point of our application.


Testing the NerdDinner Application 

If we are using the Professional Edition or higher version of Visual Studio 2008, we can use the built-in unit-testing IDE support within Visual Studio to test the project.

 

Choosing one of the above options in Figure 1-22 will open the Test Results pane within the IDE (Figure 1-23) and provide us with pass/fail status on the 27 unit tests included in our new project that cover the built-in functionality.

Figure 1-22

[image: 024]

Figure 1-23
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Creating the Database 

We’ll be using a database to store all of the Dinner and RSVP data for our NerdDinner application.

 

The steps below show creating the database using the free SQL Server Express edition. All of the code we’ll write works with both SQL Server Express and the full SQL Server.


Creating a New SQL Server Express Database 

We’ll begin by right-clicking on our web project, and then selecting the Add ⇒ New Item menu command (Figure 1-24).

Figure 1-24
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This will bring up the Add New Item dialog (Figure 1-25). We’ll filter by the Data category and select the SQL Server Database item template.

Figure 1-25
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We’ll name the SQL Server Express database we want to create NerdDinner.mdf and hit OK. Visual Studio will then ask us if we want to add this file to our \App_Data directory (Figure 1-26), which is a directory already set up with both read and write security ACLs.

 

We’ll click Yes and our new database will be created and added to our Solution Explorer (Figure 1-27).

Figure 1-26
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Figure 1-27
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Creating Tables within Our Database 

We now have a new empty database. Let’s add some tables to it.

 

To do this we’ll navigate to the Server Explorer tab window within Visual Studio, which enables us to manage databases and servers. SQL Server Express databases stored in the \App_Data folder of our application will automatically show up within the Server Explorer. We can optionally use the Connect to Database icon on the top of the Server Explorer window to add additional SQL Server databases (both local and remote) to the list as well (Figure 1-28).

Figure 1-28
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We will add two tables to our NerdDinner database — one to store our Dinners, and the other to track RSVP acceptances to them. We can create new tables by right-clicking on the Tables folder within our database and choosing the Add New Table menu command (Figure 1-29).

Figure 1-29
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This will open up a table designer that allows us to configure the schema of our table. For our Dinners table, we will add 10 columns of data (Figure 1-30).

Figure 1-30

[image: 032]

We want the DinnerID column to be a unique primary key for the table. We can configure this by right-clicking on the DinnerID column and choosing the Set Primary Key menu item (Figure 1-31).

 

In addition to making DinnerID a primary key, we also want configure it as an identity column whose value is automatically incremented as new rows of data are added to the table (meaning the first inserted Dinner row will have a DinnerID of 1, the second inserted row will have a DinnerID of 2, etc.).

 

We can do this by selecting the DinnerID column and then using the Column Properties editor to set the “(Is Identity)” property on the column to Yes (Figure 1-32). We will use the standard identity defaults (start at 1 and increment 1 on each new Dinner row).

Figure 1-31
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Figure 1-32
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We’ll then save our table by pressing Ctrl-S or by clicking the File ⇒ Save menu command. This will prompt us to name the table. We’ll name it Dinners (Figure 1-33).

Figure 1-33
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Our new Dinners table will then show up in our database in the Server Explorer.

 

We’ll then repeat the above steps and create a RSVP table. This table will have three columns. We will set up the RsvpID column as the primary key, and also make it an identity column (Figure 1-34).

 

We’ll save it and give it the name RSVP.

Figure 1-34
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Setting Up a Foreign Key Relationship Between Tables 

We now have two tables within our database. Our last schema design step will be to set up a “one-to-many” relationship between these two tables — so that we can associate each Dinner row with zero or more RSVP rows that apply to it. We will do this by configuring the RSVP table’s DinnerID column to have a foreign-key relationship to the DinnerID column in the Dinners table.

 

To do this we’ll open up the RSVP table within the table designer by double-clicking it in the Server Explorer. We’ll then select the DinnerID column within it, right-click, and choose the Relationships… context menu command (Figure 1-35):

Figure 1-35
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This will bring up a dialog that we can use to set up relationships between tables (Figure 1-36).

 

We’ll click the Add button to add a new relationship to the dialog. Once a relationship has been added, we’ll expand the Tables and Column Specification tree-view node within the property grid to the right of the dialog, and then click the “…” button to the right of it (Figure 1-37).

 

Clicking the “…” button will bring up another dialog that allows us to specify which tables and columns are involved in the relationship, as well as allow us to name the relationship.

Figure 1-36
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Figure 1-37
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We will change the Primary Key Table to be Dinners, and select the DinnerID column within the Dinners table as the primary key. Our RSVP table will be the foreign-key table, and the RSVP.DinnerID column will be associated as the foreign-key (Figure 1-38).

 

Now each row in the RSVP table will be associated with a row in the Dinner table. SQL Server will maintain referential integrity for us — and prevent us from adding a new RSVP row if it does not point to a valid Dinner row. It will also prevent us from deleting a Dinner row if there are still RSVP rows referring to it.

Figure 1-38
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Adding Data to Our Tables 

Let’s finish by adding some sample data to our Dinners table. We can add data to a table by right-clicking on it in the Server Explorer and choosing the Show Table Data command (Figure 1-39):

Figure 1-39
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Let’s add a few rows of Dinner data that we can use later as we start implementing the application (Figure 1-40).




Building the Model 

In a Model-View-Controller framework the term Model refers to the objects that represent the data of the application, as well as the corresponding domain logic that integrates validation and business rules with it. The Model is in many ways the “heart” of an MVC-based application, and as we’ll see later, it fundamentally drives the behavior of the application.

Figure 1-40
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The ASP.NET MVC framework supports using any data access technology. Developers can choose from a variety of rich .NET data options to implement their models including: LINQ to Entities, LINQ to SQL, NHibernate, LLBLGen Pro, SubSonic, WilsonORM, or just raw ADO.NET DataReaders or DataSets.

 

For our NerdDinner application, we are going to use LINQ to SQL to create a simple domain model that corresponds fairly closely to our database design, and add some custom validation logic and business rules. We will then implement a repository class that helps abstract away the data persistence implementation from the rest of the application, and enables us to easily unit test it.


LINQ to SQL 

LINQ to SQL is an ORM (object relational mapper) that ships as part of .NET 3.5.

 

LINQ to SQL provides an easy way to map database tables to .NET classes we can code against. For our NerdDinner application, we’ll use it to map the Dinners and RSVP tables within our database to Dinner and RSVP model classes. The columns of the Dinners and RSVP tables will correspond to properties on the Dinner and RSVP classes. Each Dinner and RSVP object will represent a separate row within the Dinners or RSVP tables in the database.

 

LINQ to SQL allows us to avoid having to manually construct SQL statements to retrieve and update Dinner and RSVP objects with database data. Instead, we’ll define the Dinner and RSVP classes, how they map to/from the database, and the relationships between them. LINQ to SQL will then take care of generating the appropriate SQL execution logic to use at runtime when we interact and use them.

 

We can use the LINQ language support within VB and C# to write expressive queries that retrieve Dinner and RSVP objects. This minimizes the amount of data code we need to write, and allows us to build really clean applications.


Adding LINQ to SQL Classes to Our Project 

We’ll begin by right-clicking on the Models folder in our project, and select the Add ⇒ New Item menu command (Figure 1-41).

Figure 1-41
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This will bring up the Add New Item dialog (Figure 1-42). We’ll filter by the Data category and select the LINQ to SQL Classes template within it.

Figure 1-42
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We’ll name the item NerdDinner and click the Add button. Visual Studio will add a NerdDinner. dbml file under our \Models directory, and then open the LINQ to SQL object relational designer (Figure 1-43).


Creating Data Model Classes with LINQ to SQL 

LINQ to SQL enables us to quickly create data model classes from an existing database schema. To do this we’ll open the NerdDinner database in the Server Explorer, and select the Tables we want to model in it (Figure 1-44).

Figure 1-43
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Figure 1-44
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We can then drag the tables onto the LINQ to SQL designer surface. When we do this, LINQ to SQL will automatically create Dinner and RSVP classes using the schema of the tables (with class properties that map to the database table columns as shown in Figure 1-45).

 

By default the LINQ to SQL designer automatically pluralizes table and column names when it creates classes based on a database schema. For example: the “Dinners” table in our example above resulted in a Dinner class. This class naming helps make our models consistent with .NET naming conventions, and I usually find that having the designer fix this up is convenient (especially when adding lots of tables). If you don’t like the name of a class or property that the designer generates, though, you can always override it and change it to any name you want. You can do this either by editing the entity/property name in-line within the designer or by modifying it via the property grid.

Figure 1-45
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By default the LINQ to SQL designer also inspects the primary key/foreign key relationships of the tables, and based on them automatically creates default relationship associations between the different model classes it creates. For example, when we modeled the Dinners and RSVP tables onto the LINQ to SQL designer, a one-to-many relationship association between the two was inferred based on the fact that the RSVP table had a foreign key to the Dinners table (this is indicated by the arrow in the designer in Figure 1-46).

Figure 1-46
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The association in Figure 1-46 will cause LINQ to SQL to add a strongly typed Dinner property to the RSVP class that developers can use to access the Dinner entity associated with a given RSVP. It will also cause the Dinner class to have a strongly typed RSVPs collection property that enables developers to retrieve and update RSVP objects associated with that Dinner.

In Figure 1-47, you can see an example of IntelliSense within Visual Studio when we create a new RSVP object and add it to a Dinner’s RSVPs collection.

Figure 1-47
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Notice how LINQ to SQL created a “RSVPs” collection on the Dinner object. We can use this to associate a foreign-key relationship between a Dinner and a RSVP row in our database (Figure 1-48):

Figure 1-48
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If you don’t like how the designer has modeled or named a table association, you can override it. Just click on the association arrow within the designer and access its properties via the property grid to rename, delete, or modify it. For our NerdDinner application, though, the default association rules work well for the data model classes we are building and we can just use the default behavior.


NerdDinnerDataContext Class 

Visual Studio automatically generates .NET classes that represent the models and database relationships defined using the LINQ to SQL designer. A LINQ to SQL DataContext class is also generated for each LINQ to SQL designer file added to the solution. Because we named our LINQ to SQL class item “NerdDinner,” the DataContext class created will be called NerdDinnerDataContext. This NerdDinnerDataContext class is the primary way we will interact with the database.

 

Our NerdDinnerDataContext class exposes two properties — Dinners and RSVP — that represent the two tables we modeled within the database. We can use C# to write LINQ queries against those properties to query and retrieve Dinner and RSVP objects from the database.

 

The following code (Figure 1-49) demonstrates how to instantiate a NerdDinnerDataContext object and perform a LINQ query against it to obtain a sequence of Dinners that occur in the future.

Figure 1-49
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A NerdDinnerDataContext object tracks any changes made to Dinner and RSVP objects retrieved using it, and enable us to easily save the changes back to the database. The code that follows demonstrates how we can use a LINQ query to retrieve a single Dinner object from the database, update two of its properties, and then save the changes back to the database:
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The NerdDinnerDataContext object in the code automatically tracked the property changes made to the Dinner object we retrieved from it. When we called the SubmitChanges method, it executed an appropriate SQL “UPDATE” statement to the database to persist the updated values back.


Creating a DinnerRepository Class 

For small applications, it is sometimes fine to have Controllers work directly against a LINQ to SQL DataContext class, and embed LINQ queries within the Controllers. As applications get larger, though, this approach becomes cumbersome to maintain and test. It can also lead to us duplicating the same LINQ queries in multiple places.

 

One approach that can make applications easier to maintain and test is to use a repository pattern. A repository class helps encapsulate data querying and persistence logic, and abstracts away the implementation details of the data persistence from the application. In addition to making application code cleaner, using a repository pattern can make it easier to change data storage implementations in the future, and it can help facilitate unit testing an application without requiring a real database.

For our NerdDinner application we’ll define a DinnerRepository class with the following signature:
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Later in this chapter, we’ll extract an IDinnerRepository interface from this class and enable dependency injection with it on our Controllers. To begin with, though, we are going to start simple and just work directly with the DinnerRepository class.


To implement this class we’ll right-click on our Models folder and choose the Add ⇒ New Item menu command. Within the Add New Item dialog, we’ll select the Class template and name the file DinnerRepository.cs (Figure 1-50).

Figure 1-50
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We can then implement our DinnerRespository class using the code that follows:
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Retrieving, Updating, Inserting, and Deleting Using the DinnerRepository Class 

Now that we’ve created our DinnerRepository class, let’s look at a few code examples that demonstrate common tasks we can do with it.


Querying Examples 

The code that follows retrieves a single Dinner using the DinnerID value:
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The code that follows retrieves all upcoming dinners and loops over them:
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Insert and Update Examples 

The code that follows demonstrates adding two new dinners. Additions/modifications to the repository aren’t committed to the database until the Save method is called on it. LINQ to SQL automatically wraps all changes in a database transaction — so either all changes happen or none of them does when our repository saves:
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The code that follows retrieves an existing Dinner object and modifies two properties on it. The changes are committed back to the database when the Save method is called on our repository:

[image: 060]

The code that follows retrieves a dinner and then adds an RSVP to it. It does this using the RSVPs collection on the Dinner object that LINQ to SQL created for us (because there is a primary-key/foreign-key relationship between the two in the database). This change is persisted back to the database as a new RSVP table row when the Save method is called on the repository:
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Delete Example 

The code that follows retrieves an existing Dinner object, and then marks it to be deleted. When the Save method is called on the repository, it will commit the delete back to the database:
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Integrating Validation and Business Rule Logic with Model Classes 

Integrating validation and business rule logic is a key part of any application that works with data.


Schema Validation 

When model classes are defined using the LINQ to SQL designer, the datatypes of the properties in the data model classes will correspond to the datatypes of the database table. For example: if the EventDate column in the Dinners table is a datetime, the data model class created by LINQ to SQL will be of type DateTime (which is a built-in .NET datatype). This means you will get compile errors if you attempt to assign an integer or boolean to it from code, and it will raise an error automatically if you attempt to implicitly convert a non-valid string type to it at runtime.

 

LINQ to SQL will also automatically handle escaping SQL values for you when you use strings — so you don’t need to worry about SQL injection attacks when using it.


Validation and Business Rule Logic 

Datatype validation is useful as a first step but is rarely sufficient. Most real-world scenarios require the ability to specify richer validation logic that can span multiple properties, execute code, and often have awareness of a model’s state (for example: is it being created /updated/deleted, or within a domain-specific state like “archived”).

 

There are a variety of different patterns and frameworks that can be used to define and apply validation rules to model classes, and there are several .NET based frameworks out there that can be used to help with this. You can use pretty much any of them within ASP.NET MVC applications.

 

For the purposes of our NerdDinner application, we’ll use a relatively simple and straightforward pattern where we expose an IsValid property and a GetRuleViolations method on our Dinner model object. The IsValid property will return true or false depending on whether the validation and business rules are all valid. The GetRuleViolations method will return a list of any rule errors.

 

We’ll implement IsValid and GetRuleViolations by adding a partial class to our project. Partial classes can be used to add methods/properties/events to classes maintained by a VS designer (like the Dinner class generated by the LINQ to SQL designer) and help avoid having the tool from messing with our code.

 

We can add a new partial class to our project by right-clicking on the \Models folder, and then selecting the Add New Item menu command. We can then choose the Class template within the Add New Item dialog (Figure 1-51) and name it Dinner.cs.

Figure 1-51
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Clicking the Add button will add a Dinner.cs file to our project and open it within the IDE. We can then implement a basic rule/validation enforcement framework using the following code:
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A few notes about this code:•  The Dinner class is prefaced with a partial keyword — which means the code contained within it will be combined with the class generated/maintained by the LINQ to SQL designer and compiled into a single class.
•  Invoking the GetRuleViolations method will cause our validation and business rules to be evaluated (we’ll implement them shortly). The GetRuleViolations method returns back a sequence of RuleViolation objects that provide more details about each rule error.
•  The IsValid property provides a convenient helper property that indicates whether the Dinner object has any active RuleViolations. It can be proactively checked by a developer using the Dinner object at any time (and does not raise an exception).
•  The OnValidate partial method is a hook that LINQ to SQL provides that allows us to be notified any time the Dinner object is about to be persisted within the database. Our OnValidate implementation in the previous code ensures that the Dinner has no RuleViolations before it is saved. If it is in an invalid state, it raises an exception, which will cause LINQ to SQL to abort the transaction.



This approach provides a simple framework that we can integrate validation and business rules into. For now let’s add the below rules to our GetRuleViolations method:[image: 066]
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We are using the yield return feature of C# to return a sequence of any RuleViolations. The first six rule checks in the previous code simply enforce that string properties on our Dinner cannot be null or empty. The last rule is a little more interesting and calls a PhoneValidator.IsValidNumber helper method that we can add to our project to verify that the ContactPhone number format matches the Dinner’s country.

 

We can use .NET’s regular expression support to implement this phone validation support. The code that follows is a simple PhoneValidator implementation that we can add to our project that enables us to add country-specific Regex pattern checks:[image: 068]



Now when we try to create or update a Dinner, our validation logic rules will be enforced. Developers can proactively determine if a Dinner object is valid, and retrieve a list of all violations in it without raising any exceptions:[image: 069]



If we attempt to save a Dinner in an invalid state, an exception will be raised when we call the Save method on the DinnerRepository. This occurs because our Dinner.OnValidate partial method raises an exception if any rule violations exist in the Dinner. We can catch this exception and reactively retrieve a list of the violations to fix:[image: 070]



Because our validation and business rules are implemented within our domain model layer, and not within the UI layer, they will be applied and used across all scenarios within our application. We can later change or add business rules and have all code that works with our Dinner objects honor them. Having the flexibility to change business rules in one place, without having these changes ripple throughout the application and UI logic, is a sign of a well-written application, and a benefit that an MVC framework helps encourage.




Controllers and Views 

With traditional web frameworks (classic ASP, PHP, ASP.NET Web Forms, etc.), incoming URLs are typically mapped to files on disk. For example: a request for a URL like /Products.aspx or /Products.php might be processed by a Products.aspx or Products.php file.

Web-based MVC frameworks map URLs to server code in a slightly different way. Instead of mapping incoming URLs to files, they instead map URLs to methods on classes. These classes are called  Controllers and they are responsible for processing incoming HTTP requests, handling user input, retrieving and saving data, and determining the response to send back to the client (display HTML, download a file, redirect to a different URL, etc.).

 

Now that we have built up a basic model for our NerdDinner application, our next step will be to add a Controller to the application that takes advantage of it to provide users with a data listing/details navigation experience for dinners on our site.


Adding a DinnersController Controller 

We’ll begin by right-clicking on the Controllers folder within our web project, and then selecting the Add ⇒ Controller menu command (Figure 1-52).

 

You can also execute this command by typing Ctrl-M, Ctrl-C.

Figure 1-52
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This will bring up the Add Controller dialog (Figure 1-53):

Figure 1-53
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We’ll name the new controller DinnersController and click the Add button. Visual Studio will then add a Dinners Controller.cs file under our \Controllers directory (Figure 1-54).

Figure 1-54
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It will also open up the new DinnersController class within the code-editor.


Adding Index and Details Action Methods to the DinnersController Class 

We want to enable visitors using our application to browse the list of upcoming dinners, and enable them to click on any dinner in the list to see specific details about it. We’ll do this by publishing the following URLs from our application:[image: 074]



We can publish initial implementations of these URLs by adding two public “action methods” to our DinnersController class:[image: 075]
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We can then run the application and use our browser to invoke them. Typing in the /Dinners/ URL will cause our Index method to run, and it will send back the following response (Figure 1-55):Figure 1-55
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Typing in the /Dinners/Details/2 URL will cause our Details method to run, and send back the response in Figure 1-56.

Figure 1-56
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You might be wondering — how did ASP.NET MVC know to create our DinnersController class and invoke those methods? To understand that let’s take a quick look at how routing works.


Understanding ASP.NET MVC Routing 

ASP.NET MVC includes a powerful URL routing engine that provides a lot of flexibility in controlling how URLs are mapped to controller classes. It allows us to completely customize how ASP.NET MVC  chooses which controller class to create, which method to invoke on it, as well as configure different ways that variables can be automatically parsed from the URL/querystring and passed to the method as parameter arguments. It delivers the flexibility to totally optimize a site for SEO (search engine optimization) as well as publish any URL structure we want from an application.

 

By default, new ASP.NET MVC projects come with a preconfigured set of URL routing rules already registered. This enables us to easily get started on an application without having to explicitly configure anything. The default routing rule registrations can be found within the Application class of our projects — which we can open by double-clicking the Global.asax file in the root of our project (Figure 1-57).

Figure 1-57
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The default ASP.NET MVC routing rules are registered within the RegisterRoutes method of this class:[image: 080]



The routes.MapRoute method call in the previous code registers a default routing rule that maps incoming URLs to controller classes using the URL format: /{controller}/{action}/{id} — where  controller is the name of the controller class to instantiate, action is the name of a public method to invoke on it, and id is an optional parameter embedded within the URL that can be passed as an argument to the method. The third parameter passed to the MapRoute method call is a set of default values to use for the controller/action/id values in the event that they are not present in the URL (controller = “Home”, action=”Index”, id=””).

 

The following table demonstrates how a variety of URLs are mapped using the default /{controllers}/ {action}/{id} route rule: [image: 081]



The last three rows show the default values (Controller = Home, Action = Index, Id = “”) being used. Because the Index method is registered as the default action name if one isn’t specified, the /Dinners and /Home URLs cause the Index action method to be invoked on their Controller classes. Because the “Home” controller is registered as the default controller if one isn’t specified, the / URL causes the HomeController to be created, and the Index action method on it to be invoked.

 

If you don’t like these default URL routing rules, the good news is that they are easy to change — just edit them within the RegisterRoutes method in the previous code. For our NerdDinner application, though, we aren’t going to change any of the default URL routing rules — instead we’ll just use them as-is.


Using the DinnerRepository from Our DinnersController 

Let’s now replace the current implementation of our Index and Details action methods with implementations that use our model.

 

We’ll use the DinnerRepository class we built earlier to implement the behavior. We’ll begin by adding a using statement that references the NerdDinner.Models namespace, and then declare an instance of our DinnerRepository as a field on our DinnerController class.

 

Later in this chapter, we’ll introduce the concept of Dependency Injection and show another way for our Controllers to obtain a reference to a DinnerRepository that enables better unit testing — but for right now we’ll just create an instance of our DinnerRepository inline like the code that follows.
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Now we are ready to generate a HTML response back using our retrieved data model objects.


Using Views with Our Controller 

While it is possible to write code within our action methods to assemble HTML and then use the Response.Write helper method to send it back to the client, that approach becomes fairly unwieldy quickly. A much better approach is for us to only perform application and data logic inside our DinnersController action methods, and to then pass the data needed to render a HTML response to a separate view template that is responsible for outputting the HTML representation of it. As we’ll see in a moment, a view template is a text file that typically contains a combination of HTML markup and embedded rendering code.

 

Separating our controller logic from our view rendering brings several big benefits. In particular it helps enforce a clear separation of concerns between the application code and UI formatting/rendering code. This makes it much easier to unit test application logic in isolation from UI rendering logic. It makes it easier to later modify the UI rendering templates without having to make application code changes. And it can make it easier for developers and designers to collaborate together on projects.

 

We can update our DinnersController class to indicate that we want to use a view template to send back an HTML UI response by changing the method signatures of our two action methods from having a return type of “void” to instead have a return type of ActionResult. We can then call the View helper method on the Controller base class to return back a ViewResult object:[image: 084]
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The signature of the View helper method we are using in the previous code looks like Figure 1-58.

Figure 1-58
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The first parameter to the View helper method is the name of the view template file we want to use to render the HTML response. The second parameter is a model object that contains the data that the view template needs in order to render the HTML response.

 

Within our Index action method we are calling the View helper method and indicating that we want to render an HTML listing of dinners using an “Index” view template. We are passing the view template a sequence of Dinner objects to generate the list from:[image: 087]



Within our Details action method, we attempt to retrieve a Dinner object using the id provided within the URL. If a valid Dinner is found we call the View helper method, indicating we want to use a “Details” view template to render the retrieved Dinner object. If an invalid dinner is requested, we render a helpful error message that indicates that the dinner doesn’t exist using a “NotFound” view template (and an overloaded version of the View() helper method that just takes the template name):[image: 088]
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Let’s now implement the “NotFound”, “Details”, and “Index” view templates.


Implementing the “NotFound” View Template 

We’ll begin by implementing the “NotFound” view template — which displays a friendly error message indicating that the requested dinner can’t be found.

 

We’ll create a new view template by positioning our text cursor within a controller action method, and then by right clicking and choosing the Add View menu command (Figure 1-59; we can also execute this command by pressing Ctrl-M, Ctrl-V):Figure 1-59
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This will bring up an Add View dialog shown in Figure 1-60. By default, the dialog will pre-populate the name of the view to create to match the name of the action method the cursor was in when the dialog was launched (in this case “Details”). Because we want to first implement the “NotFound” template, we’ll override this view name and set it instead to be NotFound:Figure 1-60
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When we click the Add button, Visual Studio will create a new NotFound.aspx (Figure 1-61) view template for us within the \Views\Dinners directory (which it will also create if the directory doesn’t already exist):Figure 1-61

[image: 092]



It will also open up our new NotFound.aspx view template within the code-editor (Figure 1-62):Figure 1-62
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View templates by default have two content regions where we can add content and code. The first allows us to customize the “title” of the HTML page sent back. The second allows us to customize the “main content” of the HTML page sent back.

 

To implement our “NotFound” view template, we’ll add some basic content:[image: 094]
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We can then try it out within the browser. To do this let’s request the /Dinners/Details/9999 URL. This will refer to a dinner that doesn’t currently exist in the database, and will cause our DinnersController .Details action method to render our “NotFound” view template (Figure 1-63).

Figure 1-63
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One thing you’ll notice in Figure 1-63 is that our basic view template has inherited a bunch of HTML that surrounds the main content on the screen. This is because our view template is using a master page  template that enables us to apply a consistent layout across all views on the site. We’ll discuss how master pages work more in a later part of this chapter.


Implementing the “Details” View Template 

Let’s now implement the “Details” view template — which will generate HTML for a single Dinner model.

 

We’ll do this by positioning our text cursor within the Details action method, and then right-clicking and choosing the Add View menu command — Figure 1-64 — or pressing Ctrl-M, Ctrl-V.

 

This will bring up the Add View dialog. We’ll keep the default view name (Details). We’ll also select the “Create a strongly typed view” checkbox in the dialog and select (using the combobox drop-down) the name of the model type we are passing from the Controller to the View. For this view we are passing a Dinner object (the fully qualified name for this type is: NerdDinner.Models.Dinner) as shown in Figure 1-65.

Figure 1-64
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Figure 1-65
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Unlike the previous template, where we chose to create an “Empty View,” this time we will choose to automatically scaffold the view using a “Details” template. We can indicate this by changing the View content drop-down in the dialog above.

 

Scaffolding will generate an initial implementation of our details view template based on the Dinner model we are passing to it. This provides an easy way for us to quickly get started on our view template implementation.

 

When we click the Add button, Visual Studio will create a new Details.aspx view template file for us within our \Views\Dinners directory (Figure 1-66).

Figure 1-66
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It will also open up our new Details.aspx view template within the code-editor. It will contain an initial scaffold implementation of a details view based on a Dinner model. The scaffolding engine uses .NET reflection to look at the public properties exposed on the class passed to it, and will add appropriate content based on each type it finds:[image: 100]
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We can request the /Dinners/Details/1 URL to see what this “details” scaffold implementation looks like in the browser. Using this URL will display one of the dinners we manually added to our database when we first created it (Figure 1-67).

Figure 1-67
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This gets us up and running quickly, and provides us with an initial implementation of our Details. aspx view. We can then go and tweak it to customize the UI to our satisfaction.

 

When we look at the Details.aspx template more closely, we’ll find that it contains static HTML as well as embedded rendering code. <% %> code nuggets execute code when the view template renders, and <%= %> code nuggets execute the code contained within them and then render the result to the output stream of the template.

 

We can write code within our View that accesses the Dinner model object that was passed from our controller using a strongly typed Model property. Visual Studio provides us with full code-IntelliSense when accessing this Model property within the editor (Figure 1-68).

Figure 1-68
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Let’s make some tweaks so that the source for our final Details view template looks like that below:[image: 104]
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When we access the /Dinners/Details/1 URL again, it will render like so (Figure 1-69):Figure 1-69
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Implementing the “Index” View Template 

Let’s now implement the “Index” view template — which will generate a listing of upcoming dinners. To do this we’ll position our text cursor within the Index action method, and then right-click and choose the Add View menu command (or press Ctrl-M, Ctrl-V).

 

Within the Add View dialog (Figure 1-70), we’ll keep the view template named Index and select the “Create a strongly-typed view” checkbox. This time we will choose to automatically generate a List view template, and select NerdDinner.Models.Dinner as the model type passed to the view (which because we have indicated we are creating a List scaffold will cause the Add View dialog to assume we are passing a sequence of Dinner objects from our Controller to the View): Figure 1-70
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When we click the Add button, Visual Studio will create a new Index.aspx view template file for us within our \Views\Dinners directory. It will scaffold an initial implementation within it that provides an HTML table listing of the Dinners we pass to the view.

 

When we run the application and access the /Dinners/ URL, it will render our list of dinners like so (Figure 1-71):Figure 1-71
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The table solution in Figure 1-71 gives us a grid-like layout of our Dinner data — which isn’t quite what we want for our consumer-facing Dinner listing. We can update the Index.aspx view template and modify it to list fewer columns of data, and use a <ul> element to render them instead of a table using the code that follows:[image: 109]



We are using the var keyword within the foreach statement as we loop over each dinner in our model. Those unfamiliar with C# 3.0 might think that using var means that the Dinner object is late-bound. It, instead, means that the compiler is using type-inference against the strongly typed Model property (which is of type IEnumerable<Dinner>) and compiling the local “dinner” variable as a Dinner type — which means we get full IntelliSense and compile-time checking for it within code blocks (Figure 1-72).

Figure 1-72
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When we press the Refresh button on the /Dinners URL in our browser, our updated view now looks like Figure 1-73.

Figure 1-73
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This is looking better — but isn’t entirely there yet. Our last step is to enable end users to click individual dinners in the list and see details about them. We’ll implement this by rendering HTML hyperlink elements that link to the Details action method on our DinnersController.

 

We can generate these hyperlinks within our Index view in one of two ways. The first is to manually create HTML <a> elements like Figure 1-74, where we embed <% %> blocks within the <a> HTML element:Figure 1-74
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An alternative approach we can use is to take advantage of the built-in Html.ActionLink helper method within ASP.NET MVC that supports programmatically creating an HTML <a> element that links to another action method on a Controller:[image: 113]



The first parameter to the Html.ActionLink helper method is the link-text to display (in this case the title of the dinner), the second parameter is the Controller action name we want to generate the link to  (in this case the “Details” method), and the third parameter is a set of parameters to send to the action (implemented as an anonymous type with property name/values). In this case we are specifying the id parameter of the dinner we want to link to, and because the default URL routing rule in ASP.NET MVC is {Controller}/{Action}/{id} the Html.ActionLink helper method will generate the following output:[image: 114]



For our Index.aspx view we’ll use the Html.ActionLink helper method approach and have each dinner in the list link to the appropriate details URL:[image: 115]



And now when we hit the /Dinners URL, our dinner list looks like Figure 1-75:Figure 1-75
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When we click any of the dinners in the list, we’ll navigate to see details about it (Figure 1-76):Figure 1-76
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Convention-Based Naming and the \Views Directory Structure 

ASP.NET MVC applications, by default, use a convention-based directory naming structure when resolving view templates. This allows developers to avoid having to fully qualify a location path when referencing views from within a Controller class. By default ASP.NET MVC will look for the view template file within the \Views\[ControllerName]\ directory underneath the application.

 

For example, we’ve been working on the DinnersController class — which explicitly references three view templates: “Index”, “Details”, and “NotFound”. ASP.NET MVC will, by default, look for these views within the \Views\Dinners directory underneath our application root directory (Figure 1-77).

 

Notice in Figure 1-77 how there are currently three controller classes within the project (DinnersController, HomeController, and AccountController — the last two were added by default when we created the project), and there are three subdirectories (one for each controller) within the \Views directory.

 

Views referenced from the Home and Accounts controllers will automatically resolve their view templates from the respective \Views\Home and \Views\Account directories. The \Views\Shared subdirectory provides a way to store view templates that are reused across multiple controllers within the application. When ASP.NET MVC attempts to resolve a view template, it will first check within the  \Views\[Controller] specific directory, and if it can’t find the view template there it will look within the \Views\Shared directory.

Figure 1-77

[image: 118]

When it comes to naming individual view templates, the recommended guidance is to have the view template share the same name as the action method that caused it to render. For example, above our Index action method is using the “Index” view to render the view result, and the Details action method is using the “Details” view to render its results. This makes it easy to quickly see which template is associated with each action.

 

Developers do not need to explicitly specify the view template name when the view template has the same name as the action method being invoked on the controller. We can instead just pass the model object to the View helper method (without specifying the view name), and ASP.NET MVC will automatically infer that we want to use the \Views\[ControllerName]\[ActionName] view template on disk to render it.

 

This allows us to clean up our controller code a little, and avoid duplicating the name twice in our code:[image: 119]
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The previous code is all that is needed to implement a nice Dinner listing/details experience for the site.




Create, Update, Delete Form Scenarios 

We’ve introduced controllers and views, and covered how to use them to implement a listing/details experience for dinners on the site. Our next step will be to take our DinnersController class further and enable support for editing, creating, and deleting dinners with it as well.


URLs Handled by DinnersController 

We previously added action methods to DinnersController that implemented support for two URLs: /Dinners and /Dinners/Details/[id].

[image: 121]

We will now add action methods to implement three additional URLs: /Dinners/Edit/[id], /Dinners   /Create, and /Dinners/Delete/[id]. These URLs will enable support for editing existing dinners, creating new dinners, and deleting dinners.

 

We will support both HTTP GET and HTTP POST verb interactions with these new URLs. HTTP GET requests to these URLs will display the initial HTML view of the data (a form populated with the Dinner data in the case of “edit,” a blank form in the case of “create,” and a delete confirmation screen in the case of “delete”). HTTP POST requests to these URLs will save/update/delete the Dinner data in our DinnerRepository (and from there to the database).

[image: 122]

Let’s begin by implementing the “edit” scenario.


Implementing the HTTP-GET Edit Action Method 

We’ll start by implementing the HTTP GET behavior of our edit action method. This method will be invoked when the /Dinners/Edit/[id] URL is requested. Our implementation will look like:[image: 123]



The code above uses the DinnerRepository to retrieve a Dinner object. It then renders a view template using the Dinner object. Because we haven’t explicitly passed a template name to the View helper method, it will use the convention based default path to resolve the view template: /Views/Dinners/ Edit.aspx.

 

Let’s now create this view template. We will do this by right-clicking within the Edit method and selecting the Add View context menu command (Figure 1-78).

Figure 1-78
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Within the Add View dialog, we’ll indicate that we are passing a Dinner object to our view template as its model, and choose to auto-scaffold an Edit template (Figure 1-79).

Figure 1-79
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When we click the Add button, Visual Studio will add a new Edit.aspx view template file for us within the \Views\Dinners directory. It will also open up the new Edit.aspx view template within the code-editor — populated with an initial “Edit” scaffold implementation like that in Figure 1-80.

Figure 1-80
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Let’s make a few changes to the default “Edit” scaffold generated, and update the Edit view template to have the content below (which removes a few of the properties we don’t want to expose):[image: 127]
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When we run the application and request the /Dinners/Edit/1 URL we will see the page in  Figure 1-81:Figure 1-81
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The HTML markup generated by our view looks like that below. It is standard HTML — with a <form> element that performs an HTTP POST to the /Dinners/Edit/1 URL when the Save <input type=“submit”/> button is pushed. A HTML <input type=“text”/> element has been output for each editable property (Figure 1-82).

Figure 1-82
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Html.BeginForm and Html.TextBox Html Helper Methods 

Our Edit.aspx view template is using several “Html Helper” methods: Html.ValidationSummary, Html.BeginForm, Html.TextBox, and Html.ValidationMessage. In addition to generating HTML markup for us, these helper methods provide built-in error handling and validation support.


Html.BeginForm Helper Method 

The Html.BeginForm helper method is what output the HTML <form> element in our markup. In our Edit.aspx view template, you’ll notice that we are applying a C# “using” statement when using this method. The open curly brace indicates the beginning of the <form> content, and the closing curly brace is what indicates the end of the </form> element:[image: 131]



Alternatively, if you find the “using” statement approach unnatural for a scenario like this, you can use a Html.BeginForm and Html.EndForm combination (which does the same thing):[image: 132]
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Calling Html.BeginForm without any parameters will cause it to output a form element that does an HTTP-POST to the current request’s URL. That is why our Edit view generates a <form action=“ /Dinners/Edit/1” method=“post”> element. We could have alternatively passed explicit parameters to Html.BeginForm if we wanted to post to a different URL.


Html.TextBox Helper Method 

Our Edit.aspx view uses the Html.TextBox helper method to output <input type=“text”/> elements:[image: 134]



The Html.TextBox method above takes a single parameter — which is being used to specify both the id/name attributes of the <input type=“text”/> element to output, as well as the model property to populate the textbox value from. For example, the Dinner object we passed to the Edit view had a “Title” property value of .NET Futures, and so our Html.TextBox(“Title”) method call output is: <input id=“Title” name=“Title” type=“text” value=“.NET Futures” />.

 

Alternatively, we can use the first Html.TextBox parameter to specify the id/name of the element, and then explicitly pass in the value to use as a second parameter:[image: 135]



Often we’ll want to perform custom formatting on the value that is output. The String.Format static method built into .NET is useful for these scenarios. Our Edit.aspx view template is using this to format the EventDate value (which is of type DateTime) so that it doesn’t show seconds for the time:[image: 136]



A third parameter to Html.TextBox can optionally be used to output additional HTML attributes. The code-snippet below demonstrates how to render an additional size=“30” attribute and a class=“mycssclass” attribute on the <input type=“text”/> element. Note how we are escaping the name of the class attribute using a @ character because class is a reserved keyword in C#:[image: 137]




Implementing the HTTP-POST Edit Action Method 

We now have the HTTP-GET version of our Edit action method implemented. When a user requests the /Dinners/Edit/1 URL they receive an HTML page like the one in Figure 1-83: Figure 1-83
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Pressing the Save button causes a form post to the /Dinners/Edit/1 URL, and submits the HTML <input> form values using the HTTP POST verb. Let’s now implement the HTTP POST behavior of our edit action method — which will handle saving the dinner.

 

We’ll begin by adding an overloaded Edit action method to our DinnersController that has an “AcceptVerbs” attribute on it that indicates it handles HTTP POST scenarios:[image: 139]



When the [AcceptVerbs] attribute is applied to overloaded action methods, ASP.NET MVC automatically handles dispatching requests to the appropriate action method depending on the incoming HTTP verb. HTTP POST requests to /Dinners/Edit/[id] URLs will go to the above Edit method, while all other HTTP verb requests to /Dinners/Edit/[id] URLs will go to the first Edit method we implemented (which did not have an [AcceptVerbs] attribute).

Why Differentiate via HTTP Verbs?

You might ask — why are we using a single URL and differentiating its behavior via the HTTP verb? Why not just have two separate URLs to handle loading and saving edit changes? For example: /Dinners/Edit/[id] to display the initial form and /Dinners/Save/[id] to handle the form post to save it?

The downside with publishing two separate URLs is that in cases where we post to /Dinners/Save/2, and then need to redisplay the HTML form because of an input error, the end user will end up having the /Dinners/Save/2 URL in their browser’s address bar (since that was the URL the form posted to). If the end user bookmarks this redisplayed page to their browser favorites list, or copy/pastes the URL and emails it to a friend, they will end up saving a URL that won’t work in the future (since that URL depends on post values).

By exposing a single URL (like: /Dinners/Edit/[id]) and differentiating the processing of it by HTTP verb, it is safe for end users to bookmark the edit page and/or send the URL to others.



Retrieving Form Post Values 

There are a variety of ways we can access posted form parameters within our HTTP POST Edit method. One simple approach is to just use the Request property on the Controller base class to access the form collection and retrieve the posted values directly:[image: 140]
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The approach in the previous code is a little verbose, though, especially once we add error handling logic.

 

A better approach for this scenario is to leverage the built-in UpdateModel helper method on the Controller base class. It supports updating the properties of an object we pass it using the incoming form parameters. It uses reflection to determine the property names on the object, and then automatically converts and assigns values to them based on the input values submitted by the client.

 

We could use the UpdateModel method to implement our HTTP-POST Edit action using this code:[image: 142]



We can now visit the /Dinners/Edit/1 URL, and change the title of our dinner (Figure 1-84).

Figure 1-84
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When we click the Save button, we’ll perform a form post to our Edit action, and the updated values will be persisted in the database. We will then be redirected to the Details URL for the dinner (which will display the newly saved values like those in Figure 1-85).

Figure 1-85
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Handling Edit Errors 

Our current HTTP-POST implementation works fine — except when there are errors.

 

When a user makes a mistake editing a form, we need to make sure that the form is redisplayed with an informative error message that guides them to fix it. This includes cases where an end-user posts incorrect input (for example: a malformed date string), as well as cases where the input format is valid but there is a business rule violation. When errors occur, the form should preserve the input data the user originally entered so that they don’t have to refill their changes manually. This process should repeat as many times as necessary until the form successfully completes.

 

ASP.NET MVC includes some nice built-in features that make error handling and form redisplay easy. To see these features in action, let’s update our Edit action method with the following code:[image: 145]
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The previous code is similar to our previous implementation — except that we are now wrapping a try/ catch error handling block around our work. If an exception occurs either when calling UpdateModel, or when we try and save the DinnerRepository (which will raise an exception if the Dinner object we are trying to save is invalid because of a rule violation), our catch error handling block will execute. Within it, we loop over any rule violations that exist in the Dinner object and add them to a ModelState object (which we’ll discuss shortly). We then redisplay the view.

 

To see this working let’s re-run the application, edit a dinner, and change it to have an empty Title, an Event Date of BOGUS, and use a UK phone number with a country value of USA. When we press the Save button our HTTP POST Edit method will not be able to save the dinner (because there are errors) and will redisplay the form in Figure 1-86.

Figure 1-86
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Our application has a decent error experience. The text elements with the invalid input are highlighted in red, and validation error messages are displayed to the end user about them. The form is also preserving the input data the user originally entered — so that they don’t have to refill anything.

 

How, you might ask, did this occur? How did the Title, Event Date, and Contact Phone textboxes highlight themselves in red and know to output the originally entered user values? And how did error messages get displayed in the list at the top? The good news is that this didn’t occur by magic — rather it was because we used some of the built-in ASP.NET MVC features that make input validation and error handling scenarios easy.


Understanding ModelState and the Validation HTML Helper Methods 

Controller classes have a ModelState property collection that provides a way to indicate that errors exist with a model object being passed to a View. Error entries within the ModelState collection identify the name of the model property with the issue (for example: “Title”, “EventDate”, or “ContactPhone”), and allow a human-friendly error message to be specified (for example: “Title is required”).

 

The UpdateModel() helper method automatically populates the ModelState collection when it encounters errors while trying to assign form values to properties on the model object. For example, our Dinner object’s EventDate property is of type DateTime. When the UpdateModel method was unable to assign the string value BOGUS to it in the previous scenario, the UpdateModel method added an entry to the ModelState collection indicating an assignment error had occurred with that property.

 

Developers can also write code to explicitly add error entries into the ModelState collection as we are doing below within our “catch” error handling block, which is populating the ModelState collection with entries based on the active Rule Violations in the Dinner object:[image: 148]




Html Helper Integration with ModelState 

HTML helper methods — like Html.TextBox — check the ModelState collection when rendering output. If an error for the item exists, they render the user-entered value and a CSS error class.

 

For example, in our “Edit” view we are using the Html.TextBox helper method to render the EventDate of our Dinner object:[image: 149]



When the view was rendered in the error scenario, the Html.TextBox method checked the ModelState collection to see if there were any errors associated with the “EventDate” property of our Dinner object. When it determined that there was an error, it rendered the submitted user input (“BOGUS”) as the value, and added a CSS error class to the <input type=”textbox”/> markup it generated:[image: 150]



You can customize the appearance of the CSS error class to look however you want. The default CSS error class — input-validation-error — is defined in the \content\site.css stylesheet and looks like the code below:[image: 151]



This CSS rule is what caused our invalid input elements to be highlighted, as in Figure 1-87.

Figure 1-87
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Html .ValidationMessage Helper Method 

The Html.ValidationMessage helper method can be used to output the ModelState error message associated with a particular model property:

[image: 153]

The previous code outputs: <span class=”field-validation-error”> The value ‘BOGUS’ is invalid</span>

 

 

The Html.ValidationMessage helper method also supports a second parameter that allows developers to override the error text message that is displayed:

[image: 154]

The previous code outputs: <span class=”field-validation-error”>*</span> instead of the default error text when an error is present for the EventDate property.


Html.ValidationSummary() Helper Method 

The Html.ValidationSummary helper method can be used to render a summary error message, accompanied by a <ul><li/></ul> list of all detailed error messages in the ModelState collection (Figure 1-88):Figure 1-88
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The Html.ValidationSummary helper method takes an optional string parameter — which defines a summary error message to display above the list of detailed errors:[image: 156]



You can optionally use CSS to override what the error list looks like.


Using a AddRuleViolations Helper Method 

Our initial HTTP-POST Edit implementation used a foreach statement within its catch block to loop over the Dinner object’s Rule Violations and add them to the controller’s ModelState collection:[image: 157]



We can make this code a little cleaner by adding a ControllerHelpers class to the NerdDinner project, and implement an AddRuleViolations extension method within it that adds a helper method to the ASP.NET MVC ModelStateDictionary class. This extension method can encapsulate the logic necessary to populate the ModelStateDictionary with a list of RuleViolation errors:[image: 158]
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We can then update our HTTP-POST Edit action method to use this extension method to populate the ModelState collection with our Dinner Rule Violations.


Complete Edit Action Method Implementations 

The following code implements all of the controller logic necessary for our Edit scenario:[image: 160]



The nice thing about our Edit implementation is that neither our Controller class nor our view template has to know anything about the specific validation or business rules being enforced by our Dinner model. We can add additional rules to our model in the future and do not have to make any code changes to our controller or view in order for them to be supported. This provides us with the flexibility to easily evolve our application requirements in the future with a minimum of code changes.


Implementing the HTTP-GET Create Action Method 

We’ve finished implementing the Edit behavior of our DinnersController class. Let’s now move on to implement the Create support on it — which will enable users to add new dinners.

 

We’ll begin by implementing the HTTP GET behavior of our create action method. This method will be called when someone visits the /Dinners/Create URL. Our implementation looks like:[image: 161]



The previous code creates a new Dinner object, and assigns its EventDate property to be one week in the future. It then renders a View that is based on the new Dinner object. Because we haven’t explicitly passed a name to the View helper method, it will use the convention based default path to resolve the view template: /Views/Dinners/Create.aspx.

 

Let’s now create this view template. We can do this by right-clicking within the Create action method and selecting the Add View context menu command. Within the Add View dialog we’ll indicate that we are passing a Dinner object to the view template, and choose to auto-scaffold a Create template (Figure 1-89).

Figure 1-89
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When we click the Add button, Visual Studio will save a new scaffold-based Create.aspx view to the \Views\Dinners directory, and open it up within the IDE (Figure 1-90).

Figure 1-90
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Let’s make a few changes to the default “create” scaffold file that was generated for us, and modify it up to look like the code below:[image: 164]
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And now when we run our application and access the /Dinners/Create URL within the browser, it will render the UI as in Figure 1-91 from our Create action implementation.


Implementing the HTTP-POST Create Action Method 

We have the HTTP-GET version of our Create action method implemented. When a user clicks the Save button, it performs a form post to the /Dinners/Create URL, and submits the HTML <input> form values using the HTTP POST verb.

 

Let’s now implement the HTTP POST behavior of our create action method. We’ll begin by adding an overloaded Create action method to our DinnersController that has an AcceptVerbs attribute on it that indicates it handles HTTP POST scenarios:[image: 166]

Figure 1-91
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There are a variety of ways we can access the posted form parameters within our HTTP-POST-enabled Create method.

 

One approach is to create a new Dinner object and then use the UpdateModel helper method (as we did with the Edit action) to populate it with the posted form values. We can then add it to our DinnerRepository, persist it to the database, and redirect the user to our Details action to show the newly created dinner, using the following code:[image: 168]
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Alternatively, we can use an approach where we have our Create action method take a Dinner object as a method parameter. ASP.NET MVC will then automatically instantiate a new Dinner object for us, populate its properties using the form inputs, and pass it to our action method:[image: 170]



Our action method in the previous code verifies that the Dinner object has been successfully populated with the form post values by checking the ModelState.IsValid property. This will return false if there are input conversion issues (for example: a string of “BOGUS” for the EventDate property), and if there are any issues, our action method redisplays the form.

 

If the input values are valid, then the action method attempts to add and save the new dinner to the DinnerRepository. It wraps this work within a try/catch block and redisplays the form if there are any business rule violations (which would cause the dinnerRepository.Save method to raise an exception).

To see this error handling behavior in action, we can request the /Dinners/Create URL and fill out details about a new dinner. Incorrect input or values will cause the create form to be redisplayed with the errors highlighted in Figure 1-92.

Figure 1-92
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Notice how our Create form is honoring the exact same validation and business rules as our Edit form. This is because our validation and business rules were defined in the model, and were not embedded within the UI or controller of the application. This means we can later change/evolve our validation or business rules in a single place and have them apply throughout our application. We will not have to change any code within either our Edit or Create action methods to automatically honor any new rules or modifications to existing ones.

 

When we fix the input values and click the Save button again, our addition to the DinnerRepository will succeed, and a new dinner will be added to the database. We will then be redirected to the  /Dinners/Details/[id] URL — where we will be presented with details about the newly created dinner (Figure 1-93): Figure 1-93
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Implementing the HTTP-GET Delete Action Method 

Let’s now add “Delete” support to our DinnersController.

 

We’ll begin by implementing the HTTP GET behavior of our delete action method. This method will get called when someone visits the /Dinners/Delete/[id] URL . Below is the implementation:[image: 173]



The action method attempts to retrieve the dinner to be deleted. If the dinner exists it renders a View based on the Dinner object. If the object doesn’t exist (or has already been deleted) it returns a View that renders the “NotFound” view template we created earlier for our “Details” action method.

 

We can create the “Delete” view template by right-clicking within the Delete action method and selecting the “Add View” context menu command. Within the “Add View” dialog we’ll indicate that we are passing a Dinner object to our view template as its model, and choose to create an empty template (Figure 1-94): Figure 1-94
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When we click the Add button, Visual Studio will add a new Delete.aspx view template file for us within our \Views\Dinners directory. We’ll add some HTML and code to the template to implement a delete confirmation screen as shown below:[image: 175]



The code above displays the title of the dinner to be deleted, and outputs a <form> element that does a POST to the /Dinners/Delete/[id] URL if the end user clicks the Delete button within it.

 

When we run our application and access the /Dinners/Delete/[id] URL for a valid Dinner object, it renders the UI as in Figure 1-95.

Figure 1-95
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Why Are We Doing a POST

You might ask — why did we go through the effort of creating a <form> within our Delete confirmation screen? Why not just use a standard hyperlink to link to an action method that does the actual delete operation?

The reason is because we want to be careful to guard against web-crawlers and search engines discovering our URLs and inadvertently causing data to be deleted when they follow the links. HTTP-GET-based URLs are considered “safe” for them to access/crawl, and they are supposed to not follow HTTP-POST ones.

A good rule is to make sure you always put destructive or data modifying operations behind HTTP-POST requests.



Implementing the HTTP-POST Delete Action Method 

We now have the HTTP-GET version of our Delete action method implemented that displays a delete confirmation screen. When an end user clicks the Delete button, it will perform a form post to the /Dinners/Dinner/[id] URL.

 

Let’s now implement the HTTP POST behavior of the delete action method using the code that follows:[image: 177]

[image: 178]



The HTTP-POST version of our Delete action method attempts to retrieve the Dinner object to delete. If it can’t find it (because it has already been deleted) it renders our “NotFound” template. If it finds the dinner, it deletes it from the DinnerRepository. It then renders a “Deleted” template.

 

To implement the “Deleted” template, we’ll right-click in the action method and choose the Add View context menu. We’ll name our view Deleted and have it be an empty template (and not take a strongly typed model object). We’ll then add some HTML content to it:[image: 179]



And now when we run our application and access the/Dinners/Delete/[id] URL for a valid Dinner object, it will render our Dinner delete confirmation screen as in Figure 1-96.

Figure 1-96

[image: 180]

When we click the Delete button, it will perform an HTTP-POST to the /Dinners/Delete/[id] URL, which will delete the dinner from our database, and display our “Deleted” view template (Figure 1-97).

Figure 1-97

[image: 181]


Model Binding Security 

We’ve discussed two different ways to use the built-in model-binding features of ASP.NET MVC. The first using the UpdateModel method to update properties on an existing model object, and the second using ASP.NET MVC’s support for passing model objects in as action method parameters. Both of these techniques are very powerful and extremely useful.

 

This power also brings with it responsibility. It is important to always be paranoid about security when accepting any user input, and this is also true when binding objects to form input. You should be careful to always HTML encode any user-entered values to avoid HTML and JavaScript injection attacks, and be careful of SQL injection attacks (note: we are using LINQ to SQL for our application, which automatically encodes parameters to prevent these types of attacks). You should never rely on client-side validation alone, and always employ server-side validation to guard against hackers attempting to send you bogus values.

 

One additional security item to make sure you think about when using the binding features of ASP. NET MVC is the scope of the objects you are binding. Specifically, you want to make sure you understand the security implications of the properties you are allowing to be bound, and make sure you only allow those properties that really should be updatable by an end user to be updated.

 

By default, the UpdateModel method will attempt to update all properties on the model object that match incoming form parameter values. Likewise, objects passed as action method parameters also, by default, can have all of their properties set via form parameters.


Locking Down Binding on a Per-Usage Basis 

You can lock down the binding policy on a per-usage basis by providing an explicit include list of properties that can be updated. This can be done by passing an extra string array parameter to the UpdateModel method like the following code:[image: 182]



Objects passed as action method parameters also support a [Bind] attribute that enables an include list of allowed properties to be specified like the code that follows:[image: 183]




Locking Down Binding on a Type Basis 

You can also lock down the binding rules on a per-type basis. This allows you to specify the binding rules once and then have them apply in all scenarios (including both UpdateModel and action method parameter scenarios) across all controllers and action methods.

 

You can customize the per-type binding rules by adding a [Bind] attribute onto a type, or by registering it within the Global.asax file of the application (useful for scenarios where you don’t own the type). You can then use the Bind attribute’s Include and Exclude properties to control which properties are bindable for the particular class or interface.

 

We’ll use this technique for the Dinner class in our NerdDinner application, and add a [Bind] attribute to it that restricts the list of bindable properties to the following:[image: 184]



Notice we are not allowing the RSVPs collection to be manipulated via binding, nor are we allowing the DinnerID or HostedBy properties to be set via binding. For security reasons we’ll instead only manipulate these particular properties using explicit code within our action methods.


CRUD Wrap-Up 

ASP.NET MVC includes a number of built-in features that help with implementing form posting scenarios. We used a variety of these features to provide CRUD UI support on top of our DinnerRepository.

We are using a model-focused approach to implement our application. This means that all our validation and business rule logic is defined within our model layer — and not within our controllers or views. Neither our Controller class nor our view templates know anything about the specific business rules being enforced by our Dinner model class.

 

This will keep our application architecture clean and make it easier to test. We can add additional business rules to our model layer in the future and not have to make any code changes to our Controller or View in order for them to be supported. This is going to provide us with a great deal of agility to evolve and change our application in the future.

 

Our Dinners Controller now enables dinner listings/details, as well as create, edit, and delete support. The complete code for the class can be found below:[image: 185]
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ViewData andViewModel 

We’ve covered a number of form post scenarios, and discussed how to implement create, update and delete (CRUD) support. We’ll now take our DinnersController implementation further and enable support for richer form editing scenarios. While doing this we’ll discuss two approaches that can be used to pass data from controllers to views: ViewData and ViewModel.


Passing Data from Controllers to View Templates 

One of the defining characteristics of the MVC pattern is the strict separation of concerns it helps enforce between the different components of an application. Models, Controllers, and Views each have well defined roles and responsibilities, and they communicate amongst each other in well-defined ways. This helps promote testability and code reuse.

 

When a Controller class decides to render an HTML response back to a client, it is responsible for explicitly passing to the view template all of the data needed to render the response. View templates  should never perform any data retrieval or application logic — and should instead limit themselves to only having rendering code that is driven off of the model/data passed to it by the controller.

Right now the model data being passed by our DinnersController class to our view templates is simple and straightforward — a list of Dinner objects in the case of Index, and a single Dinner object in the case of Details, Edit, Create, and Delete. As we add more UI capabilities to our application, we are often going to need to pass more than just this data to render HTML responses within our view templates. For example, we might want to change the Country field within our Edit and Create views from being an HTML textbox to a dropdownlist. Rather than hard-code the dropdownlist of country names in the view template, we might want to generate it from a list of supported countries that we populate dynamically. We will need a way to pass both the Dinner object and the list of supported countries from our controller to our view templates.

 

Let’s look at two ways we can accomplish this.


Using the ViewData Dictionary 

The Controller base class exposes a View Data dictionary property that can be used to pass additional data items from Controllers to Views.

 

For example, to support the scenario where we want to change the Country textbox within our Edit view from being an HTML textbox to a dropdownlist, we can update our Edit action method to pass (in addition to a Dinner object) a Select List object that can be used as the model of a countries dropdownlist.

[image: 188]

The constructor of the Select List from the previous code is accepting a list of countries to populate the dropdownlist with, as well as the currently selected value.

 

We can then update our Edit.aspx view template to use the Html.DropDownList helper method instead of the Html.Text Box helper method we used previously:

[image: 189]

The Html.Drop DownList helper method in the previous line of code takes two parameters. The first is the name of the HTML form element to output. The second is the SelectList model we passed via the ViewData dictionary. We are using the C# “as” keyword to cast the type within the dictionary as a SelectList.

And now when we run our application and access the /Dinners/Edit/1 URL within our browser, we’ll see that our edit UI has been updated to display a drop-down list of countries instead of a textbox (Figure 1-98):

Figure 1-98

[image: 190]

Because we also render the Edit view template from the HTTP-POST Edit method (in scenarios when errors occur), we’ll want to make sure that we also update this method to add the SelectList to View Data when the view template is rendered in error scenarios:

[image: 191]

And now our Dinners Controller edit scenario supports a drop-down list.


Using a ViewModel Pattern 

The View Data dictionary approach has the benefit of being fairly fast and easy to implement. Some developers don’t like using string-based dictionaries, though, since typos can lead to errors that will not be caught at compile-time. The un-typed ViewData dictionary also requires using the “as” operator or casting when using a strongly typed language like C# in a view template.

 

An alternative approach that we could use is one often referred to as the ViewModel pattern. When using this pattern, we create strongly typed classes that are optimized for our specific view scenarios, and that expose properties for the dynamic values/content needed by our view templates. Our controller classes can then populate and pass these view-optimized classes to our view template to use. This enables type-safety, compile-time checking, and editor IntelliSense within view templates.

 

For example, to enable dinner form editing scenarios, we can create a DinnerFormViewModel class like the following code that exposes two strongly typed properties: a Dinner object and the SelectList model needed to populate the countries drop-down list:
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We can then update our Edit action method to create the DinnerFormViewModel using the Dinner object we retrieve from our repository, and then pass it to our view template:

[image: 193]

We’ll then update our view template so that it expects a DinnerFormViewModel instead of a Dinner object by changing the Inherits attribute at the top of the edit.aspx page like so:

[image: 194]

 

 

Once we do this, the IntelliSense of the Model property within our view template will be updated to reflect the object model of the DinnerFormViewModel type we are passing it (see Figures 1-99 and 1-100):

Figure 1-99
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Figure 1-100
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We can then update our view code to work off of it. Notice in the following code how we are not changing the names of the input elements we are creating (the form elements will still be named “Title”, “Country”) — but we are updating the HTML Helper methods to retrieve the values using the Dinner Form View Model class:

[image: 197]

We’ll also update our Edit post method to use the DinnerFormViewModel class when rendering errors:
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We can also update our Create action methods to reuse the exact same DinnerFormViewModel class to enable the countries dropdownlist within those as well. The following code is the HTTP-GET implementation:

[image: 200]

The following code is the implementation of the HTTP-POST Create method:

[image: 201]

And now both our Edit and Create screens support drop-down lists for picking the country.


Custom-Shaped ViewModel Classes 

In the scenario above, our DinnerFormViewModel class directly exposes the Dinner model object as a property, along with a supporting SelectList model property. This approach works fine for scenarios where the HTML UI we want to create within our view template corresponds relatively closely to our domain model objects.

 

For scenarios where this isn’t the case, one option that you can use is to create a custom-shaped ViewModel class whose object model is more optimized for consumption by the view — and which might look completely different from the underlying domain model object. For example, it could potentially expose different property names and/or aggregate properties collected from multiple model objects.

 

Custom-shaped ViewModel classes can be used both to pass data from controllers to views to render and to help handle form data posted back to a controller’s action method. For this later scenario, you might have the action method update a ViewModel object with the form-posted data, and then use the View Model instance to map or retrieve an actual domain model object.

 

Custom-shaped ViewModel classes can provide a great deal of flexibility, and are something to investigate any time you find the rendering code within your view templates or the form-posting code inside your action methods starting to get too complicated. This is often a sign that your domain models don’t cleanly correspond to the UI you are generating, and that an intermediate custom-shaped ViewModel class can help.




Partials and Master Pages 

One of the design philosophies ASP.NET MVC embraces is the Do Not Repeat Yourself principle (commonly referred to as DRY). A DRY design helps eliminate the duplication of code and logic, which ultimately makes applications faster to build and easier to maintain.

 

We’ve already seen the DRY principle applied in several of our NerdDinner scenarios. A few examples: our validation logic is implemented within our model layer, which enables it to be enforced across both edit and create scenarios in our controller; we are reusing the “NotFound” view template across the Edit, Details and Delete action methods; we are using a convention-naming pattern with our view templates, which eliminates the need to explicitly specify the name when we call the View helper method; and we are reusing the DinnerFormViewModel class for both Edit and Create action scenarios.

 

Let’s now look at ways we can apply the DRY Principle within our view templates to eliminate code duplication there as well.


Revisiting Our Edit and Create View Templates 

Currently we are using two different view templates — Edit.aspx and Create.aspx — to display our Dinner form UI. A quick visual comparison of them highlights how similar they are. Figure 1-101 shows what the create form looks like:

Figure 1-101
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And Figure 1-102 is what our “Edit” form looks like.

 

Not much of a difference is there? Other than the title and header text, the form layout and input controls are identical.

 

If we open up the Edit.aspx and Create.aspx view templates, we’ll find that they contain identical form layout and input control code. This duplication means we end up having to make changes twice anytime we introduce or change a new Dinner property — which is not good.


Using Partial View Templates 

ASP.NET MVC supports the ability to define partial view templates that can be used to encapsulate view rendering logic for a sub-portion of a page. Partials provide a useful way to define view rendering logic once, and then reuse it in multiple places across an application.

Figure 1-102
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To help “DRY-up” our Edit.aspx and Create.aspx View template duplication, we can create a partial View template named DinnerForm.ascx that encapsulates the form layout and input elements common to both. We’ll do this by right-clicking on our \Views\Dinners directory and choosing the Add ⇒ View menu command shown in Figure 1-103:

Figure 1-103
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This will display the Add View dialog. We’ll name the new view we want to create DinnerForm, select the “Create a partial view” checkbox on the dialog, and indicate that we will pass it a DinnerFormViewModel class (see Figure 1-104).

Figure 1-104
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When we click the Add button, Visual Studio will create a new DinnerForm.ascx view template for us within the \Views\Dinners directory.

 

We can then copy/paste the duplicate form layout/input control code from our Edit.aspx/ Create.aspx view templates into our new DinnerForm.ascx partial view template:
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We can then update our Edit and Create view templates to call the DinnerForm partial template and eliminate the form duplication. We can do this by calling Html.RenderPartial(“DinnerForm”) within our view templates:

Create.aspx
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Edit.aspx
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You can explicitly qualify the path of the partial template you want when calling Html.RenderPartial (for example: ~ /Views/Dinners/DinnerForm.ascx). In our previous code, though, we are taking advantage  of the convention-based naming pattern within ASP.NET MVC, and just specifying Dinner Form as the name of the partial to render. When we do this, ASP.NET MVC will look first in the convention-based views directory (for Dinners Controller this would be /Views/Dinners). If it doesn’t find the partial template there, it will then look for it in the /Views/Shared directory.

 

When Html.RenderPartial is called with just the name of the partial view, ASP.NET MVC will pass to the partial view the same Model and ViewData dictionary objects used by the calling view template. Alternatively, there are overloaded versions of Html.RenderPartial that enable you to pass an alternate Model object and/or ViewData dictionary for the partial view to use. This is useful for scenarios where you only want to pass a subset of the full Model/ViewModel.

Why <% %> Instead of <%= %>?

One of the subtle things you might have noticed with the previous code is that we are using a <% %> block instead of a <%= %> block when calling Html.RenderPartial.

<%= %> blocks in ASP.NET indicate that a developer wants to render a specified value (for example: <%= “Hello” %> would render “Hello”). <% %> blocks instead indicate that the developer wants to execute code, and that any rendered output within them must be done explicitly (for example: <% Response.Write(“Hello”); %>).

The reason we are using a <% %> block with our previous Html.Render Partial code is because the Html.RenderPartial method doesn’t return a string, and instead outputs the content directly to the calling the View template’s output stream. It does this for performance efficiency reasons, and by doing so, it avoids the need to create a (potentially very large) temporary string object. This reduces memory usage and improves overall application throughput.

One common mistake when using Html.RenderPartial is to forget to add a semicolon at the end of the call when it is within a <% %> block. For example, this code will cause a compiler error:
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You instead need to write:

[image: 211]

This is because <% %> blocks are self-contained code statements, and when using C# code statements, need to be terminated with a semicolon.



Using Partial View Templates to Clarify Code 

We created the Dinner Form partial view template to avoid duplicating view rendering logic in multiple places. This is the most common reason to create partial view templates.

 

Sometimes it still makes sense to create partial views even when they are only being called in a single place. Very complicated view templates can often become much easier to read when their view rendering logic is extracted and partitioned into one or more well-named partial templates.

For example, consider the below code-snippet from the e file in our project (which we will be looking at shortly). The code is relatively straightforward to read — partly because the logic to display a login/logout link at the top right of the screen is encapsulated within the Log On User Control partial:
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Whenever you find yourself getting confused trying to understand the HTML/code markup within a view template, consider whether it wouldn’t be clearer if some of it was extracted and refactored into well-named partial views.


Master Pages 

In addition to supporting partial views, ASP.NET MVC also supports the ability to create master page templates that can be used to define the common layout and top-level HTML of a site. Content placeholder controls can then be added to the master page to identify replaceable regions that can be overridden or filled in  by views. This provides a very effective (and DRY) way to apply a common layout across an application.

 

By default, new ASP.NET MVC projects have a master page template automatically added to them. This master page is named Site.master and lives within the \Views\Shared\ folder as shown in  Figure 1-105.

 

The default Site.master file looks like the following code. It defines the outer HTML of the site, along with a menu for navigation at the top. It contains two replaceable content placeholder controls — one for the title, and the other for where the primary content of a page should be replaced:
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Figure 1-105
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All of the view templates we’ve created for our NerdDinner application (“List”, “Details”, “Edit”, “Create”, “NotFound”, etc.) have been based on this Site.master template. This is indicated via the

Master Page File attribute that was added by default to the top <% @ Page %> directive when we created our views using the Add View dialog:
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What this means is that we can change the Site.master content, and have the changes automatically be applied and used when we render any of our view templates.

 

Let’s update our Site.master’s header section so that the header of our application is “NerdDinner” instead of “My MVC Application.” Let’s also update our navigation menu so that the first tab is “Find a Dinner” (handled by the HomeController’s Index action method), and let’s add a new tab called “Host a Dinner” (handled by the DinnersController’s Create action method):

[image: 217]

When we save the Site.master file and refresh our browser, we’ll see our header changes show up across all views within our application. For example, see Figure 1-106.

Figure 1-106
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And with the /Dinners/Edit/[id] URL (Figure 1-107):

Figure 1-107
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Partials and master pages provide very flexible options that enable you to cleanly organize views. You’ll find that they help you avoid duplicating view content/code, and make your view templates easier to read and maintain.




Paging Support 

If our site is successful, it will have thousands of upcoming dinners. We need to make sure that our UI scales to handle all of these dinners and allows users to browse them. To enable this, we’ll add paging support to our /Dinners URL so that instead of displaying thousands of dinners at once, we’ll only display 10 upcoming dinners at a time — and allow end users to page back and forward through the entire list in an SEO friendly way.


Index() Action Method Recap 

The Index action method within our Dinners Controller class currently looks like the following code:
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When a request is made to the /Dinners URL, it retrieves a list of all upcoming dinners and then renders a listing of all of them (Figure 1-108):

Figure 1-108

[image: 221]




Understanding IQueryable<T>

I Queryable<T> is an interface that was introduced with LINQ in .NET 3.5. It enables powerful deferred execution scenarios that we can take advantage of to implement paging support.

In our Dinner Repository in the following code we are returning an I Query able <Dinner> sequence from our Find Upcoming Dinners method:
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The IQueryable<Dinner> object returned by our Find Up coming Dinners method encapsulates a query to retrieve Dinner objects from our database using LINQ to SQL. Importantly, it won’t execute the query against the database until we attempt to access/iterate over the data in the query, or until we call the To List method on it. The code calling our Find Up coming Dinners method can optionally choose to add additional “chained” operations/filters to the IQueryable<Dinner> object before executing the query. LINQ to SQL is then smart enough to execute the combined query against the database when the data is requested.

 

To implement paging logic, we can update our Index action method so that it applies additional Skip and Take operators to the returned IQueryable<Dinner> sequence before calling ToList on it:
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The above code skips over the first 10 upcoming dinners in the database, and then returns 20 dinners. LINQ to SQL is smart enough to construct an optimized SQL query that performs this skipping logic in the SQL database — and not in the web server. This means that even if we have millions of upcoming dinners in the database, only the 10 we want will be retrieved as part of this request (making it efficient and scalable).


Adding a “page” Value to the URL 

Instead of hard-coding a specific page range, we’ll want our URLs to include a page parameter that indicates which Dinner range a user is requesting.


Using a Querystring Value 

The code that follows demonstrates how we can update our Index action method to support a querystring parameter and enable URLs like /Dinners?page=2:
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The Index action method in the previous code has a parameter named page. The parameter is declared as a nullable integer. This means that the /Dinners?page=2 URL will cause a value of “2” to be passed as the parameter value. The /Dinners URL (without a querystring value) will cause a null value to be passed.

 

We are multiplying the page value by the page size (in this case 10 rows) to determine how many dinners to skip over. We are using the C# “coalescing” operator (??) which is useful when dealing with nullable types. The previous code assigns page the value of 0 if the page parameter is null.


Using Embedded URL Values 

An alternative to using a querystring value would be to embed the page parameter within the actual URL itself. For example: /Dinners/Page/2 or /Dinners/2. ASP.NET MVC includes a powerful URL routing engine that makes it easy to support scenarios like this.

 

We can register custom routing rules that map any incoming URL or URL format to any controller class or action method we want. All we need to do is to open the Global.asax file within our project (Figure 1-109).

Figure 1-109
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And then register a new mapping rule using the MapRoute helper method as in the first call to routes.MapRoute that follows:

[image: 226]

In the previous code, we are registering a new routing rule named “UpcomingDinners”. We are indicating it has the URL format “Dinners/Page/{page}” — where {page} is a parameter value embedded within the URL. The third parameter to the MapRoute method indicates that we should map URLs that match this format to the Index action method on the DinnersController class.

 

We can use the exact same Index code we had before with our Querystring scenario — except now our page parameter will come from the URL and not the querystring:
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And now when we run the application and type in /Dinners, we’ll see the first 10 upcoming dinners, as shown in Figure 1-110.

Figure 1-110
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And when we type in /Dinners/Page/1, we’ll see the next page of dinners (Figure 1-111):

Figure 1-111
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Adding Page Navigation UI 

The last step to complete our paging scenario will be to implement “next” and “previous” navigation UI within our view template to enable users to easily skip over the Dinner data.

To implement this correctly, we’ll need to know the total number of Dinners in the database, as well as how many pages of data this translates to. We’ll then need to calculate whether the currently requested “page” value is at the beginning or end of the data, and show or hide the “previous” and “next” UI accordingly. We could implement this logic within our Index action method. Alternatively, we can add a helper class to our project that encapsulates this logic in a more reusable way.

 

The following code is a simple Paginated List helper class that derives from the List<T> collection class built into the .NET Framework. It implements a reusable collection class that can be used to paginate any sequence of IQueryable data. In our NerdDinner application we’ll have it work over IQueryable<Dinner> results, but it could just as easily be used against I Query able <Product> or I Query able<Customer> results in other application scenarios:
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Notice in the previous code how it calculates and then exposes properties like PageIndex, PaegeSize, TotalCount, and TotalPages. It also then exposes two helper properties Has Previous Page and Has Next Page that indicate whether the page of data in the collection is at the beginning or end of the original sequence. The above code will cause two SQL queries to be run — the first to retrieve the count of the total number of Dinner objects (this doesn’t return the objects — rather it performs a SELECT COUNT statement that returns an integer), and the second to retrieve just the rows of data we need from our database for the current page of data.

 

We can then update our DinnersController.Index helper method to create a PaginatedList<Dinner> from our DinnerRepository.FindUpcomingDinners result, and pass it to our view template:
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We can then update the \Views\Dinners\Index.aspx view template to inherit from ViewPage<NerdDinner.Helpers.PaginatedList<Dinner>> instead of ViewPage<IEnumerable<Dinner>>, and then add the following code to the bottom of our view template to show or hide next and previous navigation UI:
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Notice, in the previous code, how we are using the Html.RouteLink helper method to generate our hyperlinks. This method is similar to the Html.ActionLink helper method we’ve used previously. The difference is that we are generating the URL using the “UpcomingDinners” routing rule we set up within our Global.asax file. This ensures that we’ll generate URLs to our Index action method that have the format: /Dinners/Page/{page} — where the {page} value is a variable we are providing above based on the current PageIndex.

 

And now when we run our application again, we’ll see 10 dinners at a time in our browser, as shown in  Figure 1-112.

 

We also have <<< and >>> navigation UI at the bottom of the page that allows us to skip forwards and backwards over our data using search-engine-accessible URLs (Figure 1-113).

Figure 1-112
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Figure 1-113
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Understanding the Implications of IQueryable <T>

IQueryable<T> is a very powerful feature that enables a variety of interesting deferred execution scenarios (like paging and composition-based queries). As with all powerful features, you want to be careful with how you use it and make sure it is not abused.

It is important to recognize that returning an IQueryable<T> result from your repository enables calling code to append on chained operator methods to it and so participate in the ultimate query execution. If you do not want to provide calling code this ability, then you should return back IList<T>, List<T> or IEnumerable<T> results — which contain the results of a query that has already executed.

For pagination scenarios, this would require you to push the actual data pagination logic into the repository method being called. In this scenario, we might update our FindUpcomingDinners finder method to have a signature that either returned a PaginatedList:
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or returned an IList<Dinner>, and use a totalCount out param to return the total count of Dinners:
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Authentication and Authorization 

Right now our NerdDinner application grants anyone visiting the site the ability to create and edit the details of any dinner. Let’s change this so that users need to register and log in to the site to create new dinners, and add a restriction so that only the user who is hosting a dinner can edit it later.

 

To enable this we’ll use authentication and authorization to secure our application.


Understanding Authentication and Authorization 

Authentication is the process of identifying and validating the identity of a client accessing an application. Put more simply, it is about identifying who the end user is when they visit a website.

 

ASP.NET supports multiple ways to authenticate browser users. For Internet web applications, the most common authentication approach used is called Forms Authentication. Forms Authentication enables a developer to author an HTML login form within their application and then validate the username/password an end user submits against a database or other password credential store. If the username/password combination is correct, the developer can then ask ASP.NET to issue an encrypted HTTP cookie to identify the user across future requests. We’ll be using forms authentication with our NerdDinner application.

Authorization is the process of determining whether an authenticated user has permission to access a particular URL/resource or to perform some action. For example, within our NerdDinner application we’ll want to authorize only users who are logged in to access the /Dinners/Create URL and create new dinners. We’ll also want to add authorization logic so that only the user who is hosting a dinner can edit it — and deny edit access to all other users.


Forms Authentication and the AccountController 

The default Visual Studio project template for ASP.NET MVC automatically enables forms authentication when new ASP.NET MVC applications are created. It also automatically adds a pre-built account login implementation to the project — which makes it really easy to integrate security within a site.

 

The default Site.master master page displays a [Log On] link (shown in Figure 1-114) at the top right of the site when the user accessing it is not authenticated:

Figure 1-114
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Clicking the [Log On] link takes a user to the /Account/LogOn URL (Figure 1-115)

 

Visitors who haven’t registered can do so by clicking the Register link — which will take them to the /Account/Register URL and allow them to enter account details (Figure 1-116).

 

Clicking the Register button will create a new user within the ASP.NET Membership system, and authenticate the user onto the site using forms authentication.

 

When a user is logged in, the Site.master changes the top right of the page to output a “Welcome [username]!” message and renders a [Log Off] link instead of a [Log On] one. Clicking the [Log Off] link logs out the user (Figure 1-117).

Figure 1-115
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Figure 1-116
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Figure 1-117
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The above login, logout, and registration functionality is implemented within the AccountController class that was added to our project by VS when it created it. The UI for the AccountController is implemented using view templates within the \Views\Account directory (Figure 1-118).

Figure 1-118

[image: 242]

The AccountController class uses the ASP.NET Forms Authentication system to issue encrypted authentication cookies, and the ASP.NET Membership API to store and validate usernames/passwords. The ASP. NET Membership API is extensible and enables any password credential store to be used. ASP.NET ships with built-in membership provider implementations that store username/passwords within a SQL database, or within Active Directory.

 

We can configure which membership provider our NerdDinner application should use by opening the web.config file at the root of the project and looking for the <membership> section within it. The default web.config, added when the project was created, registers the SQL membership provider, and configures it to use a connection-string named ApplicationServices to specify the database location.

 

The default ApplicationServices connection string (which is specified within the <connectionStrings> section of the web.config file) is configured to use SQL Express. It points to a SQL Express database named ASPNETDB.MDF under the application’s App_Data directory. If this database doesn’t exist the first time the Membership API is used within the application, ASP.NET will automatically create the database and provision the appropriate membership database schema within it (Figure 1-119).

Figure 1-119
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If instead of using SQL Express we wanted to use a full SQL Server instance (or connect to a remote database), all we’d need to do is to update the ApplicationServices connection string within the web.config file and make sure that the appropriate membership schema has been added to the database it points at. You can run the aspnet_regsql.exe utility within the \Windows\Microsoft.NET\ Framework\v2.0.50727\ directory to add the appropriate schema for membership and the other ASP.NET application services to a database.


Authorizing the /Dinners/Create URL Using the [Authorize] Filter 

We didn’t have to write any code to enable a secure authentication and account management implementation for the NerdDinner application. Users can register new accounts with our application, and log in/log out of the site. And now we can add authorization logic to the application, and use the authentication status and username of visitors to control what they can and can’t do within the site.

 

Let’s begin by adding authorization logic to the Create action methods of our DinnersController class. Specifically, we will require that users accessing the /Dinners/Create URL must be logged in. If they aren’t logged in, we’ll redirect them to the login page so that they can sign in.

Implementing this logic is pretty easy. All we need to do is to add an [Authorize] filter attribute to our Create action methods like so:
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ASP.NET MVC supports the ability to create action filters that can be used to implement reusable logic that can be declaratively applied to action methods. The [Authorize] filter is one of the built-in action filters provided by ASP.NET MVC, and it enables a developer to declaratively apply authorization rules to action methods and controller classes.

 

When applied without any parameters (as in the previous code), the [Authorize] filter enforces that the user making the action method request must be logged in — and it will automatically redirect the browser to the login URL if they aren’t. When doing this redirect, the originally requested URL is passed as a querystring argument (for example: /Account/LogOn?ReturnUrl=%2fDinners%2fCreate). The AccountController will then redirect the user back to the originally requested URL once they log in.

 

The [Authorize] filter optionally supports the ability to specify a Users or Roles property that can be used to require that the user is both logged in and within a list of allowed users or a member of an allowed security role. For example, the code below only allows two specific users, scottgu and billg, to access the /Dinners/Create URL:
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Embedding specific user names within code tends to be pretty unmaintainable though. A better approach is to define higher-level roles that the code checks against, and then to map users into the role using either a database or active directory system (enabling the actual user mapping list to be stored externally from the code). ASP.NET includes a built-in role management API as well as a built-in set of role providers (including ones for SQL and Active Directory) that can help perform this user/role mapping. We could then update the code to only allow users within a specific “admin” role to access the /Dinners/Create URL:
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Using the User.Identity.Name Property When Creating Dinners 

We can retrieve the username of the currently logged-in user of a request using the User.Identity.Name property exposed on the Controller base class.

 

Earlier, when we implemented the HTTP-POST version of our Create action method, we had hard-coded the HostedBy property of the dinner to a static string. We can now update this code to instead use the User.Identity.Name property, as well as automatically add an RSVP for the host creating the dinner:

[image: 247]

Because we have added an [Authorize] attribute to the Create method, ASP.NET MVC ensures that the action method only executes if the user visiting the /Dinners/Create URL is logged in on the site. As such, the User.Identity.Name property value will always contain a valid username.


Using the User.Identity.Name Property When Editing Dinners 

Let’s now add some authorization logic that restricts users so that they can only edit the properties of dinners they themselves are hosting.

 

To help with this, we’ll first add an IsHostedBy(username) helper method to our Dinner object (within the Dinner.cs partial class we built earlier). This helper method returns true or false,  depending on whether a supplied username matches the Dinner HostedBy property, and encapsulates the logic necessary to perform a case-insensitive string comparison of them:
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We’ll then add an [Authorize] attribute to the Edit action methods within our DinnersController class. This will ensure that users must be logged in to request a /Dinners/Edit/[id] URL.

 

We can then add code to our Edit methods that uses the Dinner.IsHostedBy(username) helper method to verify that the logged-in user matches the dinner host. If the user is not the host, we’ll display an “InvalidOwner” view and terminate the request. The code to do this looks like the following:
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We can then right-click on the \Views\Dinners directory and choose the Add ⇒ View menu command to create a new “InvalidOwner” view. We’ll populate it with the following error message:
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And now when a user attempts to edit a dinner they don’t own, they’ll get the error message shown in  Figure 1-120.

Figure 1-120
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We can repeat the same steps for the Delete action methods within our controller to lock down permission to delete dinners as well, and ensure that only the host of a dinner can delete it.


Showing/Hiding Edit and Delete Links 

We are linking to the Edit and Delete action method of our DinnersController class from our /Details URL (Figure 1-121).

 

Currently we are showing the Edit and Delete action links regardless of whether the visitor to the details URL is the host of the dinner. Let’s change this so that the links are only displayed if the visiting user is the owner of the dinner.

Figure 1-121
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The Details action method within our DinnersController retrieves a Dinner object and then passes it as the model object to our view template:
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We can update our view template to conditionally show/hide the Edit and Delete links by using the Dinner.IsHostedBy helper method as in the code that follows:
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AJAX Enabling RSVPs Accepts 

Let’s now add support for logged-in users to RSVP their interest in attending a dinner. We’ll implement this using an AJAX-based approach integrated within the dinner details page.


Indicating Whether the User Is RSVP’ed 

Users can visit the /Dinners/Details/[id] URL to see details about a particular dinner (Figure 1-122).

Figure 1-122
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The Details action method is implemented like so:
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Our first step to implement RSVP support will be to add an IsUserRegistered(username) helper method to our Dinner object (within the Dinner.cs partial class we built earlier). This helper method returns true or false, depending on whether the user is currently RSVP’d for the dinner:
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We can then add the following code to our Details.aspx view template to display an appropriate message indicating whether the user is registered or not for the event:
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And now when a user visits a dinner they are registered for they’ll see the message in Figure 1-123.

Figure 1-123

[image: 261]

And when they visit a dinner they are not registered for, they’ll see the message in Figure 1-124.

Figure 1-124
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Implementing the Register Action Method 

Let’s now add the functionality necessary to enable users to RSVP for a dinner from the details page.

 

To implement this, we’ll create a new RSVPController class by right-clicking on the \Controllers directory and choosing the Add ⇒ Controller menu command.

 

We’ll implement a Register action method within the new RSVPController class that takes an ID for a dinner as an argument, retrieves the appropriate Dinner object, checks to see if the logged-in user is currently in the list of users who have registered for it, and if not adds an RSVP object for them:
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Notice, in the previous code, how we are returning a simple string as the output of the action method. We could have embedded this message within a view template — but since it is so small we’ll just use the Content helper method on the controller base class and return a string message like that above.


Calling the Register Action Method Using AJAX 

We’ll use AJAX to invoke the Register action method from our Details view. Implementing this is pretty easy. First we’ll add two script library references:
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The first library references the core ASP.NET AJAX client-side script library. This file is approximately 24k in size (compressed) and contains core client-side AJAX functionality. The second library contains utility functions that integrate with ASP.NET MVC’s built-in AJAX helper methods (which we’ll use shortly).

 

We can then update the view template code we added earlier so that, instead of outputing a “You are not registered for this event” message, we render a link that when pushed performs an AJAX call that invokes our Register action method on our RSVP controller and RSVPs the user:
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The Ajax.ActionLink helper method in the previous code is built into ASP.NET MVC and is similar to the Html.ActionLink helper method except that instead of performing a standard navigation, it makes an AJAX call to the action method. Above we are calling the “Register” action method on the “RSVP” controller and passing the DinnerID as the id parameter to it. The final AjaxOptions parameter we are passing indicates that we want to take the content returned from the action method and update the HTML <div> element on the page whose id is “rsvpmsg”.

 

And now when a user browses to a dinner they aren’t registered for yet, they’ll see a link to RSVP for it (Figure 1-125).

Figure 1-125
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If they click the “RSVP for this event” link, they’ll make an AJAX call to the Register action method on the RSVP controller, and when it completes they’ll see an updated message like that in Figure 1-126.

 

The network bandwidth and traffic involved when making this AJAX call is really lightweight. When the user clicks on the “RSVP for this event” link, a small HTTP POST network request is made to the /Dinners/Register/1 URL that looks like the following on the wire:
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And the response from our Register action method is simply:
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Figure 1-126
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This lightweight call is fast and will work even over a slow network.


Adding a jQuery Animation 

The AJAX functionality we implemented works well and fast. Sometimes it can happen so fast, though, that a user might not notice that the RSVP link has been replaced with new text. To make the outcome a little more obvious, we can add a simple animation to draw attention to the updates message.

 

The default ASP.NET MVC project template includes jQuery — an excellent (and very popular) open source JavaScript library that is also supported by Microsoft. jQuery provides a number of features, including a nice HTML DOM selection and effects library.

 

To use jQuery, we’ll first add a script reference to it. Because we are going to be using jQuery within a variety of places within our site, we’ll add the script reference within our Site.master master page file so that all pages can use it.
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Make sure you have installed the JavaScript IntelliSense hotfix for VS 2008 SP1 that enables richer intellisense support for JavaScript files (including jQuery). You can download it from:  http:// tinyurl.com/vs2008javascripthotfix


Code written using JQuery often uses a global $() JavaScript method that retrieves one or more HTML elements using a CSS selector. For example, $(“#rsvpmsg”) selects any HTML element with the ID of rsvpmsg, while $(“.something“) would select all elements with the “something” CSS class name.

You can also write more advanced queries like “return all of the checked radio buttons” using a selector query like: $(“input[@type=radio][@checked]“).

 

Once you’ve selected elements, you can call methods on them to take action, such as hiding them: $(“#rsvpmsg”).hide();

 

 

For our RSVP scenario, we’ll define a simple JavaScript function named Animate RSVP Message that selects the “rsvpmsg” <div> and animates the size of its text content. The code below starts the text small and then causes it to increase over a 400 milliseconds timeframe:
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We can then wire up this JavaScript function to be called after our AJAX call successfully completes by passing its name to our Ajax.ActionLink helper method (via the Ajax Options OnSuccess event property):
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And now when the “RSVP for this event” link is clicked and our AJAX call completes successfully, the content message sent back will animate and grow large (Figure 1-127).

Figure 1-127
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In addition to providing an OnSuccess event, the Ajax Options object exposes OnBegin, OnFailure, and OnComplete events that you can handle (along with a variety of other properties and useful options).


Cleanup — Refactor Out a RSVP Partial View 

Our details view template is starting to get a little long, which over time will make it a little harder to understand. To help improve the code readability, let’s finish up by creating a partial view — RSVPStatus.ascx — that encapsulates all of the RSVP view code for our Details page.

 

We can do this by right-clicking on the \Views\Dinners folder and then choosing the Add ⇒ View menu command. We’ll have it take a Dinner object as its strongly typed ViewModel. We can then copy/paste the RSVP content from our Details.aspx view into it.

 

Once we’ve done that, let’s also create another partial view — EditAndDeleteLinks.ascx  —  that encapsulates our Edit and Delete link view code. We’ll also have it take a Dinner object as its strongly typed ViewModel, and copy/paste the Edit and Delete logic from our Details.aspx view into it.

 

Our details view template can then just include two Html.RenderPartial method calls at the bottom:
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This makes the code cleaner to read and maintain.




Integrating an AJAX Map 

We’ll now make our application a little more visually exciting by integrating AJAX mapping support. This will enable users who are creating, editing, or viewing dinners to see the location of the dinner graphically.


Creating a Map Partial View 

We are going to use mapping functionality in several places within our application. To keep our code DRY, we’ll encapsulate the common map functionality within a single partial template that we can reuse across multiple controller actions and views. We’ll name this partial view map.ascx and create it within the \Views\Dinners directory.

 

We can create the map.ascx partial by right-clicking on the \Views\Dinners directory and choosing the Add ⇒ View menu command. We’ll name the view Map.ascx, check it as a partial view, and indicate that we are going to pass it a strongly typed Dinner model class (Figure 1-128):

 

When we click the “Add” button our partial template will be created. We’ll then update the Map.ascx file to have the following content:
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Figure 1-128
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The first <script> reference points to the Microsoft Virtual Earth 6.2 mapping library. The second <script> reference points to a map.js file that we will shortly create, which will encapsulate our common JavaScript mapping logic. The <div id=”theMap”> element is the HTML container that Virtual Earth will use to host the map.

 

We then have an embedded <script> block that contains two JavaScript functions specific to this view. The first function uses jQuery to wire up a function that executes when the page is ready to run client-side  script. It calls a Load Map helper function that we’ll define within our Map.js script file to load the Virtual Earth map control. The second function is a callback event handler that adds a pin to the map that identifies a location.

 

Notice how we are using a server-side <%= %> block within the client-side script block to embed the latitude and longitude of the dinner we want to map into the JavaScript. This is a useful technique to output dynamic values that can be used by client-side script (without requiring a separate AJAX call back to the server to retrieve the values — which makes it faster). The <%= %> blocks will execute when the view is rendering on the server — and so the output of the HTML will just end up with embedded JavaScript values (for example: var latitude = 47.64312;).


Creating a Map.js Utility Library 

Let’s now create the Map.js file that we can use to encapsulate the JavaScript functionality for our map (and implement the LoadMap and LoadPin methods above). We can do this by right-clicking on the \Scripts directory within our project, and then choose the Add ⇒ New Item menu command, select the JScript item, and name it Map.js.

 

Below is the JavaScript code we’ll add to the Map.js file that will interact with Virtual Earth to display our map and add locations pins to it for our dinners:
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Integrating the Map with Create and Edit Forms 

We’ll now integrate the Map support with our existing Create and Edit scenarios. The good news is that this is pretty easy to do, and doesn’t require us to change any of our Controller code. Because our Create and Edit views share a common Dinner Form partial view used to implement the dinner form UI, we can add the map in one place and have both our Create and Edit scenarios use it.

 

All we need to do is to open the \Views\Dinners\DinnerForm.ascx partial view and update it to include our new map partial. Below is what the updated Dinner Form will look like once the map is added (the HTML form elements are omitted from the code snippet below for brevity):
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The Dinner Form partial above takes an object of type Dinner Form View Model as its model type (because it needs both a Dinner object and a Select List to populate the drop-down list of countries).

Our map partial just needs an object of type Dinner as its model type, and so when we render the map partial we are passing just the Dinner sub-property of DinnerFormViewModel to it:
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The JavaScript function we’ve added to the partial uses jQuery to attach a blur event to the Address HTML textbox. You’ve probably heard of focus events that fire when a user clicks or tabs into a textbox. The opposite is a blur event that fires when a user exits a textbox. The event handler in the previous code clears the latitude and longitude textbox values when this happens, and then plots the new address location on our map. A callback event handler that we defined within the map.js file will then update the longitude and latitude textboxes on our form using values returned by Virtual Earth based on the address we gave it.

 

And now when we run our application again and click the Host Dinner tab, we’ll see a default map displayed along with our standard Dinner form elements (Figure 1-129).

Figure 1-129
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When we type in an address, and then tab away, the map will dynamically update to display the location, and our event handler will populate the latitude/longitude textboxes with the location values (Figure 1-130).

Figure 1-130
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If we save the new dinner and then open it again for editing, we’ll find that the map location is displayed when the page loads (Figure 1-131).

 

Every time the address field is changed, the map and the latitude/longitude coordinates will update.

 

Now that the map displays the dinner location, we can also change the Latitude and Longitude form fields from being visible textboxes to instead be hidden elements (since the map is automatically updating them each time an address is entered). To do this, we’ll switch from using the Html.TextBox HTML helper to using the Html.Hidden helper method:
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And now our forms are a little more user-friendly (Figure 1-132) and avoid displaying the raw latitude/longitude (while still storing them with each dinner in the database).

Figure 1-131
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Figure 1-132
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Integrating the Map with the Details View 

Now that we have the map integrated with our Create and Edit scenarios, let’s also integrate it with our Details scenario. All we need to do is to call <% Html.RenderPartial(“map”); %> within the Details view.

 

Below is what the source code to the complete Details view (with map integration) looks like:
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And now when a user navigates to a /Dinners/Details/[id] URL, they’ll see details about the dinner, the location of the dinner on the map (complete with a pushpin that when hovered over displays the title of the dinner and the address of it), and have an AJAX link to RSVP for it (Figure 1-133). 

Figure 1-133
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Implementing Location Search in Our Database and Repository 

To finish off our AJAX implementation, let’s add a map to the home page of the application that allows users to graphically search for dinners near them (Figure 1-134).

 

We’ll begin by implementing support within our database and data repository layer to efficiently perform a location-based radius search for dinners. We could use the new geospatial features of SQL 2008 (www.microsoft.com/sqlserver/2008/en/us/spatial-data.aspx) to implement this, or alternatively we can use a SQL function approach that Gary Dryden discussed in article here: www.codeproject.com/KB/cs/distancebetweenlocations.aspx  and Rob Conery blogged about using with LINQ to SQL here: http://blog.wekeroad.com/2007/08/30/linq-and-geocoding/.

 

To implement this technique, we will open the Server Explorer within Visual Studio, select the NerdDinner database, and then right-click on the functions sub-node under it and choose to create a new Scalar-valued function (Figure 1-135).

Figure 1-134
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Figure 1-135
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We’ll then paste in the following Distance Between function:
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We’ll then create a new table-valued function in SQL Server that we’ll call Nearest Dinners (Figure 1-136):

Figure 1-136
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This Nearest Dinners table function uses the Distance Between helper function to return all dinners within 100 miles of the latitude and longitude we supply it:
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To call this function, we’ll first open up the LINQ to SQL designer by double-clicking on the Nerd Dinner.dbml file within our \Models directory (Figure 1-137).

Figure 1-137

[image: 295]

We’ll then drag the Nearest Dinners and Distance Between functions onto the LINQ to SQL designer, which will cause them to be added as methods on our LINQ to SQL Nerd Dinner Data Context class (Figure 1-138).

Figure 1-138
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We can then expose a Find By Location query method on our Dinner Repository class that uses the Nearest Dinner function to return upcoming dinners that are within 100 miles of the specified location:
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Implementing a JSON-Based AJAX Search Action Method 

We’ll now implement a controller action method that takes advantage of the new Find By Location repository method to return a list of Dinner data that can be used to populate a map. We’ll have this action method return the Dinner data in a JSON (JavaScript Object Notation) format so that it can be easily manipulated using JavaScript on the client.

 

To implement this, we’ll create a new Search Controller class by right-clicking on the \Controllers directory and choosing the Add ⇒ >Controller menu command. We’ll then implement a Search By Location action method within the new Search Controller class like the one that follows:
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The SearchController’s Search By Location action method internally calls the Find By Location method on Dinner Respository to get a list of nearby dinners. Rather than return the Dinner objects directly to the client, though, it instead returns Json Dinner objects. The Json Dinner class exposes a subset of Dinner properties (for example: for security reasons it doesn’t disclose the names of the people who have RSVP’ed for a dinner). It also includes an RSVP Count property that doesn’t exist in Dinner — and that is dynamically calculated by counting the number of RSVP objects associated with a particular dinner.

 

We are then using the Json helper method on the Controller base class to return the sequence of dinners using a JSON-based wire format. JSON is a standard text format for representing simple data structures. The following is an example of what a JSON-formatted list of two JsonDinner objects looks like when returned from our action method:
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Calling the JSON-Based AJAX Method Using jQuery 

We are now ready to update the home page of the NerdDinner application to use the SearchController’s Search By Location action method. To do this, we’ll open the /Views/Home/Index.aspx view template and update it to have a textbox, search button, our map, and a <div> element named dinnerList:
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We can then add two JavaScript functions to the page:
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The first JavaScript function loads the map when the page first loads. The second JavaScript function wires up a JavaScript click event handler on the search button. When the button is pressed, it calls the Find Dinners Given Location JavaScript function which we’ll add to our Map.js file:
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This Find DinnersGivenLocation function calls map.Find on the Virtual Earth Control to center it on the entered location. When the Virtual Earth map service returns, the map.Find method invokes the call back Update Map Dinners callback method we passed it as the final argument.

 

The call back Update Map Dinners method is where the real work is done. It uses jQuery’s $.post helper method to perform an AJAX call to our SearchController’s Search By Location action method — passing it the latitude and longitude of the newly centered map. It defines an inline function that will be called when the $.post helper method completes, and the JSON-formatted dinner results returned from the Search By Location action method will be passed it using a variable called dinners. It then does a foreach over each returned dinner, and uses the dinner’s latitude and longitude and other properties to add a new pin on the map. It also adds a dinner entry to the HTML list of dinners to the right of the map. It then wires up a hover event for both the pushpins and the HTML list so that details about the dinner are displayed when a user hovers over them:
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And now when we run the application and visit the home page, we’ll be presented with a map. When we enter the name of a city the map will display the upcoming dinners near it (Figure 1-139).

 

Hovering over a dinner will display details about it (Figure 1-140).

Figure 1-139
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Figure 1-140
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Clicking the Dinner title either in the bubble or on the right-hand side in the HTML list will navigate us to the dinner — which we can then optionally RSVP for (Figure 1-141).

Figure 1-141
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Unit Testing 

Let’s develop a suite of automated unit tests that verify our NerdDinner functionality, and that will give us the confidence to make changes and improvements to the application in the future.


Why Unit Test? 

On the drive into work one morning you have a sudden flash of inspiration about an application you are working on. You realize there is a change you can implement that will make the application dramatically better. It might be a refactoring that cleans up the code, adds a new feature, or fixes a bug.

 

The question that confronts you when you arrive at your computer is — “how safe is it to make this improvement?” What if making the change has side effects or breaks something? The change might be simple and only take a few minutes to implement, but what if it takes hours to manually test out all of the application scenarios? What if you forget to cover a scenario and a broken application goes into production? Is making this improvement really worth all the effort?

 

Automated unit tests can provide a safety net that enables you to continually enhance your applications, and avoid being afraid of the code you are working on. Having automated tests that quickly verify functionality enables you to code with confidence — and empowers you to make improvements you might otherwise not have felt comfortable doing. They also help create solutions that are more maintainable and have a longer lifetime — which leads to a much higher return on investment.

The ASP.NET MVC Framework makes it easy and natural to unit test application functionality. It also enables a Test Driven Development (TDD) workflow that enables test-first-based development.


NerdDinner.Tests Project 

When we created our NerdDinner application at the beginning of this tutorial, we were prompted with a dialog asking whether we wanted to create a unit test project to go along with the application project (Figure 1-142).

Figure 1-142
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We kept the “Yes, create a unit test project” radio button selected — which resulted in a Nerd Dinner.Tests project being added to our solution (Figure 1-143).

Figure 1-143
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The Nerd Dinner.Tests project references the NerdDinner application project assembly, and enables us to easily add automated tests to it that verify the application.


Creating Unit Tests for Our Dinner Model Class 

Let’s add some tests to our Nerd Dinner.Tests project that verify the Dinner class we created when we built our model layer.

 

We’ll start by creating a new folder within our test project called “Models” where we’ll place our model-related tests. We’ll then right-click on the folder and choose the Add ⇒ New Test menu command. This will bring up the Add New Test dialog.

 

We’ll choose to create a Unit Test and name it DinnerTest.cs (Figure 1-144).

Figure 1-144
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When we click the OK button, Visual Studio will add (and open) a Dinner Test.cs file to the project (Figure 1-145).

Figure 1-145
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The default Visual Studio unit test template has a bunch of boilerplate code within it that I find a little messy. Let’s clean it up to just contain the code that follows:
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The [Test Class] attribute on the Dinner Test class above identifies it as a class that will contain tests, as well as optional test initialization and teardown code. We can define tests within it by adding public methods that have a [Test Method] attribute on them.

 

In the following code is the first of two tests we’ll add that exercise our Dinner class. The first test verifies that our Dinner is invalid if a new Dinner is created without all properties being set correctly. The second test verifies that our Dinner is valid when a Dinner has all properties set with valid values:
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You’ll notice above that our test names are very explicit (and somewhat verbose). We are doing this because we might end up creating hundreds or thousands of small tests, and we want to make it easy to quickly determine the intent and behavior of each of them (especially when we are looking through a list of failures in a test runner). The test names should always be named after the functionality they are testing. Above we are using a Noun_ Should_Verb naming pattern.

 

We are structuring the tests using the AAA testing pattern — which stands for Arrange, Act, Assert:

• Arrange: Set up the unit being tested
• Act: Exercise the unit under test and capture results
• Assert: Verify the behavior

When we write tests, we want to avoid having the individual tests do too much. Instead each test should verify only a single concept (which will make it much easier to pinpoint the cause of failures). A good guideline is to try to only have a single assert statement for each test. If you have more than one assert statement in a test method, make sure they are all being used to test the same concept. When in doubt, make another test.


Running Tests 

Visual Studio 2008 Professional (and higher editions) includes a built-in test runner that can be used to run Visual Studio Unit Test projects within the IDE. We can select the Test ⇒ Run ⇒ All Tests in Solution menu command (or press Ctrl-R, A) to run all of our unit tests. Or alternatively we can position our cursor within a specific test class or test method and use the Test ⇒ Run ⇒ Tests in Current Context menu command (or press Ctrl-R, T) to run a subset of the unit tests.

 

Let’s position our cursor within the DinnerTest class and press Ctrl-R, T to run the two tests we just defined. When we do this, a Test Results window will appear within Visual Studio and we’ll see the results of our test run listed within it (Figure 1-146).

Figure 1-146
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The VS test results window does not show the Class Name column by default. You can add this by right-clicking within the Test Results window and using the Add/Remove Columns menu command.


Our two tests took only a fraction of a second to run — and as you can see they both passed. We can now go on and augment them by creating additional tests that verify specific rule validations, as well as cover the two helper methods — IsUserHost and IsUserRegistered — that we added to the Dinner class. Having all these tests in place for the Dinner class will make it much easier and safer to add new business rules and validations to it in the future. We can add our new rule logic to Dinner, and then within seconds verify that it hasn’t broken any of our previous logic functionality.

 

Notice how using a descriptive test name makes it easy to quickly understand what each test is verifying. I recommend using the Tools ⇒ Options menu command, opening the Test Tools/Test Execution configuration screen, and checking the “Double-clicking a failed or inconclusive unit test result displays the point of failure in the test” checkbox. This will allow you to double-click on a failure in the test results window and jump immediately to the assert failure.


Creating DinnersController Unit Tests 

Let’s now create some unit tests that verify our Dinners Controller functionality. We’ll start by right-clicking on the Controllers folder within our Test project and then choose the Add ⇒ New Test menu command. We’ll create a Unit Test and name it DinnersControllerTest.cs.

 

We’ll create two test methods that verify the Details action method on the DinnersController. The first will verify that a view is returned when an existing dinner is requested. The second will verify that a “Not Found” view is returned when a nonexistent dinner is requested:[image: 318]
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The previous code compiles cleanly. When we run the tests, though, they both fail (Figure 1-147).

Figure 1-147
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If we look at the error messages, we’ll see that the reason the tests failed was because our Dinners Repository class was unable to connect to a database. Our NerdDinner application is using a connection string to a local SQL Server Express file which lives under the \App_Data directory of the NerdDinner application project. Because our Nerd Dinner.Tests project compiles and runs in a different directory than the application project, the relative path location of our connection string is incorrect.

 

We could fix this by copying the SQL Express database file to our test project, and then add an appropriate test connection string to it in the App.config of our test project. This would get the above tests unblocked and running.

 

Unit testing code using a real database, though, brings with it a number of challenges. Specifically:•  It significantly slows down the execution time of unit tests. The longer it takes to run tests, the less likely you are to execute them frequently. Ideally, you want your unit tests to be able to be run in seconds — and have it be something you do as naturally as compiling the project.
•  It complicates the setup and cleanup logic within tests. You want each unit test to be isolated and independent of others (with no side effects or dependencies). When working against a real database you have to be mindful of state and reset it between tests.



Let’s look at a design pattern called dependency injection that can help us work around these issues and avoid the need to use a real database with our tests.


Dependency Injection 

Right now Dinners Controller is tightly coupled to the Dinner Repository class. Coupling refers to a situation where a class explicitly relies on another class in order to work:

[image: 321]

Because the Dinner Repository class requires access to a database, the tightly coupled dependency the Dinners Controller class has on the Dinner Repository ends up requiring us to have a database in order for the Dinners Controller action methods to be tested.

 

We can get around this by employing a design pattern called “dependency injection” — which is an approach where dependencies (like repository classes that provide data access) are no longer implicitly created within classes that use them. Instead, dependencies can be explicitly passed to the class that uses them, using constructor arguments. If the dependencies are defined using interfaces, we then have the flexibility to pass in fake dependency implementations for unit test scenarios. This enables us to create test-specific dependency implementations that do not actually require access to a database.

 

To see this in action, let’s implement dependency injection with our DinnersController.


Extracting an IDinnerRepository Interface 

Our first step will be to create a new IDinner Repository interface that encapsulates the repository contract our controllers require to retrieve and update dinners.

 

We can define this interface contract manually by right-clicking on the \Models folder, and then choosing the Add ⇒ New Item menu command and creating a new interface named IDinnerRepository.cs.

 

Alternatively, we can use the refactoring tools built into Visual Studio Professional (and higher editions) to automatically extract and create an interface for us from our existing Dinner Repository class. To extract this interface using VS, simply position the cursor in the text editor on the Dinner Repository class, and then right-click and choose the Refactor ⇒ Extract Interface menu command (Figure 1-148).

Figure 1-148
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This will launch the Extract Interface dialog and prompt us for the name of the interface to create. It will default to IDinner Repository and automatically select all public methods on the existing Dinner Repository class to add to the interface (Figure 1-149).

Figure 1-149
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When we click the OK button, Visual Studio will add a new IDinner Repository interface to our application:
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And our existing Dinner Repository class will be updated so that it implements the interface:
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Updating DinnersController to Support Constructor Injection 

We’ll now update the Dinners Controller class to use the new interface.

 

Currently Dinners Controller is hard-coded such that its dinner Repository field is always a Dinner Repository instance:
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We’ll change it so that the dinner Repository field is of type I Dinner Repository instead of DinnerRepository. We’ll then add two public Dinners Controller constructors. One of the constructors allows an IDinner Repository to be passed as an argument. The other is a default constructor that uses our existing Dinner Repository implementation:

[image: 327]

Because ASP.NET MVC, by default creates controller classes using default constructors, our Dinners Controller at runtime will continue to use the Dinner Repository class to perform data access.

 

We can now update our unit tests, though, to pass in a fake dinner repository implementation using the parameter constructor. This fake dinner repository will not require access to a real database, and instead will use in-memory sample data.


Creating the FakeDinnerRepository Class 

Let’s create a FakeDinnerRepository class.

 

We’ll begin by creating a Fakes directory within our Nerd Dinner.Tests project and then add a new Fake Dinner Repository class to it (right-click on the folder and choose Add ⇒ New Class, as shown in  Figure 1-150):

Figure 1-150
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We’ll update the code so that the Fake Dinner Repository class implements the IDinner Repository interface. We can then right-click on it and choose the Implement interface IDinnerRepository context menu command (Figure 1-151).

Figure 1-151
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This will cause Visual Studio to automatically add all of the I Dinner Repository interface members to our Fake Dinner Repository class with default stub out implementations:
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We can then update the Fake Dinner Repository implementation to work off of an in-memory List <Dinner> collection passed to it as a constructor argument:

[image: 332]
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We now have a fake I Dinner Repository implementation that does not require a database and can instead work off an in-memory list of Dinner objects.


Using the FakeDinnerRepository with Unit Tests 

Let’s return to the Dinners Controller unit tests that failed earlier because the database wasn’t available. We can update the test methods to use a Fake Dinner Repository populated with sample in-memory dinner data to the DinnersController using the code that follows:
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And now when we run these tests, they both pass (Figure 1-152).

Figure 1-152
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Best of all, they take only a fraction of a second to run, and do not require any complicated setup/cleanup logic. We can now unit test all of our DinnersController action method code (including listing, paging, details, create, update, and delete) without ever needing to connect to a real database.

Dependency Injection Frameworks

Performing manual dependency injection (like we are above) works fine, but does become harder to maintain as the number of dependencies and components in an application increases.

Several dependency injection frameworks exist for .NET that can help provide even more dependency management flexibility. These frameworks, also sometimes called  Inversion of Control (IoC) containers, provide mechanisms that enable an additional level of configuration support for specifying and passing dependencies to objects at runtime (most often using constructor injection). Some of the more popular OSS Dependency Injection/IOC frameworks in .NET include: AutoFac, Ninject, Spring. NET, StructureMap, and Windsor.

ASP.NET MVC exposes extensibility APIs that enable developers to participate in the resolution and instantiation of controllers, and that enables Dependency Injection/IoC frameworks to be cleanly integrated within this process. Using a DI/IOC framework would also enable us to remove the default constructor from our DinnersController — which would completely remove the coupling between it and the DinnerRepositorys.

We won’t be using a dependency injection/IOC framework with our NerdDinner application. But it is something we could consider for the future if the NerdDinner code-base and capabilities grew.



Creating Edit Action Unit Tests 

Let’s now create some unit tests that verify the Edit functionality of the DinnersController. We’ll start by testing the HTTP-GET version of our Edit action:[image: 337]



We’ll create a test that verifies that a View backed by a Dinner Form View Model object is rendered back when a valid dinner is requested:[image: 338]



When we run the test, though, we’ll find that it fails because a null reference exception is thrown when the Edit method accesses the User.Identity.Name property to perform the Dinner.IsHostedBy check.

 

The User object on the Controller base class encapsulates details about the logged-in user, and is populated by ASP.NET MVC when it creates the controller at runtime. Because we are testing the DinnersController outside of a web-server environment, the User object isn’t set (hence the null reference exception).


Mocking the User.Identity.Name Property 

Mocking frameworks make testing easier by enabling us to dynamically create fake versions of dependent objects that support our tests. For example, we can use a mocking framework in our Edit action test to dynamically create a User object that our Dinners Controller can use to look up a simulated username. This will avoid a null reference from being thrown when we run our test.

 

There are many .NET mocking frameworks that can be used with ASP.NET MVC (you can see a list of them here: www.mockframeworks.com/). For testing our NerdDinner application, we’ll use an open source mocking framework called Moq, which can be downloaded for free from www.mockframeworks.com/moq   .

 

Once it is downloaded, we’ll add a reference in our NerdDinner.Tests project to the Moq.dll assembly (Figure 1-153).

Figure 1-153
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We’ll then add an overloaded CreateDinnersControllerAs(username) helper method to the test class that takes a username as a parameter, and which then mocks the User.Identity.Name property on the DinnersController instance:
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Above, we are using Moq to create a Mock object that fakes a ControllerContext object (which is what ASP.NET MVC passes to Controller classes to expose runtime objects like User, Request, Response, and Session). We are calling the SetupGet method on the Mock to indicate that the HttpContext.User.Identity.Name property on ControllerContext should return the username string we passed to the helper method.

 

We can mock any number of ControllerContext properties and methods. To illustrate this, I’ve also added a SetupGet call for the Request.IsAuthenticated property (which isn’t actually needed for the tests below — but which helps illustrate how you can mock Request properties). When we are done we assign an instance of the ControllerContext mock to the DinnersController our helper method returns.

 

We can now write unit tests that use this helper method to test Edit scenarios involving different users:
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And now when we run the tests, they pass (Figure 1-154).

Figure 1-154
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Testing UpdateModel() Scenarios 

We’ve created tests that cover the HTTP-GET version of the Edit action. Let’s now create some tests that verify the HTTP-POST version of the Edit action:
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The interesting new testing scenario for us to support with this action method is its usage of the Update Model helper method on the Controller base class. We are using this helper method to bind form-post values to our Dinner object instance.

 

The following code has two tests that demonstrates how we can supply form posted values for the UpdateModel helper method to use. We’ll do this by creating and populating a FormCollection object, and then assign it to the ValueProvider property on the Controller.

 

The first test verifies that on a successful save the browser is redirected to the details action. The second test verifies that when invalid input is posted the action redisplays the Edit view again with an error message.
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Testing Wrap-Up 

We’ve covered the core concepts involved in unit testing controller classes. We can use these techniques to easily create hundreds of simple tests that verify the behavior of our application.

 

Because our controller and model tests do not require a real database, they are extremely fast and easy to run. We’ll be able to execute hundreds of automated tests in seconds, and immediately get feedback as to whether a change we made broke something. This will help provide us the confidence to continually improve, refactor, and refine our application.

 

We covered testing as the last topic in this chapter — but not because testing is something you should do at the end of a development process! On the contrary, you should write automated tests as early as possible in your development process. Doing so enables you to get immediate feedback as you develop, helps you think thoughtfully about your application’s use case scenarios, and guides you to design your application with clean layering and coupling in mind.

 

A later chapter in this book will discuss Test Driven Development (TDD) and how to use it with ASP.NET MVC. TDD is an iterative coding practice where you first write the tests that your resulting code will satisfy. With TDD you begin each feature by creating a test that verifies the functionality you are about to implement. Writing the unit test first helps ensure that you clearly understand the feature and how it is supposed to work. Only after the test is written (and you have verified that it fails) do you then implement the actual functionality the test verifies. Because you’ve already spent time thinking about the use case of how the feature is supposed to work, you will have a better understanding of the requirements and how best to implement them. When you are done with the implementation you can re-run the test — and get immediate feedback as to whether the feature works correctly. We’ll cover TDD more in Chapter 10.




NerdDinner Wrap -Up 

Our initial version of our NerdDinner application is now complete and ready to deploy on the Web (Figure 1-155).

Figure 1-155
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We used a broad set of ASP.NET MVC features to build NerdDinner. Hopefully the process of developing it shed some light on how the core ASP.NET MVC features work, and provided context on how these features integrate together within an application.

 

The following chapters will go into more depth on ASP.NET MVC and discuss its features in detail.




End of sample
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select new
«
Name = HttpUEility. HemlEncode (p. Productliane)
Price = p.UnitPrice,
Description = HetpUtility.HemlEncode (p.Description) ,
)
retum Json(result)
)
)
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Dinner dinner = dimnerRepository.GetDinner (5);

ey (
Aimner.Country = USA";
Ainner . ContactPhone = *425-555-B0GUS

Aimerrepository.Save();

)
caten (

var errors = dinner.GetRuleViolations():

/1 a0 sonething to fix errors
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<¥= Heml.TextBox ("EventDate®, String.Format("(0:g)", Model.EventDate)) %>
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Foutes.Add(new RestRoute ("Broducts’)):
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Fine Wine

Thanks - we'll see you there!
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Country*>Country:</label>
<t= Html.DropDownbist (“Country”, Model.Countries) %>
Henl Validationliessage ("Country®, “+*) %>

ContactPhone*>Contact Phone #:</label>
HEnl TextBox (“ContactPhone®, Hodel.Dinner .Contact?hone) 1>
Henl Validationtiessage (*ContactPhone®, *+°) ¥>

<«

<input type='subnit® value='Save' />
</p>
</tielasers

<) %
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<4= Html.Actionlink(dinner.Title, 'Details’, new ( id=dimner.DinnerID }) %>
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<!DOCTYPE html PUBLIC *-//W3C//DTD XHTML 1.0 Transitional//EN"
“Rttp: //waa. 43 .org/TR/xhtml1/DTD/ xhtml1-transit ional .dtd~>

<html xmlns="http: / /a3 .org/1999 /xhtul” >

<head runat="server*>
<titlesUntitled Pagec/title>

</head>

<body>
<torn 1a=
<aiv>
Hello from your cousin the WebForm!
<ratv
</torm>

</poay>

</html>

fornl® runats"server'>
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public ActionResult BAit(int id) (
var product = new Product (Name = "ASP.NET WVC®)

retum View(product);
)
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posted. Savehs (Server . Happath (*~/Uploaded/* +
‘Systen. 10. Path. GetPi Leltane (posted. Fileliame) ) ) ;
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Inheritsssysten.ieb. IV, Viewpage<ierdbinner .Control lers. DinnerFornviewtiodel>
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IBnunerable<Ruleviolation> errors) (

foreach (Ruleviolation issue in errors) (
modelstate. AddodelError (1ssue. Propertyliane, issue.ErrorNiessage) ;
)
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public interface IHttpHandler
«

vo1d ProcessRequest (HttpContext context);

bool IsReusable ( get; )
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<asp:Content ID="Title" ContentPlaceHolderID="TitleContent® runats'server®>
Dinner Not Found
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[MyhctionPilter])
public class MyController : Controller
0
protected override OnhctionBxecuting (ActionExecutingContext context)
«
e
)
)
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using System;
using System.Collections.Generic;
using System.eb.Hve;

public static class yHelpers
«
public static string Unordersdlist<T>(this HtnlHelper htnl,
IEnunerable<T> itens)
«
throw new NotInpleentedgxception() ;
)
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[ValidateAntiforgeryToken]
public ActionResult Update([Bind (Includ

First, Last®))User user)
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DinnerRepository dinnerRepository = new DimnerRepository();

1/ create First Dimner
Dinner newbinnert = new Dimner() ;
newDinnerl.Title = "Dinner with Scott';
newDinnerl.HostedBy = "ScotGu";
newDinnerl.ContactPhone = ~425-703-8072";

1/ create Second Dinner
Dinner newbinner2 = new Dinner():
newDinner.Title = "Dinner with Bill';
newDinner2.HostedBy = *BillG
newDinner? . ContactPhone = ~425-555-5151°;

7/ 348 Dinners to Repository
dinnerReposi tory . Add (newbinner) ;
dinnerRepository.Add (newDinner2) ;

7/ Persist changes
dinnerRepository . Save () ;
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[TestClass)
public class DinnersControllerTest

List<Dinner> CreateTestbimers() (
List<Dinner> dinners = new List<Dimner>();
for (int 1= 0; &< 101 den) (

Dinner sampleDinner = new Dimner() {
DinnerId = i.
Title = “sanple Dimner,
HostedBy = "SomeUser”,
Address = “Sone Adaress®,
Country = “USA",
ContactPhone = *425-555-1212°,
Description = *Some description’,
Eventbate = DateTime.low.AddDays (1),
Latitude = 99,
Longitude = -89

)
ainners. Add (sampleDinner) ;
)
retum atnners;
)

Dinnerscontroller CreateDinnersController() (
var repository = new FakeDinnerRepository(CreateTestDinners()):
retum new DinnersController (repository);

)

[Testhetnoa)
public voia DetailsAction Should_Return View_For_Dinner() {
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using System;
using System.Collections.Generic;
using System Ling;

using Systen.teb;

using Systen.ieb.Mve;

using NeraDinner Models;

nanespace Nerdbimner.Controllers (
public class DinnersController : Controller (
DinnerRepository dinnerRepository = new DimerRepository();

"
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Finga omer
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You Have Been
Hacked. Have a
Nice Day You Not

1337 Person. All
Your Files are
Belong To Us N00b
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TPaymentService _paymentService;
Taddressvalidator _addressvalidator;
IShippingService _shippingService;
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<ul>
<t foreach(Product p in Model) (v>

<li><t= HemlEncods (p.Productliane) $></1>
@) w
</ut>
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<aiv id=rresultst>
<tHtnl . RenderPart ial (*ProductSearchResults, Viewbata.Model); %>
</div>
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1"
1/ GET: /pinners/pait/2

public ActionResult EAit(int id) (
Dinner dinner = dinnerRepository.GetDimer (1d);
retum View(dinner) ;

)

"

77 %OST: /Dimners/Eait/2

[Accsptverbs (Httperbs. Post) |
public ActionResult EAit(int i, PorCollection fomvalues) (

Dinner dinner = dinnerRepository.GetDimer (1d);

ery (
Updatelioel (dinner) ;

innerRepository.Save();

retum RedirectToAction(*Details®, new  idsdimner.Dinnertd )):

)
caten (
HodelState. AddRuleviolat ions (dinner . GetRuleviolations ())

retum View(dinner) ;
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MapRoute (resource, “create
MapRoute (resource + */new”, *newiten', 'GET*, null);

MapRoute (resource + */(1d)*, "show', "GET', hew ( 1d = 8"\ds* )7
MapRoute (resource + */[i4)", "update’, 'PUT*, new { id = @"\d+* 1);

“POST", null);

MapRoute (resource + */[id)", *delete’, 'DELETE', new ( id = @"\d+" ));
MapRoute (resource + */(id) /dit", "edit®, "GET", new ( id = 8°\d+* ));
)

public void WapRoute(string url, string actiomlame, string httphethod,
object constraints)
«
RouteValuebictionary constraintsbictionary;
if (constraints != null)

«

constraintsDictionary = new RouteValusDictionary(constraints) ;
)
slse
«
constraintsbictionary = new RouteValueDictionary():
)
constraintspictionary.Add("httpliethod®, new HttpMethodConstraint (httpHethod) )

internalRoutes.Add(new Route (url, new MveRouteHandler())
[
Defaults = new Routevalusbictionary (new
{ controller = Resource, action = ationliane }),
Constraints = constraintsbictionary
n:
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DinnerRepository dinnerRepository = new DinnerRepository();

// Retrieve specific dinner by its DimnerID
Dinner dinner = dinnerRepository.GetDinner (5) ;

// Update Dimner properties
dinner.Title = “Update Title';
Ainner Hostedsy = "New Owner":

/1 Persist changes
Ainnerrepository.Save():
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public class PaginatedList<T> : List<T> (

public int PageTndex ( get; private set:
public int Pagesize ( get; privae set

public int TotalCount [ get; private set: ]
public int Totalbages ( get; private set: )

public PaginatedList (IQueryable<t> source, int pagelndex, int pageSize)
Pagelndex = pageIndex;
Pagesize = pageSize;
TotalCount = source.Count ();
Totalpages = (int) Math.Ceiling(Totalcount / (double)PagesSize) ;

this.AddRange (source. Skip (Pagelndex * Pagesize) .Take (Pagesize) )
)

public bool HasPreviousPage (
get (
retum (PageIndex > 0);
)
)

public bool HasliextPage (
get (
retum (PageTndex+] < TotalPages);
)
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public ActionResult About() [
VieuData[‘Title'] = "About Page’;
return View();
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public class SqlProductRepository : IProductRepository (

public IList<Product> GetProducts() (

string connstring = System
~Contiguration
“Conigurationanager
Comnectionstrings [“Northeind']
Comnectienstring;

List<Products> result =

new List<Products>();

using (Sqlconnection conn = new SqlConnect ion(connString))
SqlComnand cnd =

«
new SqlCommand (*SELECT * FROM Products’, com);
conn.open() ;

IDataReader dr = cnd. BxecuteReader (Comandsshavior .CloseConnaction) ;

while (rar.Read()) (
Product p = new Product();
//L0ad the Product
"

result.Add(p)

)

)

retum result:
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TempData(“nessage’] = °I like Tenpbatal®;
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string() allowedProperties = new(]( “Title®, ‘Description’,
“Contactphone*, "Address*,
“Eventate’, “Latitude’,

*Longitude’);

Updateliodel (dinner, allowedProperties);
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public static void RegisterRoutes(RouteCollection routes)
«

routes. IgnoreRoute *(resource) . axd/ (*pathino) )

routes . MapRouta(
*efault,
*(controller) /(action) /(1) ",
new ( controller = "Home', action = “Index’, id =

)
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<system.web>
<caching>
<outputCacheSettings>
<outputcacheProtiles>
<ada name="MyProfile" duratior
</outputcacheprofiles>
</outputcachesettings>
</caching>
</system. web>

60" varyBypar:

none* />
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<% using (Htnl.BeginForm(new (action
<input type="text® name=’query’ siz
<input type="submit® value='go® />

“HelloAjax*))) ( ®
10 />
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public static void RegisterRoutes(RouteCollection routes)
«
routes . MapRoute(“MyRoute*
“reports/(year) / (month)", new ReportRouteHandler()));
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<%= Html.TextArea(“text®, “hello <br/> world") %>





OEBPS/guth_9780470549230_oeb_633_r1.gif
[Timer)
publLic ActionResult Index() (
Viewbata[*Title') = ‘Home Page';
VieuData(“Message"] = “Welcome to ASP.NET MVCI®

var md = new Random() ;
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<script languages®javascript® type
$(docunent) .ready (function() (
§(*#CategoryID*) .change (function() (
var selection = §(*#CategoryID") .val();
$(*#results®) . 1oad("/home, ProductByCategory/* + selection);
m
n;
</seript>

‘text/javascript®>
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"
7/ GET: Dinners/eait/s

(uthorize]
public ActionResult EAit(int i) (

Dinner dinner = dinnerRepository.GetDimner (1d) ;

4f (:ainner. IsHostedBy (User. Identity.Name) )
retum View(“Invalidouner®) ;

retum View(new DinnerFornViewHodel (dimner)) ;

)

”
77 0ST: /Dimners/Eait/s

[Acceptverbs (Hetpverbs. Post) , Authorize]
public ActionResult EAit(int id, FornCollection collection) (

Dinner dinner « dinnerRepository.GetDimner (id) ;

i

tainner. IsHostedBy (User. dentity.Name) )
retum View(“Invalidoner®) ;

ey (
Updateltodel (dinner) ;

atnnerrepository.save() :

retum RedirectTohction*Details’, new (id = dinner.DimnerIp));
)
caten

Hodelstate. AddiodelErrors (dinnerToEdit GetRuleViolations () ;
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<p><8= Html.Encode (ViewData(“Hessage']) $</p>
<t using (Html.BeginForn()) ( %>
P
Mame: <t= Heml.TextBox (“Productliane) %>
<t= Htal.Validationliessage ("Produstllane”) &>
</p>
s
Unit Price: <t Heml.TextBox(*UnitPrice’)t>
<t= Html Validationliessage “UnitPrice’) %>
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public class Simple2Controller : Controller
«
public void Goodbye (string nane)
«
Response.irite(*Goodbye * 4 HEtpUEility.HemlEncods (nane));
)
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Response . Cookies [ "MyCookie'] .Value="Renembering you.
Response. Cookies [ "MyCookie] .HttpOnly=true;
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"
77 GET: /Dinners/Eait/2

public ActionResult Edit(int 1d) (
Dinner dinner = dinnerRepository.GetDimer (1d);

retum View(dinner) ;
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ey (
Updateltodel (dinner) ;
ainnerRepository. Add(dimner) ;
aimnerRepository.Save () ;

return RedirectToaction("Details, new (idsdinner.Dimnerp));

)

cateh (
Hodelstate. AddRul eviolations (dinner . GetRuleViolations )) ;

return View(dinner)
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<ul>

<t foreach (Product p in (Viewbata['Products’) as IBnumerable<Product>)) (%>
<1i><3= tnl.Encode (p. Productllane) $></1i>

@) e

<>





OEBPS/guth_9780470549230_oeb_376_r1.gif
routes.MapRoute “simple®, *(controller)/(action) /(1d)");
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1"
7/ ®0ST: /Dinners/Create

[Acosptverbs (HetpVerbs. Post) |
public ActionResult Create(Dinner dimner) (

if (Modelstate.Isvalid) (

v (
Qinner HostedBy = "SomeUser”;

QinnerRepository. Add(aimner) ;
QinnerRepository.Save() ;

retum RedirectTohction(*Details’, new (id = dinner.Dimnerid ));
)

cateh (
Hodelstate. AddRuleViolations (dinner .GetRuleViolations ()) ;

)

)

return View(dimner):
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protected void Application Start() {
//xoute registration
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Option

Description

url
eype

beforesubmit

Success

aatatype

resetForm

clearrorm

Overrides the form’s action and submits the form to a URL that you set.
Sets the submit method of the form (POST or GET),

A function that s called before the form is submitted. This can be used to validate:
the submitted data or o perform some pre-submission logic. The arguments that
are passed to this form are data (an array of posted data),the form element, and
the options set.

A callback function that's called when the form successfully posts. This function
is passed the response text as well as the response status.

The type of data that is expected from the response. The defaultis null, but you

can also set “json”, “xml”, and “script”.

Indicates whether the form data should be reset on success

Indicates whether the form data should be cleared on success.
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<¥= Html.TextArea("text®, *hello <br /> world", 10, 80, null) %>
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<compilation debug="true’>
<assenblies>

Systen.ieb.Uve, Versions1.0.0.0, Culturesneutral,

PubLicKeyToken=31BF3856AD364B3S " />

*systen. ieb. Abstractions, Version=3.5.0.0, Culture=neutral,

5.0.0, Culturesneutral,

1BPI856ADIGAEIS />
‘Systen.Core, Version=3.5.0.0, Culture=neutral,
PubLicKeyToken=BI7ASC561934E089" />
<add assenbly="Systen. Data .DatasetExtensions, Versions3.5.0.0,
Culture=neutral, PublicKeyToken=BITASCS61934E089" />
Systen.ieb. Extensions, Version=3.5.0.0, Cultur
PublicKeyToken=318F3856AD364E35 " />
<add assembly="Systen.¥nl .Ling, Versions3.5.0.0, Culturesneutral,
PublicKeyToken-BT7ASC561934E089 />
</assenblies>
</compilation>
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public class FakeDinnerRepository : IDinnerRepository (

public Iueryable<Dinner> FindhliDinnexs() (
throw new Not InplenentedException();
)

public Igueryable<Dinner> FindByLocation(float lat, float long)(
throw new ot InplenentedBxception ();
)
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RouteTable.Routes.Add (new Route (*somepage”,
new WebFornRouteHandler (~/webforms /sohepage.aspx”) )
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public class DimnerFormViewModel (

/1 Properties
public Dinner  Dimner  ( get; private set; )
public Selectlist Countries { get; private set; }

17 constructor
public Dinnerfornviewlodel (Dinner dinner) (
Dinner = ainner;
Countries = new SelectList (PhoneValidator .AllCountries,
ainner.Countxy);
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public static void RegisterRoutes (RouteCollection routes)
0

routes. IgnoreRoute * (resource) .axd/ (*pathInfo) ) ;

Foutes MapRoute(null, "reports, (year)/ (month), new WveRouteHandler ()):
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cateh (
foreach (var issue in dinner.GetRuleviolations()) (
Hodelstate. AddodelBrrox (issue. Propertyliane,  issue.Brroressage)
)

retumn View(dinner) ;
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[(*DinnerID®:53, “Title": "Dinner with the Family®, ‘Latitude®:47.6431
2,"Longitude®:~122.130609, "Description": "Fun dinner" , "RSVECount*:2)
(*DinnerId*:54, *Title*:“Another Dinner, “Latitude*:47.632546, Longitude" s
122.21201, "Description* : “Dinner with Friends*, RSVECount-:3)]
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[Serializable]
public class Product
0

tebservice]
public class ProductService
«
(HebHiethoa)
publlic TList<Product> GetProducts()
«
)
)
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organie: 3
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Return Value

Description

Void

object (anything other than
ActionResult)

‘The action invoker replaces null results with an instance of EmptyResult,
This follows the Null Object Pattern. As a result, implementers writing
custom action filters don’t have to worry about null action results.

‘The action invoker treats the action method as f it returned null, and
thus an EmptyResult s returned.

‘The action invoker calls ToString using InvariantCulture on the object
and wraps the resulting string in a ContentResult instance.
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public string NextPageUrl(int currentPage
+ RouteCollection routes)
«
int nextPage = currentpage + 1;
VirtualPathData vp = routes.GetVirtualPath(null,
neu RouteValueDictionary (new (page = nextPage))):
if(vp 1= null)
«
return vp.VirtualPath;
)
retum null;
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public class DinnersController : Controller (

DinnerRepository dinnerRepository = new DinnerRepository():

7"
7/ GET: /Dinners/

public ActionResult Index() {

var dinners = dinnerRepository. FindUpconingDinners () .ToList ();

return View("Index, dimners):

"
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public OrderService (IorderRepository orderRepository,
IProductRepository productRepository,
TSalesRepository salesRepository,
IfransactionRepository transactionRepository,
TinventoryRepository inventoryRepository,
TuserRepository userRepository)

"
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callback: function(value, link) (
$("#3torm®) .ajaxsubait ();

)

N

i

</seripts
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public class Northwind
«
static Northwind instance = new Northwind();
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<= Heml.TextBox("Title", Model.Title)>
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[Test]

public void StringiithThreshsRetumsThresihenCount ingOcourencesfa() (
//arrange

CharCounter counter = new CharCounter();

17act
int occurrences =
‘counter .Countoccurrences (*this phrase has three occurences of a.”, ‘a’);
J/assext
Assert.AreBqual(3, occurrences) ;
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1 />

‘wizardStep® name="wizardstep® type='hidden" value
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public string HelloAjax(string query)
«
retum "You entered: * + query

)
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IList<Dinner> FindUpcomingDinners (int pageIndex, int pageSize,
out int totalCount) ( )
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public ActionResult Logout () (
Fomsuth. Signout ();

return RedirectToAction(*Index", "Home'):
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public ActionResult Index()
T
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DinnerRepository dinnerRepository = new DinnerRepository():

// Retrieve specific aimer by its Dinnertd
Dinner dinner = dinnerRepository.GetDinner (5) ;

// ark ainner to be deleted
ainnerRepository. Delete (inner) ;

1/ Persist changes
dinnerRepository. Save () ;
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<asp:Content ID='Title ContentPlaceHolderID="TitleContent' runat
Dimner Deleted
</asp:Content>

<asp:Content ID="ain’ ContentPlaceiolder ID="MainContent" runat="server'>
<n2>Dinner Deleteds/h2>

<aiv>
<p>¥Your dinner was successfully deleted.</p>
</atv
<aiv>
<p><a hrets"/ainners">Click for Upcoming Dimnerse/a></p>
</arv
</asp:Content>
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My MVC Application

Delote Confirmation

(Dsae)
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<4 if (Request.Ishuthenticated) ( %>
<4 1€ (Hodel.IsUserRegistorsd (Context . User. Identity.Nane)) { >
<poYou are registered for this event!</p>
@) else (>
<p>¥ou are not registered for this evente/p>
ERRS
) else (©

<a hret:

*/Aceount /Logon®>Logon</a> to RSVP for this event.

@) e
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/simple2/distance/0,0/1,2
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NorthuindDataCentext context = new NorthuindDataContext();
var product = context.Products.Single(p => p.ProductID

)

Vieubata["CategoryId'] = from ¢ in p.Categories
select new SelectListItem (
Text = c.Categoryliane,
Value = ¢.CategoryID,
Selected = (c-CategoryID
i

p.CategoryID)

return View(product);
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<tusing (Ajax.BeginForm("HelloAjax",
new Ajaxoptions ( UpdateTargetid = ‘results’ )))
[
<t= Htnl.TextBox("query, mull, new (size=d0)) %
<input type="subnit* />
< v

<atv ideresultet>

</aiv>
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http: / /widelyusedbank. example. con? funct ion=trans ferganount =1000&toaccountnunber=

232345543336 romschecking
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<fieldset>
<1- Fields Omitted for Brevity

s
<input type="submit® valu
</p>
</tielaset>

“saver />

<% Heml Endrorm(); %>
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<Qiv_id="escapedDiv*></div>
<script types-text/javaseript'>
@ocunent .getElenentById| *escapeddiv ) . innerHTIL
= escape("I'm a perfectly safe string');
</seript>





OEBPS/guth_9780470549230_msr_cvi_r1.jpg
Professional

Scott Hanselman, Phil Haack, Scott Guthrie:

Updates, source code, and Wiox techrical support at www wrox.com
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<t= Henl.Bncode (Hodel HostedBy) ¥

</p>
pes
ContactPhone;
<t= Heml.Bncods (Hodel .ContactPhone) 1>
</p>
P
adaress:
<3= Heml.Encode (Hodel .Address) %>
</p>
@
Country:
<t= Htnl. Encode (Hodel .Country) %>
</p>
P
Latitude:
<t= Heml. Bncode (String. Fommat (*(0:F)*, Model.Latitude)) ¥
</p>
P
Longitud
<82 Htnl.Encode (String. Format (*(0:F) ", Model.Longitude)) ¥
</p>
</f1eldset>
.
<teHtnl Actionlink(*EAit", "EAit-, new ( ideModel.Dinnerid )) > |
<t=Htnl ActionLink("Back to List', "Index') %>
</p>

</asp:Content>
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[HandleError (ExceptionType = typeof (ArgumentException)
public ActionResult GetProduct (string name)
«
i (nane
«
throw new ArgunentliullException (*nane’) ;
)
Tetum View();
)

1l





OEBPS/guth_9780470549230_oeb_294_r1.gif
CREATE FUNCTION (dbo) . [NearestDinners]
«
6lat real,
Glong real
)
RETURNS TABLE
s
RETURN
SELECT Dinners.DinnerID
FROM  Dimners
VHERE  dbo.DistanceBetveen (@lat, Glong, latitude, Longitude) <100
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HEml.TextBox (*Name*, *ASP.NET MVC®) %>
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var categories = db.Categories:
ViewbataCategoryID'] = new SelectList (categories, "CategoryID:
“CategoryName® ) ;
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<script type='text/javascript'>
function AnimateRSvPHessage () (
$(*#rsvpnsg®) -aninate (fontSize: *1.5em’), 400);
)

</seript>
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<t= Viewbata(*_buration'] %>
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public class Product
[
public string Productiiame (get;set:)
public double UnitPrice (get; set:)
)
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<ul class="validation-sumary-errors®>
<Li>ouch</1i>
<Li>ouche/1i>

<ul>
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//Pretend to save the value successfully.
return RedirectTorction("Display”):
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16 Toe v o o et cou ot e o, To (g oo e seched <V .= I
OO - [0 wwmamemsnremae ][ o 5
P L S R BT Rty 1 )

Server Error in '/' Application.

The view 'Foo" or its master could not be found. The following
locations were searched:
~Views/Home/Foo.aspx
~/Views/Home/Foo.ascx
~/Viewws/Shared/Foo.aspx
~Views/Shared/Foo.ascx
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N oecember 13, 208

wesome job gust
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1"
7/ GET: /Dimners/
” /Dinners/page/2

public ActionResult Index(int? page) (
const int pagesize = 10;
var upcomingbinners = dinnerRepository.FindUpconingDimners () ;
var paginatedDinners = upcomingDimners.Skip((page 72 0) * pagesize)
Take (pagesize)
ToList ()

retum View(paginatedpinners:
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<script srcs'/Scripts/MicrosoftAjax.js® types'text/javascript'></script>
<SCript src="/Scripts/MicrosoftMVCAjax. js* types’text/javascript'></script>
<tusing (Ajax.BeginForm| “ProductSearch-,
new Ajaxoptions ( UpdateTargetid = "results® }))
(w
<tsHtmlTextBox (“query” ,null, new (size=40)) %>

Y
<div igs"resultst>

</aiv-
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public class PakeDinnerRepository : IDimnerRepository (
private List<Dinner> dimerList;

public FakeDinnerRepository (List<Dinner> dinners) (
QimerList = dimers;
)

public Igueryable<Dinner> FindAlDimners() (
return dimnerList.AsQueryable() ;
)

publlic Tgueryable<Dinner> FindUpcomingDimners() (
return (fron dimner in Ainnerlist
vhere dinner.EventDate > DateTine.low
select dinner) .Asqueryable():
)

public Tgueryable<Dinner> FindByLocation(float lat, float lon) {
return (fron dimner in dinnerlist
where dinner.latitude == lat te dinner.Longitude
select dinner) .Asgueryable():

1on
)

public Dinner GetDimner(int id) (
return dinnerList.SingleorDefault(d => d.DimnerID

)
)

public voia Add(Dinner dinner) (
QimnerList.Add(ainner) ;
)
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<system.web>

set compilation deb

true* to insert debugging

symbols into the compiled page. Because this
atfects performance, set this value to true only
auring development.
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<add tagProfix="asp" namespace="Systen.ieb.UI"
assenbly="Systen. feb. Extensions, Version=3.5.0.0, Culture=neutral,
PublicKeyToken=318F 385 6AD3 6435 />
<add tagProfix="asp* namespace="Systen.eb.UT HebControls®
assenbly="Systen. feb. Extensions, Version=3.5.0.0, Culture=neutral,
PublicKeyToken=318F 385 6AD3 6435 />
</controls>
<namespaces>
<add namespace:
<add nanespace:
<add nanespace:
<add namespace:
<add nanespace:
</mamespaces>

Systen.ifeb. Hve* />
Systen. ifeb.Hve. Heal" />
Systen, eb. Hve. Ajax” />
Systen. Ling"/>
System.Collections.Generic®/>
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public partial class Index
«
)

. becomes.

public partial class Index
«
)

© Viewpage

ViewPage<TEnunerable<Product>>
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return View(new DinnerFormViewodel (dinner));
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RouteCollection.GetVirtualPath(
context,
new RoutevalueDictionary (
(parant, valuel),
(paran2 value2) ,

{paxa valuen)
ni
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public interface IProductRepository (
TList<Product> GetProducts();
)
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URL

Purpose

/Dinners/

/Dinners /Details/ [id]

Display an HTML list of upcoming dinners.

Display details about a specific dinner indicated by an “id”
parameter embedded within the URL — which will match the
DinnexID of the dinner in the database.

For example: /Dinners /Details/2 would display an HTML
page with details about the Dinner whose Dinnex I value is 2
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Ordercontroller controller = StructureMap.ObjectFactory
Get Instance<ordercontroller> ()
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routes MapRoute("simple*, *(controller)-(action)", new (actions"index"));
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1
17 POST: /Dinners/Eait/2

[Acoesptverbs (HttpVerbs. Post) |
public ActionResult Edit(int id, Forncollection formvalues) (

Dimer dinner = dinnerRepository.GetDimner (id);
ey (

Updateliodel (dinner) ;
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public class WebFormRouteHandler : IRouteHandler

(

public WebFormRouteHandler (string virtualPath) : this(virtualPath,

«
)

true)

public WebFormRouteHandler (string virtualPath, bool checkBhysicalUrlAccess)

«
this.Virtualeath = virtualeath;

this CheckPhysicalUrlaccess = checkPhysicalUrlaccess;

)
public string VirtualPath { get; private set; )

public bool CheckPhysicalUrlaccess ( get; set; )

public THttpHandler GetHttpHandler (RequestContext requestContext)

«
1€ (this.Checkphysicalrlaccess

& tUrlauthorizationliodule. CheckUrlAccessForPrincipal (this. VirtualPath

. requestContext.HetpContext.User

. requestContext. HttpContext .Request .Hetplethod) )

throw new SecurityException()

var page = BuildManager
CreateTnstanceFronvirtualPath(this. VirtualPath
. typeot (Page)) as THttpHandler:

if (page != null)
«
var routablePage = page as IRoutablePage;
if (routablepage i= null)
routablepage. RequestContext = requestContext;

)

retumn page;
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public static void RegisterRoutes (RouteCollection routes)
[
//¢ixst one is a naned route
routes. HapiebPornRoute *General
“haha/ (£ilenane) .aspx*, *~/forms /haha.aspx")
Foutes. MapHebFornRoute (“backdoor”, *-/admin/secret.aspx’):
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RouteData routeData = routes.GetRouteData(httpContextMock.Object);
Assert . Tsllotiull (routeData, *Should have found the route’):
hssert . AreEqual (*product”, routeData.Values[*Controller']);

Assert AreEqual (*list”, routeData.Values(*action']);

Rssert AreBqual("", routeData.Values(*id"]);
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<% Html.BeginForm(); %>
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<form actions"/account /register” methods’post'>
<teHtal AntiForgeryToken()t>

<rtorm>
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//This is WRONG!
(HandleBrror (Order=1, BxceptionType=typeot (Exception) ]

{HandleError (Orders2, ExcepticnTypestypeof (ArgumentException) , Views'AzgError®))
public ActionResult GetProduct (string name)

«

)
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routes.MapRoute(“simple®, °(first)/(second)/(third)");
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NerdDinnerDataContext db = new NerdDinnerDataContext ():

1/ Retrieve Dimner objest that reprents row with DimnerID of 1
Dimner dinner = b.Dinners.Single(d => d.DimnerId == 1);

/7 Update two properties on Dinner
Aimner.Title = "Changed Title';
Qimner.Description = *This dinner will be fun’

/4 Persist changes to database
b Subnitchanges ()5
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public interface IPaintable (
‘Systen. Drawing.Color Color { get; set; )

)
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[Act iontlame (*View')]
public ActionResult Viewsomething(string id)
0

return View();
)
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[TestMethod)
public void BaitAction_Should Return_View_For_Validdinner() (

11 Arrange
var controller = CreateDimersController ();

17 Ret
var result = controller.BAit(l) as ViewResult;

/1 hssert
Assert . IsTnstanceOfType (result . ViewData.Hodel,
typeot (DimnerFornviewtiodel) ) ;
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<input id=’name” names=‘name’ types'text® value="" />
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i€ (ainner == null)
retum View("NotFound’);

AinnerRepository . Delete (ainner) ;
AinnerRepository . Save () ;

retum View(*Deleted®):
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<form action="/home/" method="post >
<input types*text® names'Firstliame® values'Rob®/>
<input types"text® names*Lastlame values"Conery'/>
<input type="subnit* value='Take Me To Your Controller’/>
</fom>
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o WekeRoad

Search Results for Active Script Injection’ |
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1"
17 %oST: /Dimners/create

[Acosptverbs (Httpverbs. Post) )
public ActionResult Create(Dinner dimner) (

if (Modelstate. Isvalid) (

ey (
Qinner. HostedBy = "SonsUser”;

innerRepository.Add (dinner) ;
innerRepository.Save();

\nner . DinnerI 1)

retum RedirectTorction(*Details', new { i
)

caten (
HodelState. Addiodel Exrors (dinnerToCreate. GetRuleViolations ())

)
)

retum View(new DinnerPornviewiodel (aimnerToCreate)) ;
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public ActionResult Index()
«
ViewData["Title] = "Home Page";
VieuData["Message®] = “Welcome to ASP.NET MUC!®

return View(*NotIndex");
)
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public class TestProductRepository : IProductRepository
t
List<proquct> products;
public TestproductRepository ()
«
products = new List<Product>();
for (int 4= 1; 4 <= 10; 140)
¢
Product p =
new Product (“Test Product * + i.ToString(), 100M);
p.Stocklevel = 5520 1 1;
)
)
public IList<Product> GetProducts()
i
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<script src='/Scripts/jquery-1.3.2.js* type=‘text/javascript'></script>
<script szes/Scripts/jqHodal. s+ types”text/javascript®></script>
<link hrefe"/Scripte/jqtiodal. css® rel=stylesheet® types"text/cs® />

<script types-text/javaseript'>
$0).ready (function() (
$("satalog) Jam):
n:
</seript>

<button class="3qodal >Click Met</button>

<div classa® jquindow" 1de"dialog™>
<a href="s" class="jquclose">Closes/a>
<ne>
<hishy Modal Box!</nz>
L I'm a modal dialog!

</aiv>
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public partial class Dinner (

public bool Tsvalid {
get ( retwm (GetRuleViolations() -Count ()

)
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<4 Html.RenderPartial (“Map®, Model.Dinner); >
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ActionResult Type

Description

EmptyResult
ContentResult

JsonResult

RedirectResult
RedirectToRouteResult
ViewResult

PartialViewResult

FileResult

FilePathResult

FileContentResult
FileStreamResult

JavaScriptResult

Represents a null or empty response. It doesn’t do anything.
Writes the specified content direetly to the response as text

Serializes the objects it is given into JSON and writes the JSON to
the response.

Redirects the user to the given URL
Redirects the user to a URL specified via Routing parameters,
Callsinto a View engine to render a View to the response.

Similar to ViewResult, except it renders a partial View to the response,
typically in response to an AJAX request.

Serves as the base class for a set of results that write a binary response
to the stream. Useful for returning fies to the user

Derives from FileResult and returns writes a file to the response based
onafile path.

Derives from FileResult and returns writes a byte array to the response.
Derives from FileResult and returns writes a stream to the response.

Used to execute immediately JavaScript code on the client sent from
the server.
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protected void Application Start()
«
VieuBngines. Engines.Clear () ;
ViewEngines.Engines Add(new MyViewEngine()):
RegisterRoutes (RouteTable. Routes) ;

)
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TIList<Product> products = new List<Product>():
£€(1String. Tshul 0zEmpty (query) ) (

NorthuindDataContext db = new HorthuindDataContext();
var products = from p in ab.Products
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using System;
using System.Collections. Generic;

using Systen. Ling;

using Microsoft.VisualStudio.TestTools. UnitTesting;
using Nerdpinner .odels;

namespace NerdDimner.Tests.Models {

(Testclass)
public class DinnerTest (

)
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1"
// GET: /Dinners/Details/2

public ActionResult Details(int id) (
Dimner dinner = dinnerRepository.GetDinner (id);
if (@imner == null)
return View(“NotPound®);

else
return View(dinner) ;
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"
77 GET: Dimners/

public ActionResult Index() (

var upeoningDinners = dinnerRepository.FindUpconingDinners ();
var paginatedDinners = upcomingbinners.Skip(10) Take (20) . ToList () ;

return View(paginatedDinners) ;
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[AttributeUsage (AttributeTargets.Class | AttributeTargets.lethod,
Tnherited = true, Allowultiple = false)]
public sealed class ValidateInputAttribute : Filterhttribute
. TAuthorizationFilter
publlic void OnAuthorization (AuthorizationContext filtercontext) (
£iltercontext. HetpContext .Request .ValidateTnput ();
)
)
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public ActionResult About ()
(
vieuData[*Title']

“Rbout. Page*;

return View():
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"
77 20ST: /Dimners/create

[Rcceptverbs (Httpverbs. Post) )
public ActionResult Create (FornCollection fornvValues) (

)
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"
77 ®OST: /Dimners/eait/z

[Acoepterbs (Httpverbs. Post) )
public ActionResult BAit(int id, FornCollection formValues) (

Dinner dinner = dinnerRepository.GetDinner (1d) ;
Updateltodel. (ainner) ;
ainnerRepository.save():

retum RedirectToAction(*Details®, new ( id = dinner.DimnerTd ));





OEBPS/guth_9780470549230_oeb_614_r1.gif
[huthorize (Roles="Admins, SuperAdmins®)]
public class AdninController
«
//0nly agnins should see this
public ActionResult Index()
«
retumn View();

)

//0nly adnins should see this
public ActionResult DelsteAllUsers()
«

//mhankfully, this is secured by the Authorize attribute.

)
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<div class='validation-summary-errors>
<span>An error occurreds/span>
<ul>
<Lisouche/1i>
<Li>ouche/1i>
<ru1>
</div>
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‘map.AddShape (shape) ;
points.push(LL)
shapes. push (shape) ;

)

function PindAddressoniap (where) (
var numberofResults = 20;
var setBesthapView = true;
var shouResults = true;

map.Pind(", where, mull, mull, null,
nunberofResults, showResults, true, true,
setestiapView, callbackForLocation):

)

function callbackForLocation(layer, resultsArray, places,
hasiore, VEErrorMessage) (

cleariap();

if (places
retum

iy

//Make a pushpin for each place we find
§.each(places, function(i, item)
var description = *
Sf (item.Description == undetined) (
description = iten.Description;

)
var L = new VBLatLong (item.Latlong. Latitude,
iten. LatLong. Longitude) ;

LoadPin(LL, item.Name, description);
n:

//Make sure all pushpins are visible
if (points.length > 1) (

map. SethapVieu (points) ;
)

//I£ we've found exactly one place, that's our address
1€ (points.length =es 1) (
$("#Latitude’).val (points[0) . Latstude) ;
$(*#Longitude*) .val (points (0] .Longitude) ;

)

function clearhap() (
map.Clear();
points = (17
shapes = [1;
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<div id="dinnerList’></div>
</aiv>





OEBPS/guth_9780470549230_oeb_511_r1.gif
<input id="my-password" names’my-password" type

‘password" value
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<36 Master Languags

Systen.Web. Mve. ViewasterPage” >

<!DOCTYPE html BUBLIC *-//W3C//DTD XHTML 1.0 Strict//EN" *http: //wini.ud.org/TR/
Xhtnll/DTD/xhtmll-strict.atdr>
<html xmlnss"http: /s, u3.org/1999 /xhtml®>

<head runat="server>
<titler<asp:ContentPlaceHolder IDs TitleContent® runats'server® /></title>
*../../Content/Site.css" rel="stylesheet" types'text/css’ />
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/Dinners/eait/s

{Authorize)
public ActionResult Edit(int 1) {

Dinner dinner « dinnerRepository.GetDimner (id);

Vieubatal*Countries’]

new SelectList (PhoneValidator.Countries,
Ainner.Country)

return View(dinner);
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retum RSVPs. Any (r

r.AttendeeNane. Equals (userliane,
Stringconparison. InvariantCulturelgnorecase) ) ;
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<iframe srcshttp://wa.google. com/calendar/enbed?.
border-width:0 ©

scrolling"no™>
</ifrane>
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/simple2/goodbye/world
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<br><br>Please login

‘http://testasp.acunetix.com/Search.asp?tfSearct

<a href
with the
£om below before procesding: <forn

action="nybadsite. aspi><table><tr><td>Login: </td><td<input typestext lengthe20

name=login></td></tx><tr><td>Passiord: < /Ld><td><input typestext lengthe20
name=password></td></tr></table><input type=subnit value-LOGIN></form>">look at

this cool
site with naked pictures</a>
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using System;
using System.Collections.Generic;
using Systen.ieb

using System.ieb.Mvc;
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public ActionResult Index() (
ViewData["Title] = "Home Page';
ViewData["Message®] = “Welcome to ASP.NET MVC!

return View():
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public static void RegisterRoutes (RouteCollection routes)
«
Foutes.Addnew Route
«
* (resource) .axd/ (*pathlnto) ",
new StopRoutingHandler ()
N

routes.Add(new Route
«
*reports/ (year) / (month) *
. new SomeRouteHandler ()
N
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public void Index() (

Response.irite(<hl>Coning Soon: Dimners</hl>");
)

"
// GET: /Dinners/betails/2

public void Details(int id) (
Response.iirite("<hi>Details DimneriD: * + id + "</h1>");
)
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<1DOCTYPE html PUBLIC °-//W3C//DTD XATML 1.0 Transitional//EN®
“Rttp: / /e 43 .org/TR/xhtml1/DTD/xhtml1-transit ional .dtd™>
<html xmlnss"htp: / /a3 .org/1999 /xhtal >

<head runat="server'>
<titlexlntitled Pages/title>

</head>

<body>
<forn 1d="fornl* runat="server'>
<atv>

<asp:TextBox ID="TextBoxl® runat="server'
OnTextChangeds "TextBox1_TextChanged">
Initial Text</asp:TextBor>
<asp:Button ID="Buttonl® runat
P
<asp:Label ID="Labell’ runat='server’ Text:
</p>
</aiv>
</torm>
</poay>
</mtml>

Code-Behind

public partial class _Default : System.isb.UI.Page
«

server® Text="Button® />

< /aspiLabel>

protected void TextBoxl_Textchanged(object sender, EventArgs e)
«
Labell Text = *This text is different from before!®

)
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<asp:Content ID="ain" ContentPlaceHolderID="MainContent’ runats'server'
<n2>Upconing Dinners</h2>

<>
<t foreach (var dinner in Model) (%>

(h)«: Html.Encode (dinner.Title) %>
<3+ Htn Encode (ainner. BventDate. ToshortDatestring 1)t
o ent Bncode @inner. Brentate. ToshorcTinestring 014
s
e

<1

</asp:content>
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<¥if (ViewData.Model.Count>0) ( %>
<table cellpaddings'5°>
<tr>
<ta><b>Product</b></td>
<td<boprices/be/td>
</te>
<tforeach (VCAjax.lModsls.Product p in Viewata.Modsl)
(-
<trs
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[WebserviceBinding(ConfornsTo = WsiProfiles.BasicProfilel 1))
[Systen. Componentliodel ToolboxTten(alse) |

(System. eb. Script. Services. ScriptService]
public class Productservice : Systen.ifeb.Services.WebService
«

[Hebliethod)
public string() ProductNameSearch(string prefixText, int count)
«

NorthwindDataContext db = new NorthwindDataContext ();
stringl) products = (from p in db.Products
where p.Productliane. Startsuith (prefixText)
select p.Productiame) .Take (count) . ToArray ()
retum products;
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[HandleError (Order=1)]
[outputcache (Order=2)]
public class Mycontroller : Controller
«
public ActionResult Actionl() (.}
public ActionResult Action2() {.}
)
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routes.MapRoute(“nane®, *(controller)®, mull
. new (httpllethod = new HetplethodConstraint (*GET"))
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public class DinnersController : Controller (
DinnerRepository dinnerRepository = new DimnerRepository();

"
77 GET: /pinners/

public ActionResult Index() (
var dinners = dinnerRepository. FindUpcomingDinners () .Tolist ();

retum View(ainners) ;
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[Authorize (Roles="LeveliClearance, LeveldClearance’) |
public class TopSecretCantroller:Controller
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1"
17 POST: /Dinners/create

[Acosptverbs (HetpVerbs. Post), Authorize]
public ActionResult Create (Dinner aimner) (

if (Modelstate. IsValid) (

try (
dinner HostedBy = User.Tdentity.Name:

RSVR rsvp = new RSV():
rsvp.Attendeeliane = User. Tdentity.Nane;
Qinner.RSVPs.Add(revp) ;

QimnerRepository. Add(dinner) ;

QimnerRepository.Save () ;

retum RedirectToAction(*Details’, new ( id=dinner.DimerId ));
)

caten (
Hodeltate. AddlodelErrors (dimer.GetRuleViolations ()

)
)

return View(new DinnerFornviewlodel (dinner)) ;
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routes. MapRoute (*simple”
. *lcontroller) / (action)/(id)*
new (id = **, actions*index'));
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<%= Html.ValidationMessage("EventDate", "**) %>
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public interface IDinnerRepository (

Tgueryable<Dinner> FindAllDinners();
Igueryable<Dinner> FindByLocation(float latitude, float longitude)
Igueryable<Dinner> FindUpcomingDinners ();

Dinner Getbimer (int id):

void Add(Dinner dinner):
void Delete (Dinner aimner);

void save();
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public class MyRegistry : StructureMap.Configuration.DSL.Registry (
protected override void configure()
«
)

)





OEBPS/guth_9780470549230_oeb_054_r1.gif





OEBPS/guth_9780470549230_oeb_626_r1.gif
Property Description

Action ‘The name of the action that threw the exception
Controller ‘The name of the Controller in which the exception was thrown

Bxception ‘The exception that was thrown
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<tr<thoNane</tho<th>Ages/th></tr>
shetore
<tr
soaa
Style="color:gray'>
seven
Style='coloriwhite’>

seach
<ta>Sperson. Nane</td><td>Sperson. Age</Ed>

tatter
<t

#botueen
<tr><ta colspa

2>$person. blo</td></tr>

satterall
</table>

tnodata
Sorry o Person Found
send
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"
/7 GET: /Dinners/Details/2

public ActionResult Details(int id) (
Dimer dinner = dinnerRepository.GetDinner (1) ;
if (@tmner == null)
return View(“NotFound®):

else
retumn View(dinner) ;
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public void Paint(Car car, System.Drawing.Color color) {
car.Color = color;
)
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n
7/ GET: /Dinners/petails/2

public ActionResult Details(int id) {

Dinner dinner = dinnerRepository.FindDinner (1d);

if (@imner == null)
retum View(“NotFound®);
else
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public ActionResult Foo()
(
VieuData[*Title] = "Foo Page';
return view():
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HITP/1.1 200 OK

Content-Type: text/ntnl; charse
Content-Length: 29

Thanks - we'll see you thers!






OEBPS/guth_9780470549230_oeb_026_r1.gif





OEBPS/guth_9780470549230_oeb_176_r1.gif
My MVC Application

Delete Confirmation

[Oswe]

o e pioss ot





OEBPS/guth_9780470549230_oeb_776_r1.gif
<form i

<aiv>

<hl>Reports Home</h>
<acp:Button ID="Buttonl® runat="server onclick='Buttonl Click Text="Button® />
or />

</ate

</form>

forml* runat
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111 <sumary>
777 sumary description tor ProductService
111 </sumary>

[epservice (Nanespace

“hetp://tempuri .org/*) ]
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CREATE FUNCTION [dbo] . [DistanceBetween) (dLatl as real,
GLongl as real, GLat2 as real, GLongZ as real)

RETURNS real

as

BEGIN

DECLARE @dLat1InRad as float(s3):
SET GdLatilnRad = GLatl * (PL()/180.0);
DECLARE GdLong1InRad as float (53);

SET GdLonglInRad = Glongl * (PL()/180.0);
DECLARE 6dlat2Inkad as £l0at(s3);
SET 6dLat2InRad = GLat2 * (PL()/180.0);
DECLARE 9dLong2InRad as float (53)

SET dLong2InRad = GLong2 * (PL()/180.0);

DECLARE 6dlongitude as £1oat(53);
SET 6dLongitude = ¢dLong2Tnfad - dLonglInRad;
DECLARE @aLatitude as float(s3):
SET edlatitude = edlat2InRad - GdlatilnRad:
/% Internediate result a. */
DECLARE 0a as_float(53):
SET 6a = SQUARE (ST (6dLatitude / 2.0)) + COS (¢dLatiInfad)
* CS_(eaLat2Inkad)
* SQUARE(SIN (8alongitude / 2.0));
/* Internediate result ¢ (great circle distance in Radians). */
DECLARE G as real;
SET 6c = 2.0 * ATH2 (SORT (6a), SQRT (1.0 - @a));
DECLARE 6KEarthRadius as real;
/* SET KZarthRadiue = 3956.0 miles +/
SET GkEarthRadius = 6376.5; /% wms 4/

DECLARE @dbistance as real;
SET GaDistance = GkEarthRadiue * Gc;
return (edbistance) :

B
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{controller)/(action)/(1d)
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<input class="lotsofit® id='Name' name: text® value='ASP.NET MVC* />
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<t= Html.ActionLink(“LinkText®, “About”, "Account®, mull
new (title="withdraw from accaunt’}) %>





OEBPS/guth_9780470549230_oeb_117_r1.gif
My MVC Application

Geek out
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<asp:ContentPlaceHolder ID="ContentPlaceolderl® runat="server™>
</asp:ContentPlaceHolder>
</form>
<div id="navbottom'>
<asp:Repeater ID="BottonllavRepeat " runat
DatasourceTD="sitellapbatasourcel >
<HeaderTemplate>
<ul>
</HeaderTenplate>
<Itemtemplate>
s>
<asp:HyperLink ID="Hyperlinkl® runats’server"
Toxta'<ts Bval("Title') %>
NavigateUrl='<t¢ Eval(-Url') ¥

server®

ToolTip="<t# Bval(‘Description’) %' />
<1
</Ttentenplate>
<PooterTemplate>
</u1>
</FooterTenplate>
</asp:Repeater>
</atv>
<div id=foster'>
<
Club Address here
<br />
&copy; 2009 My Club Site
</p>
</atv>
</boay>

</htnl>
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<script src="/Scripts/jquery-1.3.2.s" type
<script sre='/Scripts/jquery.Hetabata.js* typ
<script src="/Scripts/jquery.rating.3s" type

‘text/javascript></script>
“toxt/Javascript ></script>
text/Javascript-></script>

<link nret

/Seripts/jquery rating.css* re text/css® />

<input ‘rating’ type='radio® class="star®
<input ‘rating’ type='radio’ class="star’
<input “rating® types'radio® class="star®
<input *rating” *radio®
<input “rating” *radio”
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_repository. Save (products) ;
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public IEnumerable<RuleViolation> GetRuleViolatioms() {

if (String. TstullorEnpty (Title))
yield retum new RuleViolation(‘Title required”, ‘Title');

if (String. IshullorBupty (Description))
yield retum new RuleViolation(-Description required

Description®);
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"
77 %0ST: /Dimners/Eait/s

(Acceptverbs (Httpverbs . Bost) ]
public ActionResult Edit(int id, FomCollection collection) (

Dinner dinner = dinnerRepository.GetDinner (id);

ey (
Updateliodel (dinner) ;

ainnerrepository.Save();
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var center

map.GetCenter() ;

$.post (*/Search/SearchyLocation’, ( latitude: center.latitude,
Longitude: center.Longitude ),
function (ainners) (
§.each(dinners, function(i, atmner) (

var LL = new VELatLong(dinner.Latitude,
dimner.Longitude, 0, null);

var Revpllessage

if (ainner . RSVPCount
Revphiessage
elee

RevpHessage

1
* + dinner RSVPCount + * RSVP

* + Qinner RSVECount + * RSVEs";

// 344 Pin to Map
L0adPin(LL, '<a hrefs"/Dinners/Details/’ + dinner.DinnerID + '*>'
+ atmner.mitle + '</a>',
“<p>" + dinner .Description + "</p>* + RevpMessage) ;

//Add a dinner to the <ul> dinnerlist on the right
$("sainnerList’) .appena (s (‘<1i/>')
attr(“class®, “dinnerlten’)
append (§ ('<a/>') .attr (*href",
*/Dimners/Details/® + dinner.DinnerId)
-html (inner Title))
-append(* (*+Rsvpllessage+)*))
n:

// Adjust zoom to display all the pins we just added.

1€ (points.length > 1) (
map. SetapView (points) ;
)

// Display the event's pin-bubble on hover.
$(*.ainnerTten”) .each(function(i, dinner) {
$(aimner) .nover (
function() ( map.ShowInfoBox (shapes(il); ),
function() ( map.HideTnfoBox (shapes(il): )
)
n:
“json);
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Property Description

view Returns the found 1view instance for the specified View name. Ifthe View
could not be located, then it returns null

ViewEngine Returns an 1ViewEngine instance if a View was found; othenvise null.

Searchedlocations  Returns an TEnunerable<stxing> that contains all the locations that the

View engine searched.
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<% if (Model.IsHostedBy (Context.User.Identity.Name)) ( %>

<t Henl.ActionLink(“EAit Dinner®, "EAit’, new ( idsHodel.DimnerId ))t> |
Henl ActionLink(*Delete Dimner®, *Delete", new (idsModel.DinnerID))s>

@) e
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[hction)
public void Index()
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[AttributeUsage (AttributeTargets.Class | AttributeTargets.Method,

Inherited = true, Allowlultiple = false))
public class Nohuthittribute : Filterattribute, IAuthorizationPilter

«
public void OnAuthorization (AuthorizationContext filtercontext)

«
filtercontext .Result = new ContentResult
( content = "You've been blocked by the Nohuth filter." )
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[Testhetnoa)
public void AboutReturnsAboutview()
«
HoneController controller = new HomeController():
ViewResult result = controller.About() as ViewResult;

//1 explicitly want to rely on the framework to set the viewname
Assert.AreBqual(string. Bupty, result.Viewame) ;
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using System.Componentiodel;
public class Product : IDataBrrorinfo (
Dictionary<string, string> _errors = new Dictionary<string, string>();
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<strong>Organizer:</strong>
Henl Encode (odel Hostedsy) t>

(<3= Htnl.Encode (Hodel .ContactPhone) 3>)
</p>

<t= Heml Actionlink(*BAit Dinner’, “BAit", new ( id=Model.DimnerID ))%> |
<4< Html.Actionlink(*Delete Dinner®,‘Delete, new ( idslodel.DinneriD))®>

</asp:Content>





OEBPS/guth_9780470549230_oeb_048_r1.gif





OEBPS/guth_9780470549230_oeb_290_r1.gif
i

H
ity

i
i
H






OEBPS/guth_9780470549230_oeb_393_r1.gif
URL

“Parameter” value

/query/select /a/b/c
/query/select /a/b/c/

/query/select/

extrastuff = "a/b/ct
extrastuff = "a/b/ct

extrastutt = ** (Route still matches. The “catch-all” just catches
the empty string in this case.)
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<asp:Content ID="Title" ContentPlaceHolderID="TitleContent® runat="server">
Host a Dinner
</asp:Content>

<asp:Content ID="Create* ContentPlaceolderD="HainContent® runat="server">
<hz>Host a Dinner</h2>
<4 Htal.RenderPartial (“DimnerFomn'); %>

</asp:Content>
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<seript
<script
<seript

<script

<seript

sy

stes* /Scripts/AjaxControlToolkit
type="text/Javascript </ soript>
sre=" /Seripts/AjaxControlToolkit
types"text/Javascript-></script>
stee" /Scripts/AjaxControlToolkit
type=*text/Javascript®></script>
sre=" /Seripts/AjaxControlToolkit
types"text/javascript®></script>

types"text/javascript®>

-Application.add_init (unction()

soreate(

M

‘AjaxControlToolkit . AutoConpleteBs
servicellethod: 'ProductNianess
servicePath: '/ProductServics
minimumPretixlength: 1,
completionsetCount: 10

)

i,

nu1,

Sget (query'))

</script>

Anination. AninationBehavior. J*
PopupBxtender . PopupBehavior . js*

Compat .Tiner Tiner . js*

-Autocomplete. AutoConpleteBehavior. js*

«

enavior,
earch,
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<%= Html.ValidationMessage("Name®) %>
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VirtualPathbata vp = routes.GetVirtualfath(null,
"todo-route", new RouteValueDictionary()):

ifwp
(

return vp.VirtualPath;
)

Tetum mull;

)

)
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<asp:Content ID="Title" ContentPlaceHolderID="TitleContent® runat="server’>
Host a Dinner

</asp:Content>

<asp:Content ID="Main® ContentPlaceHolderIDs"HainContent® runats"server~>
<h2>Host a Dimner</h2>

Htnl.ValidationSumary("Please correct the errors amd try again.”) ¥

<t using (Html.BeginForn()) (¥

<ticldset>
P
<label for="Title'>Title:</label>
<t= HEml.TextBox (“Title') %>
<t= Heml Validationliessage ("Title®, "**) %>
</p>
P

<label fors"EventDate'>vent Date:</label>
<t= Html.TextBox("Eventate’) %>
<t= Heml Validationllessage ("Eventbate’, "**) %>
</p>
>

<label fors"Description®>Description:</label>
<t= Heml Textarea “Description”) ¥
<t= Heml Validationliessage (*Description”,
</p>
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Route URL Pattern

Examples of URLS that match

(controller)/ (action) / (category)

service/ (act ion) -(format)

(xeporttype) / (year) / (month) / (date)

/products/1ist /beverages
/blog/posts/123

/service/aisplay-xm

/sales/2008/1/23
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[ValidateAntiforgeryToken]
public ActionResult Register
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using System.ieb.Mve;
using System.Heb.Routing;

public class Simplecontroller : Icontroller
0
public void Bxecute (RequestContext requestContext)
(
var response = requestContext.HttpContext.Response;
rldi</ni>") ;
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[Authorize (Users="Phil*)]
public ActionResult DelsteAllUsers()
«

e
)
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Dinner dinner = dinnerRepository.GetDimer (id) ;

ey (
Updateltodel (dinner) ;

Ainnergepository . Save ()

retum RedirectToAction(“Details", new { i = dimner.DimerId }):
)
cateh (

Modelstate. AddRuleviolat ions (dinner . GetRuleViolations (})

return View(dinner) ;

"
7/ GET: /inners/create

public ActionResult Create() (

Dinner dinner = new Dimner() (
Eventbate = DateTime. low. AddDays (7)
%
retumn view(ainner);
)

"
7/ post: Dimners/create

[Accsptverbs (HttpVerbs. Post) |
public ActionResult Create(Dimner dinner) (

1€ (Modelstate. Isvalid) (

ey (
dinner.HostedBy = "SonsUser”;

dinnerRepository. Ada (dinner) ;
dinnerRepository.Save () ;

linner . DinnerIp)

return RedirectToAction(Details", new(i
)

caten (
Hodelstate. AddRuleviolat ions (dinner. GetRuleViolations ()) ;

)
)

retum view(dinner)

)

"
7/ WYTP GET: /Dinners/belete/1
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sint total = 0;
#toreach(var item in itens)
0
o total
)

item. Quantity:
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RouteCollection routes = new RouteCollection():
GlobalApplication. RegisterRoutes (routes) ;
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{Acceptverbs (HttpVerbs. Get) |
public ActionResult Edit(string id)
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<&= Html.TextBox(“Name®) %>
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public static void RegisterRoutes (RouteCollection routes)
[
routes Add(new Route
«
“blog/ (user) / (action) *
. new ReportRoutelandler ()

Defaults = new RouteValueDictionary(
(-controller®, *blog").
(tuser*, “aanin'))

n:

routes Add(new Route
¢

“forun/ (user)/ (action) *

. new ReportRouteHandler ()
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<viewdata models"IEnunerable( (Person]]*/>
<ul classs"people™>

<1i eachs="var person in Viewpata.liodel ">
§ (person. Lastliane) , § (person. Pirstilane)
<>

<>
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Details DinnerID: 2
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public class Northwind
«
static string connstringsSysten.Configuration
-Configurationtianager
ConnectionStxings [ "Northwind"]
ConnectionStxing;

public static IList<Product> GetProducts(){
//open connection
SqiConnection connsnew SqlConnection (connectionstring):
SqiComnand cnd=new SqlComnand (*spSetProducts”,com) :
.

)
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var map = null;
var points = (1;
var shapes = [1;
var center = null;

function Loadiap(latitude, longitude, onMaploaded) (
map = new VEMap (" thelap');
options = new VEMapoptions()
options EnableBirdseye = false;

// Makes the control bar less obtrusive.
ap. SetDashboardsize (VEDashboarasize. Snall) ;

if (onltapLoaded 1= null)
map. onloadap = onifapLoaded;

if (latitude 1= null & longitude tx null) (
center = new VBLatLong(latitude, longitude);
)

map. Loadap (center, null, null, mull, mull, null, mill, options):
)

function Loadpin(LL, name, description) (
var shape = new VEShape (VEShapeType . Pushpin, LL);

//Make a nice Pushpin shape with a title and description
shape. SetTitle("<span class=\"pinTitle\"> * + escape(name) + "</span>");
if (description i== undefined) (

shape. SetDescription (*<p class=\'pinbetails\">' +

escape (description) + "</p>")
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/products/list
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addressValidator,
shippingservice,
taxservice,
mailerservice,
orderservice

s

//call the Processorder action, which s called
Jjuhen the user is ready to pay

7/3f the paynent is successful, they will be redirected to a
//Receipt page. If not, they will be shown the same view

//make sure it's the sane view page

ActionResult results controller.Processorder () ;

Assert. IsInstance0fType (result, typeof (ViewResult), “Not a ViewResult!

//make sure the View is the Checkout view, the page
I/uhere e started

ViewResult viewResult=result as ViewResult;
Assert . AreBqual (“Checkout , viewResult. Viewliame)
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[Authorize (Users="scottgu,billg")]
public ActionResult Create() (

3}
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if (filtercontext.Httpcontext t= null)
«
L€ (filtercontext.HttpContext .Request.UrlReferrer =x null)
throw new Systen.Web. HttpException(*Invalid submission’):

if (filtercontext.HttpContext .Request.UrlReferrer Host i= “mysite.com’)
throw new System.Web. HttpException (“This form wasn't submitted
fron
this sitet”
)

)
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URL

Description

/products
/product /new
Iproduct/1

/product/1/edit

Displays all products.
Renders a form to enter a new product,
Where 1 s the ID.

Renders a form to edit a product
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publlic ActionResult DoSomething() (
Script s = §(*#some-div') .heml('Updated!®);

retum Javascript(s);
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Property Description

Actionparaneters A dictionary of parameters that will be passed to the action method.

Result When canceling an action method, a flter can provide its own action result to
use instead of the one that would have been returned by the action method.
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"
/7 Query Methods

public Igueryable<Dinner> FindAliDinners() (
return db.Dinners;
)

public Toueryable<Dinner> FindUpcomingDimners() (
retumn from dimner in db.Dimers
where dimner .EventDate > DateTine.Now
orderby dinner.Eventbate
select atnner;

public Dinner GetDinner (int id) (

return ab.pinners. SingleorDefault (d => d.Dinnertd

i@
)

”
// Tnsert/Delete Wethods

public void Add(Dinner dinner) (
ab.Dinners. InsertonSubmit (dinner) ;

)

publlic voia Delete (Dinner dinner) (
b.RSVPs . DeleteAl LonSubnit (dinner. RSVPs) ;
ab.Dinners.Deleteonsubmit (ainner) ;

)

"
/1 versistence

public void Save() (
b SubnitChanges () ;
)
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HostedBy = "Scottau’,
Address = “One Microsoft Way"
Country = *Usa*,

ContactPhone = *425-703-8072",
Latitude = 93,

Longitude = -92,

)

17 Aet
bool isValid = dinner.Isvalid;

//hssert
Assert. IsTrue (isValid






OEBPS/guth_9780470549230_oeb_127_r1.gif
:Content ID="Title" ContentPlaceHolderID="TitleContent® runat='server'>
BAit: <t=Htn).Encode (Hodel.Title) >
</asp:content>

Main® ContentPlaceHolderIDs"HainContent runat

<asp:Content T
<n2>Eait Dinner</n2>
<3~ Heml ValidationSumary (*Please correct the errors and try again.”) ¥
< using (Htnl.BeginFom()) ( ©>

<fielaset>
<o
<label for="Title">Dinner Title:</label>
Henl TextBox (“Title') 8>
<t= Htul.Validationlessage (‘Title’, "**) %>
</p>
P

<label for="EventDate">Event Date:</label>
HemlTextBox (“Eventbate*, String.Pormat ((0:q)",

Model Eventpate)) 3>
Henl.Validationhiessage (“Eventbate, "**) 1>

</p>
s
<label fors*Description®>Description:</label>
Htnl TextArea (*Description”) t>
Henl Validationkessage (“Description”, **)%>

</p>
P

<label fors"Address*>Adres:
HemlTextBox (*Address®) >
<4< Henl.Validationlessage (“Address®, **7) ¥
</p>
s

Nlabel>

<label for="Country">County:</label>
HemlTextBox (“Country®)

<t= Heml Validationliessage ("Country”, *+7) &

</p>

s

<label fors"ContactPhone*>Contact Phone #:</label>
<b= Htnl.TextBox (“ContactPhone”)
<t= Heml Validationliessage (*ContactPhone®, *+7) >
</p>

s
<label for="Latitude*>Latitude:</label>

HemlTextBox (“Latitude’) %>

<t= Hewl.Validationhiessage (‘Latitude’, ***) %>

</p>

s

<label for="Longitude">Longitude:</label>
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<% ocutput "Hello, powerful person! The time is $(DateTime.Now)"
if user. IsAdministrator $>
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using System.ieb;
using Hog;
using Systen.ieb.Routing;

[Testhetnoa)

public void CanMapliornalControllerhct ionRoute ()
«

J/arrange





OEBPS/guth_9780470549230_oeb_525_r1.gif
public ActionResult Edit(int id) (
var product = new Product (Name = "ASP.NET MVC"):

ViewDatal“Product] = product;

return view();
3
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[TestMethod]

public voia UnorderedListiithIntArrayRendersUnorderedListii thilunbers ()

«

var contextliock = new Mock<HttpContextBase> ()5

var controllerhiock = new Nock<IController> ();

var cc = new ControllerContext (contexthiock.Object, new RouteData(),
controllertock. Object) ;

var viewcontext = new ViewContext(cc, "n/a’, n/a’, new Viewbatabictionary(),
new TempDatabictionary (1)

var vdcliock = new Mock<IViewDataContainer> ();

var helper = new HemlHelper (vieuContext, vcHock.object):

string output = helper.UnorderedList (new int(] (0, 1, 2 ));
hssert . AreEqual (*<ul><11>0¢/1i<1ix1e/ Li><1i>2¢/1i< /ul>", output) ;
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public ActionResult Index()
«
string message = HtpContext.Session(session_message’] Tostringl);
"
retum view();
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(r'* (?P<object_id»\a+) /products/category/$ ', 'store.products.view'),
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<div ids="theMap'>
</aiv
<script types"text/javascript'>

$(docunent) .ready (function() (
var latitude = <b-Hodel .Latitude ¥>;
var longitude = <3=Hodel.Longitude $>;

if (Qatitue
Loadlap () :

else
Loadlap(latitude, longitude, mapLoaded);

0) || (ongitude

o

Dt

function napLoaded() (
var title = <t Html.Encode(Nodel.Title) ¥>°
var address = *<t= Htul.Encods (Hodel.Address) §>

Loaabin(center, title, address);
nap. SetZoonLevel (14)
)

</seript>
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/products/view/shoes





OEBPS/guth_9780470549230_oeb_012_r1.gif
D e s o)
- At
& St

o & o
¢






OEBPS/guth_9780470549230_oeb_606_r1.gif
public ActionResult Rating(int? rating) (

VieuData["message’) = “Nothing selected
VieuDatal ‘rating"]

if (rating Hasvalue) (
VieuData["rating'] = rating;
ViewData["message’] = “You selected "+rating;
)

return view():

)
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function FindbinnersGivenLocation (where) (
map.Pind(**, where, null, null, null, mill, mull, false,
null, null, callbackUpdateMapDinners)
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public class SqlProductRepository : IProductRepository (
public IList<Product> GetProducts() (
return new Select () . From<Product> ()
‘ExecutensCollection<Product> ();
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NerdDinner

Tost Dinner

s evers
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/product /display . aspx?product i
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<input 1as"color’ name=color" types'radio values'red’ />
<input checkeds"checked id=color" mame="color type='radio’ valu
<input ids*color® names"color® types'radio’ values'green' />
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<% Heml.RenderPartial (*DinnerForm'); %>
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public class PhoneValidator (

static Ipictionarycstring, Regex> countryRegex =
new Dictionary<string, Regex>() (
("USA", new Regex(*[2-9]\\a(2)-\\a(3)-\a(4)$")) ,
( ~UK*, ‘new Regex (" (*1300\\A(6)$) | (+1800]1900]1902\\a(6)$) | (*0(2]3|7]8)
()0-918)$) | (*LNA()I$)] ("04110(2,3)\\A(6)$) ")),
( “Netherlands®, mew Regex (* ("\\+[0-9] (2) |"\\+[0-9] (2)\\ (0\\) [\\
11+ 1091 (2) V) \\(0\1) | 00(0-9] (2) [ 0) ((0-9] (9§ [0-9\\-\\81 (20)§) ")) ,
I

public static bool IsValidumber (string phoneNumber, string country) {
if (country 1= null & countryRegex.Containskey(country))
return countryRegex (countxy) . IsHatch (phonelunber) ;
else
retum false;

)

public static IEnumerable<string> Countries
get (
retumn countryRegex .Keys;
)
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<a href="/Home/About *>LinkText</a>
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Property Description
Bxception The exception that was thrown,if any: Nullif there was o exception.
Bxcept tontiandled A filtercan set this o true o indicate that it has handlled the exception.
Resule An exception filter can provide an action result o display in the case that

an exception was thrown and a result was not rendered to the view.
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"
7/ POST: /Dinners/Bait/2

[Acoeptverbs (Hetpverbs. Post) )
public ActionResult Bait(int id, PorCollection formValues) (

// Retxieve existing dimer
Dimer dinner = dinnerRepository.GetDinner (i) ;

// Update dimner with form posted values
Qimner.Title = Request.Form(“Title’):
Qimner.Description = Request.Porm| *Description*];
Qinner.EventDate = DateTine.Parse (Request.Fom | EventDate’]);
Qimner.Address = Request.Forn(*Address®):
Qimner.Country = Request.Form *Country")
dinner.ContactBhone + Request.Form(“ContactPhone’];

// Persist changes back to database
dinnerRepository.Save();
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x-requested-with: XMLHttpRequest
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public class DinnersController : Controller (

DinnerRepository dinnerRepository = new DinnerRepository();
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POST /home/HelloAjax HTTP/1.1
Accept: */*

Accept-Language: en-us

Feferer: http://localhost.:55926/hone
x-requested-with: XHLHttpRequest

Content-Type: application/x-wm-forn-urlencoded; charset

e

query=Hel10420Ajax  &X-Request ad-ii theXULHt tpRequest
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"
77 ®0ST: /Dimners/edit/2

[Acoepterbs (Httpverbs. Post) |

public ActionResult BAit(int id,

)

Forncollection fornvalues)

«
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[AcceptVerbs (Httpverbs. Post) |
public ActionResult EAit(Product product)
«

1€ (Modelstate. Tsvalid) (

//similate save to the DB
. Savechanges (product)

Viewbata( Message’] = product.Productiiane + * Updated"
retum RedirectTohction(*BQit");
)

else
«
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<& 1f (Modal.HasPraviousPage) { %>
<8= HemlRouteLink("<<<,
“UpconingDinners
new ( page= (odel Pagelndex-1) )) ¥
@) v
<t if (lodel. HasNextpage) ( %>
<8= HemlRouteLink(">>>",
“UpconingDinners”,

new ( page = (Model.PageIndex + 1) ))3>

@) e
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<a href="<%=Url.Action("index", *home’,new (name=ViewData(*name®)))¥>>Click here</a>
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public class RestRoute : RouteBase
«
publlic override RouteData GetRouteData (HttpcontextBase httpcontext)
«
//
)

public override VirtualPathData GetvirtualPath(RequestContext requestContext,
RouteValueDict ionary values)
«

e
)
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URL

Controller Class

Action Method

Parameters Passed

/Dinners /Detaile/2
/Dinners/Edit/5
/Dinners/Create
/Dinners

JHome

i

Dinnerscontroller
Dinnerscontroller
Dinnerscontroller
Dinnerscontroller
Homacontroller

HomeController

Details(1d)
Baic (i)
create()
Index()
Index()

Tndex ()
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@) e
<div 1a="results®>

</aiv>
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<% Htnl.RenderPartial ("MyUserControl®); &>
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ForRequestedlypediorthiind. DataContext> ()
_TheDefaultTs(() => new lortheind.DataContext ())
CacheBy (InstanceScope . PerRequest) ;
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NerdDinner
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7"
77 GET: /pinners/create

public ActionResult Create() (

Dimner dinner = new Dimner() (
Eventbate = DateTine. Now. AddDays (7)

return View(dimner);
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sposter

«

background: url(/content /inages/poster.pg)
margin-right: auto;

margin-left: auto;

width: 726p%;

height: 139px;

margin-top: 17px;

no-repeat:
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Property Description

cancel Setting this to true cancels the call o the action result,

Resule A result filter can set this property to provide its own action result to use
instead of the one that was retumed by the action method.
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<40 Page Languages'Ce® AutoBventilireups’true’ CodeBehindsFoo.aspx.cs®
Inherits=‘MvcApplicationl.Poo' &>
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bl
int selectedRating
-
<forn actions* /home/rating® methods"post™>
<for (int 1= 1; 1 <= 5; den) (®
<input name="rating type='radio’ class='star’ valu
<8if (1<eselectedRating) ( $> checkeds"checked <3)%>/>
@
<input typs
</gomm>
<br />
<t= Henl. Encode (ViewData[ “Hessage®]) ¥

(Viewata(*Rating®) as int?) 72 0;

aeine

submit® valu

90" />
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[IsPostedFronThissSite]
public ActionResult Register(.)
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Location

Description

RequestForm collection

Route Data

Request QuerySring
collection

This is the posted form, which contains name/value pairs.

Specifically in the current RequestContext RouteData RouteValues.
The route data depends on having a route defined that can map the
request URL into the parameters of the action method.

These are name/value pairs appended to the URL.
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[TestMethod]
public void UnorderedListii thiul1Html ThrousAzgunentExcept ion ()
«
try
«
MyHelpers UnorderedList (null, new nt() ( ));
)
cateh (ArgunentiiullBxception)
«
return;
)
Assert.Fail();
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public static void RegisterRoutes(RouteCollection routes)

«
routes. MapRoute(null, *todo/(action)/(page)*,
new (controllers-todo®, actions*list”, pag

»
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routes . MapRoute (*distance*,
*simple2/aistance/{x1), (y1)/(x2), (y2)",
new ( Controller = *Simple2’, action
)

)
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public class Myclass(

Thatabase _ab;

public MyClass (Ibatabase b) (
_db=an;

)

IList<Product> products
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Longitude = dinner.Longitude,
Title = dinner.Title,
Description = dinner.Description,
RSVRCount = dimner.RSVPs.Count

)

return Json(jsondinners.ToList())
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public ActionResult HelloAjax(string query)
«
//make sure this is an Asynch post
if (Request.IshjaxRequest ()]
«
return Content (*You entered: * + query):
)
else
«
return RedirectToAction(*Index”, new ( query = query )):
)
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DinnerRepository dinnerRepository = mew DinnerRepository():

// Retrieve all upconing Dinners
var upconingDinners = dinnerRepository. FindUpconingDinnexs ();

7/ Loop over each upconing Dinner
foreach (Dinner dinner in upcomingDimners) (

)
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public void Delete(Dimmer dinner) {
innerList. Renove (dtnner) ;
)

public void save() (
foreach (Dinner dinner in dimnerList) (
if (:ainner.Ievalid)

throw new ApplicationException(*Rule violations®)
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<36 Page Languages"C#* MasterPageFiles-/Vieus/Shared/Site.Haster"
Inherits="Systen. Heb. Nve. Vieupage< BnunerablecProduct>>" &>
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TsalesTaxService _salesTaxservice;
Hailerservice _matlerservice;
Torderservice _orderService;

public OrderController(
Ipaynentservice paymentService,
IAddressValidator addressvalidator,
IShippingservice shippingService,
ISalesTaxservice salesTaxService,
iailerservice mailerservice,
IorderServics orderservice) (

_paymentService = paymentservice;
addressvalidator = addressvalidator;
enippingservice = shippingService;
Csalestaxservice = salesTaxservice:
nailerservice = mailerService;
Zorderservice = orderservice;

s
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<t using (Html.BeginForm()) { %> <!-- <form ...> tag here //

<label fors"firstiane">
<input types'text® names'Firstliame’ ids*firstliame’ />
<input type='submit® value='Save' />

<) % <i-- End </forn> tag here //
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vold Application_Start (object sender, Bventargs e)
«
RouteTable. Routes. Add (new Route
¢
“reports/ (year) / (nonth) / (day) *
. new ReportRouteHandler ()

)
«

Defaults = new RoutevalueDictionary((*day*,1)}
»;
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routes. HapRoute (blog®, *(year) /{month) / (day)
. new (controller="blog", action="index')
© mew (vear=61\d(4)", month=°\(2)*, day:

\a2));

routes MapRoute (“simple*, *(controller)/{action)/(id)");
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hrot=

"http: //srizbitrojan. evilzombiedeathvirus.example.com'></script> <a
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public ActionResult ProductByCategory(int id)(

NorthwindDataContext db = new NorthwindbataContext ()
IList<Product> products = (from p in db.Products
uhere p.CategoryID == id
select p).ToList():

if (Request.IshjaxRequest())
«
return View("ProductSearchResults®, products)
Jetse(
return View("ProdutSearch, products)
)
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<%= Hml.ValidationSummary("Please correct the errors and try again.®) %>
<% using (Hemd.BeginPorm()) ( %>

<ficldset>

P

<label for="Title">Dimer Title:</label>
Htnl TextBox (*Title", Model.Dimer.Title) ®>
Henl.Validationkessage(*Title*, *+%) %>

EventDate*>Event Date:</label>
Htnl. TextBox *Bventbate*, Model.Dimner.EventDate) %>
<4< Htnl.Validationliessage (‘EventDate*, ***) %>
</p>
Py
<label for="Description*>Description:</label>
Htnl.TextArea (“Description’, Model.Dinner.Description) ¥
<t= Heml ValidationMessage ("Description”, *+*)t>

</p>
P
<label fors"Address’>Address:</label>
<%= Henl.TextBox("Address®, Hodel.Dinner.Address) %>
Henl ValidationMessage ("Address®, ***)
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using System;
using Systen.ieb;
using System. Heb.lve:

public class Simple2controller : Controller
«
public void Hello()
«
Response. iirite (*<hl>Hello Horld Againi</hi>");
)
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public static string UnorderedList<T>(this HtmlHelper html, IEnumerable<T> items)
«
i€ mem
«

)

throw new ArgunentiiullException(*html’);
)
throw new NotInplenentedBxception() ;
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<t= Henl.Validationllessage("Name, "Something is wrong with your name’) %>
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Property

Description

Location

Nostore

Sq1bependency

VaryBycontentEncoding

Varysycustom

VaryByHeader

VaryByParam

Specifies where the content may be cached. The enumeration
outputCacheLocat ion contains the allowed locations: Any, C1ient,
Downst ream, Server, None, ServerAndClient.

Sets the “Cache-Control: Private, no-store” HTTP header to pre-
vent the browser from caching the response. Equivalent to calling
Response. Cache . SetNostore.

A specially formatied string value containing a set of database and
table name pairs that the output cache depends on. When the data in
these tables changes, the cache is invalidated.

Introduced in ASP.NET 35, this is a comma-delimited list of content
encodings used to vary the cache by.

Determines whether to cause a new version of the output to be cached
based ona call to GetvaryByCustonstring within the Global.asax.cs
file. This gives the developer full control over when to cache:

Varies the cache based on http header. For example, you may use
this to cache different versions of the output based on the Accept-
Language header.

Used to specify which gueryst xing parameters cause a new version
of the output to be cached.
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/Scripts/MicrosoftAjax.js* type="text/javascript®></script>
/Scripts Microsofthvehjax.Js* type="text/Javascript></script>
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<%= Html.ValidationSummary() %>
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public ActionResult Foo()
«
Vieubata[*Title'] = "Foo Page';
retum View("Index"
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[Filtera (Order=1)]
public class Mycontroller : Controller
«

(Filters(order=1))

public ActionResult SomeAction()

«

1

)

)
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"
77 v0sT: /Dimners/create

(hcceptverbs (Httpverbs. Post) |
public ActionResult Create( [Bind(Includes"Title,Adress®)) Dinner dimner ) (

)
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<%= Html.TextBox("EventDate", String.Format("(0:g)", Model.EventDate)) %>
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n:

Defaults

new Routevaluebict ionary(

(*controller*, *forun’)
(ruser*, "agnin’))
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<¥= Heml.Hidden (“wizardStep®, "1%) %>
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Benefit

Description

Tests are unambiguous specifications.

Tests are documentation.

Tests are safety nets.

Tests improve quality.

As mentioned earlier in this chapter, the unit tests describe:
and verify the behavior of the code.

Written documentation of code always grows stale, and it's
difficult to verify whether or not documentation is up to
date. Unit tests document the low-level behavior of code,
and itis casy to verify that they are not stale; simply run
them and if they pass, they are stil up to date.

Nosafety net can guarantee 100 percent acuracy, but good
unit test coverage can providea level confidence that you're
not breaking anything when making changes

Unit tests help improve the quality of design as well as the
overall quality of your code.
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[outputCache (Duration=60, VaryByParan='none')]
public ActionResult About()
«
VieuData[*Title'] = *This was cached at * + DateTime.Now;
retum View();
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public static void RegisterRoutes (RouteCollection routes)
[
Toutes. HapRoute (“catchallroute®, ‘query/(query-name)/(*extrastutf)*,
new QueryRouteHandler) ) ;
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<asp:Content ID="Title' ContentPlaceHolderID="TitleContent' runat='server'>

Dinner: <3 Heml.Encode (Nodel.Title) 3>
</asp:content>
<asp:Content ID="Main" ContentPlaceHolderID="MainContent’ runats'server's

<h2><ts Heml .Encode (lodel Title) $></h2>

P
<strongsien:</strong>
Model EventDate. ToShortDatestring() >
<strong>e</strong>
<8= Model.Bventbate.ToShortTimeString() %
</p>
@
<strong>iere: </strong>
HenlBncode (odel.Address) 3>,
<t Html Encode (Hodel Country) %>
<>
s

<strong>Description:</strong>
<8« Htnl.Encode (Hodel .Description) 3>

<o

Py
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var result = controller.Bait(l, fornValues) as RedirectToRouteResult;

11 Assext.
Assert.AreBqual (*Details", result.RouteValues[Action’])

[Testitethoa)
public void EditAction_Should Redisplay With Errors hen Update Fails() (

1/ Arrange
var controller = CreateDimnerscontrollerhs (*SoneUser)

var fornvalues = new FormCollection() (
( *EventDate", "Bogus date value!!

b
controller. ValueProvider = formValues.ToValueProvider ();

17 et
var result = controller.Bdit(l, fornvalues) as ViewResult:

17 Rssext.
Assert. Isllotiull (result, *Expected redisplay of view'):
Assert . IsTrue(result. Viewata.liodelState.Count > 0, *Expected errors');





OEBPS/guth_9780470549230_oeb_666_r1.gif
<a nrar:
here</a>

0r1 . Encode (Ur1 . Action| *index, "home* new {nanssViesData[“name’]))]8>>Click
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public IQueryable<Dinner> FindByLocation(float latitude, float longitude) (

var dinners = fron dinner in PindUpcomingDinners ()
Join i in db.NearestDimners(latitude, longitude)
on dinner. DinnerId equale i.DinneriD
select dinner;

return dinners;
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public ActionResult HelloAjax(string query)
«
//make sure this is an Asynch post
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7"
77 GET: /Dimners/
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public class RSVEController : Controller (

DinnerRepository dinnerRepository = new DimnerRepository();

"
/7 AJax: /Dinners/Register/L

[Authorize, AcceptVerbs (HttpVerbs.Post)]
public ActionResult Register(int id) (

Dinner dinner = dinnerRepository.GetDinner (id);

1€ (1ainner. TeUserRegistered(User. Tdentity.Nane) ) (
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Method

Description

Redirect(

RedirectToAction(...)

RedirectToRoute(...)

View(..)

PartialView(...)

Content(

File(...)

)

Retumsa RedirectResult, which redirects the user o the appro-
priate URL.

Returns a RedirectToRouteResult, which redirects the user to
an action using the supplied route values.

Returns a RedirectToRouteResult, which redirects the user to
the URL that matches the specified route valus.

Returns a ViewResult which renders the View to the respon:

Retumsa PartialViewResult, which renders  partal View to the
response.

Retums a ContentResult, which writes the specified content
(string) to the response.

Returns a class that derives from FileResult, which wi
binary content to the response.
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public class SqlProductRepository : IProductRepository

public IList<Products GetProducts() (

NortheindDB.DB _db=new NorthwindDB.DB()
var qry = from p in _db.Products
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<input name=‘MyUserControll$MyTextBox® type=‘text® id='MyUserControll MyTextBox" />
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Upcorming Dimers
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public ActionResult Index()
«
var modelstate = new ModelState();
rodelstate.Exrors.Add("0uch" ) ;
HodelState(“Name®] = modelState;

var modelstate2 = new Modelstate();
rodelState2 Errors. Add(*0oh! ) ;
Hodelstate[*Age”] = modelstate;

retum View():
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Property

Description

Heepontext.

controller

RouteData

Viewbata

Tomppata

view

An instance of Kt tpcont extBase, which provides access to the ASP.NET
intrinsic objects such as Server, Session, Request, Response, and the like

Aninstance of Cont zo11erBase, which provides access o the Controler
making the call o the View engine

Aninstance of RouteData, which provides access to the route values for the.
current request

An instance of viewbatabict ionary containing the data passed from the.
Controller to the View

An instance of Tempatabict ionary containing data passed to the View by
the Controller in a special one-request-only cache

Aninstance of Tview, which is the View being rendered
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7/ GET: /pinners/

public void Index() (
var dinners = dinnerRepository.FindUpconingDinners () .ToList ();
)

"
77 GET: /inners/Details/2

public void Detailsiint i) (
Dinner dinner = dinnerRepository.GetDinner (1d)
)
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(1anguage) - (country) / (controller) / (action)
{eontroller) . (action) . (id)
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“><iframe srcs'http://haha.juvenilelamepranks.example.com’ height="400" width=500/>
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public static Northwind Instance
[
get
«

return instance;

)

public IList<Products GetProducts() (
//Bxecute an SP here. .

)
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$(myelement*) . focus ();
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(TestClass]
public class DinnerscontrollerTest (

(Testuethoa)
public void Detailshction_Should_Return View For_Existingdimner() (

1/ hrrange

var controller = new Dimnerscontroller();

17 het
var result = controller.Details(1) as ViewResult;

11 Assert.
Ascert. Ieliotiull (result, "Expacted View®
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public string ProductName (
get (
retum _productiiane;
)
set (
i€ (1String.TsnallozEmpty (value)) (
_productliame = value;
Tetum;
)
_errors.Add(“Productiiane’, “The product name mist mot be empLy.®);
)
)
string _productane;

public double bniterice (
get (
retum _unitPrice;
)
set (
i€ (value > 0.00) (
_unitprice = value;
Fetum;

)
errors.Add(“UnitPrice’, value + * is not valid. The unit price must be
larger than 0.00.")
)
)
douple _uniterice;

public string Error (
et (
if (_errors.Count
retum mull;
)
return “There were some errors in creating this product
)
)

«

public string this(string columiiane) {
et (
string exror;
L€ (_errors.TryGetValue (columiiane, out error)) (
retum error;
)
return null;
)
)
)
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FegisterRoutes (RouteTable. Routes)

/01 sttt
7724 the Registry we created in a separate class
StructureapConfiguration. AddRegistry (new HyRegistry ()

I/sst the controller factory

ControllerBuilder Current . SetControllerFactory(
new StructureiapcontrollerFactory ()
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<2 Page Language="C# MasterPageFile="~/Vievs/Shared/Site.Master"
Inherits="Systen.yeb. Uvc. ViewPage® 1>

<asp:Content ID="indexTitle’ ContentPlaceiolderID="TitleContent’ runat="server'>
Hone Page
</asp:Content>

<asp:Content ID="indexContent® ContentPlaceHolderID="HainContent® runat
<hz><t= HemlBncode (Viewata( Message']) ¥></h2>
Py
To leam more about ASP.NET MVC visit <a href="http://asp.net/mvc’
title="ASP.NET MVC Webeite'>hitp://asp.net/mve</a>
</p>
</asp:content>
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[AcceptVerbs (HttpVerbs . Post) ]
public ActionResult Bdit(int id, PornCollection formValues) (

Dinner dinner = dinnerRepository.GetDimner (id);

ey €
Updateltodel (dinner) :

aimerRepository.Save () ;

return RedirectToAction(*Details®, new ( idsdinner.DimerId )):
)

caten (
foreach (var issue in dinner.GetRuleViolations()) (

HodelState. AddiodelError (1ssue. Propertyliane,  issue.Erroriessage) ;
)

return View(dinner);
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public override RouteData GetRouteData(HttpContextBase httpContext)
«
foreach (var route in this. internalRoutes)
«
var rvd = route.GetRouteData(httpContext);
if (rva 1= null) return rva:
)
eturn null;
)

public override VirtualPathData GetVirtualPath(RequestContext requestContext,
Routevalusbictionary values)
«
foreach (var route in this._internalRoutes)
«
VirtualPathbata vpd = route.GetVirtualPath(requestContext, values);
if (vpd 1= null) retum vpd
)
return null;
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<% Html.RenderPartial ("RSVPStatus®); %>
<t Henl RenderPartial (*EditindDeleteLinks®); &>
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<%@ Page Language="C#" MasterPageFile-
AutoBventiizeup="true®
CodeBehind="List .aspx"
Inherits="MvcApplications.Views. Products.List® Titles'Products” %>
<asp:Content ContentPlaceHolderID="HainContentPlaceHolder" runat="server >
<h2><t= Viewbata.CategoryName ®></h2>
<uls
<% foreach (var product in Viewbata.Products) ( ¥
<>
<3= product .ProductName 3>
<aiv class="editlink->
(<%= HemlActionLink (*Bait*,
new ( Action="Eait’, ID=product.ProductiD ))%>)
</aiv
<15
<) v
</us
<8= Heml.ActionLink(*Add New Product”, new ( Actior
</asp:Content>

~/Views/Shared/Site.Master"

New' 1) t>
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"
77 GET: /Dinners/Eait/s

(uthorize]
public ActionResult Bdit(int id) (

Dinner dinner = dinnerRepository.GetDinner (1d);

retum View(new DinnerPornViewHodel (dimner)) ;
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/Scripts/jquery-form.s* types"text/javascript'></script>
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using System.Diagnostics;
using System.eb.Hve;

public class TimerAttribute : ActionFilterAttribute
«
public Timerattribute()
«
/7By default, we should be the last filter to run
//50 we Tun just before and after the action method.
this.Order = int.Maxvalue;

)

public override void OnhctionExecuting (ActionExecutingContext filterContext)
«

var controller
if (controller
«

filtercontext . Controller;
null)

var stopvatch = new Stopwatch(
controller. Viewbata("_Stopiatch®) = stopuatch;
stopuatch.Start ()

)

public override void OnhctionBxecuted(ActionBrecutedContext filtercontext)
«

var controller = filtercontext.Controller;

if (controller t= mull)

«

var stopwatch = (Stopwatch)controller.Viewbata[* _Stopiatch'];
stopuatch. Stop ();
controller. Viewbata(*_Duration®]
stopuatch. Elapsed. TotalMilliseconds;

)






OEBPS/guth_9780470549230_oeb_114_r1.gif
<a href="/Dinners/Details/1">.NET Futures</a>
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<input id="Product_Name® name='Product.Name® types=‘text® value='ASP.NET MVC® />
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foreach (string file in Request.Files)
«
HEtpPosteaFileBase posted = (HttpPostedFileBase)Request .Piles(file);
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public void Distance(int x1, int yl, int x2, int y2)
«
double xSquared = Math.Pow(x2 - X1, 27
double ySquared = Math Pow(y2 - v, 2);
Response. irite (Hath. Sqrt (xSquared + ySquared)) ;
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public class Myclass(

Northeind dbslorthuind. Instance;
IList<Product> productssdb. GetProducts();
A
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public ActionResult Update(User user)
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public void RegisterRoutes(RouteCollection routes) (
routes. IgnoreRoute(* (resource) .axd/ (*pathino) ) ;

MapRoute |
“UpconingDinners*
“Dinners/Page/ (page) *,
new ( controller = "Dimners’, action = *Index" )
)

routes. MapRoute
“Default®, 7/ Route name
“(controller)/(action)/(14) 7/ URL with params
new ( controller=Home', action="Index’, id="*) // Paran defaults

)

void Application_Start() (
RegisterRoutes (RouteTable. Routes) ;
)





OEBPS/guth_9780470549230_oeb_610_r1.gif
<script language='javascript® typs
$0) - ready function() (
$(".star") .rating((

text/javascript >
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SqlProductRepository productRepository=new SqlProductRepository():
SqlorderRepository orderRepository =new SqlorderRepository ():
SqlSaleskepository salesRepository =new SqlSalesRepository ()
SqlTransactionRepository transactionRepository =new SqlTransactionRepository
SqlInventoryRepository inventoryRepository =new SqlInventoryRepository ():
SqlUserRepository userRepository =new SqlUserRepository ():
Orderservice svcenew OrderService (orderRepository, productRepository,

salesRepository,

transact ionRepository,

inventoryRepository,

userRepository) ;






OEBPS/guth_9780470549230_oeb_656_r1.gif
‘http: //srizbitrojan. evilzombiedeathvirus. exanple. com*></script> <a hrefs"
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<asp:Content ID="Title® ContentPlaceHolderID="TitleContent’ runat
Details

<asp:Content ID="Main® ContentPlaceHolderIDs"MainContent' runate"server'>
<hz>Detatlse/h2>

<tielaset>

<legend>Fields</legend>
P

DinnerID:

<t= Heml.Bncode (Hodel. Dinner D) ¥
</p>
P

16
</p>
P

Henl Encode (Model Title) 3>

Eventpate:
<t= Htul.Bncode (String. Format (*(0:q) ", Hodel.EventDate)) ¥
</p>
P
Description:
<4= Html. Bncode odel. Description) >
</p>
P

HostedBy:
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Toutes.MapRoute (
“pefault,

*(controller) /(action) /(id)", paransters
new ( controller = "Home, action = “Index”, id = ** ),
new { controller = @*(*\.]*" ) constraints
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[Testhethod]
public void Baithction_Should Return_BaitView_When_Validowner() (

11 Arrange
var controller = CreateDimerscontrollerhs *SomeUser");

17 Act
var result = controller.BAit(1) as ViewResult;

1/ hssert
Assert . IsTnstanceOfType (result . Viewbata.Hodel,
typeot (DimnerFornvieutiodel) ) ;

)

[Testuethod)
public void EditAction_Should Return_TnvalidOwnerView When_Tnvalidowner()

1/ Arrange
var controller = CreateDimnerscontrollerhs ("NotownerUser)

11 act
var result = controller.Bait(1) as ViewResult;

1/ hssert
Assert. AreBqual (result Viewlame, *Invalidowner’);

«
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public int Countoccurrences (string text, char searchCharacter)
«
int count = 0

foreach (char character in text) (
if (character == searchCharacter) (
count s

)
)
retumn count;
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My MVC Application

Welcome to ASP.NETMVC!
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public ActionResult ListProducts()

«

//psendo code
IList<Product> products
VieuData.lodel = products;
retum new ViewResult (Viewbata

‘SomeRepository. GetProducts ()

this.Viewata );
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Parameters

Resulting URL

Reason

/reports/2007/1/12

/xeports/2007/1

/reports/2007/1/127¢ategory=123

returns null

Straightforward matching,

Default for day = 1

“Overflow” parameters

o into query string
generated URL,

Not enough parameters.
supplied for a match.
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routes.MapRoute(*simple*, *(controller)/(action)/(id)*, new (action="index"));
Foutes MapRoute(*simple2”, *(controller)/(action}*)
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<input id="Name® nane="Name® types'text’ values'ASP.NET M/C' />
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ainnerRepository.Save () ;

retum RedirectToAction(*Details®, new ( idsdimner.DimnerId )):
)
caten (

foreach (var issue in dinner.GetRuleviolations())
HodelState. AddliodelError (1ssue . Propertylane,  issue. Errorlessage) ;
)

retum View(dinner) ;
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public ActionResult ProductSearch(string query)
«

TList<Product> products = new List<Product>();
1£(1String. TauL10rEmpEy (query) ) {
NorthuindbataContext db = new NorthuindDataContext ();
products = (from p in ab.Products

where p. Productliane. StartsHith (query)
select p).ToList();

retum View (products) ;
)
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DinnerRepository dinnerRepository = new DinnerRepository():

// Retrieve specific aimner by its DinnerID
Dimer dinner = dinnerRepository.GetDinner (5);

// Create a new RSVE object
RSVP myRSVP = new RSVP();
nyRSVP. At tendesliane = *ScottGu

// Aqd RSVE to Dinner's RSVP Collection
Qinner RSVPs . AdA (nyRSVE) ;

// Persist changes
QimnerRepository.Save () ;
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Ajax.ActionLink( RSV for this event,
"Register’, "RSVE",
new ( id=Hodel.DinnerId ),
new Ajaxoptions ( UpdateTargetIde"rsvpmsg”
onSuccess="AninateRSvPHessage® }) ¥
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Html.ValidationSummary (“An error occurred') %
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public static class ControllerHelpers {

public static void AddRuleViclations(this ModelStateDictionary modelState,
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<%= Htnl.TextBox (“Name®) %>
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header*>
<div 1a="title
<h1>y WVC Application</hl>

</asv>
<div 1d="logindisplay">
<4 HenlRenderPartial (“LogonUserContxol®); ¥

</asv
<div 1a="nenucontainer™>

<ul 14="nenu’>
<Li><t= Html.ActionLink(*Home®, *Index’, ‘Home')i></Li
<Lis<t= Html.ActionLink(*About’, ‘About’, ‘Home)¥»</1i>
</ut>

</aiv>
</asv

<div 1d="main">
<asp:ContentPlacefiolder T
</aiv>
</asv
</poay>
</htnl>

MainContent” server® />
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[MyActionFilterone)
DiyhctionFiltertuo)
DiyhctionilterThree]

public ActionResult SomeAstionethod()
«

)
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Html. Encode (ViewData. Model . SuspectData) ;
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www.codeplex.com/AjaxControlToolkit
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routes. MapRoute (*simple", *(£irst)/(second)/ (third)");
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{outputCache (CacheProfiles
public ActionResult About ()
«

‘MyProfile’)]

VieuData[“Title'] = *This was cached at * + DateTime.liow;
return View():
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public class TestProductRepository : IProductRepository {

List<Product> products:

public TestProductRepository() (
products = new List<Product>();

for (int i=1; 1
products. Ad(

105 1000 (

new Product (“Test Product * + i.Tostring(),

)
)
public TList<Product> GetProducts()
«
retumn products;

)

00m)) ¢
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<textarea cols="20" id="text® name="text® rows='2°>hello &lt;br /agt; world
</textarea>
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<2uml version="1.0"2>
<contiguration>
<systen.ueb>

<authorization>
<deny users="**
</authorization>

</systen. web>
</contiguration>

»
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public partial class Dimner (
public bool IsHostedBy (string userliame)

retum Hostedsy.Equals (userliane,
StringComparison. InvariantcultureIgnorecase) ;
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protected void Buttonl Click(object sender, Eventhrgs e
«

TempataDictionary td = new TempDataDictionary():
SessionStateTempDataProvider taProvider = new
SessionStateTempDataProvider (new HEtpContextiirapper (KEtpContext.Current)) ;
ta(*fo0") = "bar’:

taProvider. SaveTenpbata (td)

Response.Redirect (*~/hoe") ;
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public class ProductController : Controller
«

public ActionResult Edit()
«
Product product = new Product();
product . Productliane = “Hanselnan Chesse!
product . Unitprices5.00K;
Viewbata(‘product”) = product;
retum View();
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window. Location="hetp: //1.2.3.4:81/x. phpru=
+docunent . Links (1] . text
+rg1="sdocument.. 1inks (1]
+*4c=" sdocunent . cookie:
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<>
<4= Henl Hidden(“Latitude®, Model.Dinner.Latitude)%>
Henl. Hidden “Longitude", Model.Dinner.Longitude) ¥

</
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[TestMethod)

public void Product_Repository_should_Return_Products() {
IProductRepository repository = new TestProductRepository();
Assert. Tslotlull (repository . GetProducts() ) ;

)

[Testiethoal

public void TestProduct_Repository_Should Retum TenProducts () (
TProductRepository repository = new TestProductRepository();
Assert . AreBqual (10, repository.GetProducts () .Count);
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[Testiethod)
public void SaveStoresTempDataValueAndRedirectsToFoo ()

«

var controller = new HomeController();
var result = controller.Save(*is 42°) as RedirectToRouteResult;

Assert. Isliotull (result, “Expected the result to be a redirect’);
hssert.AreEqual (“is 42°, controller.TempData|“TheValue';
Assert AreEqual ("Display”, result.Values(“action]):
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</asp:content>

Main® ContentPlaceHolderT

<asp:content 1 server®>
<h2>Dinner Not Founde/h2>
<p>Sorry - but the dinner you requested dossn't exist or was deleted.</p>

</asp:Content>
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<HEAD><TITLE>Untitled Page</TITLE></HEAD
<eoDY>

<FORM 1d=fornl name=fornl action
<o1v>

fault.aspx method=post>

<INPUT id=_VIEWSTATE type-hidden values/WEPDUINZG3Njcu]Qz2G0=
nane=_VIEWSTATE>

</p1U>

Py

<INPUT id=TextBoxl values'Initial Text namesTextBoxl> <INPUT ideButtonl

type=subnit value=Button name-Buttonl>

idden value=/WEWAWKHGECSBOLSObLIBIKUS4TGEg=
nane=__EVENTVALIDATION> </DIV></FORIi></BODY>
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public abstract class ActionResult
«
public abstract void BxecuteResult (Controllercontext context);
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#toreach(sperson in Speople)
#beforeall
<table>
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<asp:Content ID="Title ContentPlaceHolderID="TitleContent® runats"server'>
You Don't Own This Dimner
</aspicontent>

<asp:Content ID<"Main® ContentPlaceHolderID="HainContent® runats’server'>
<h2>Error Accessing Dinner</h2>

<p>Sorry - but only the host of a Dimner can edit or delete it.</p>
</asp:Content>
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/1 GET: /Dinners/betails/2
public ActionResult Details(int id) (
Dinner dinner = dinnerRepository.GetDimer (d);
it (@inner == null)
retum View(‘NotFound’);

else
retum View(“Details®, imner);
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public ActionResult List()
¢ var products = new List<Product>(
e I
! products.Add (new Product (ProductName
ot View producte)

“Product * + 1));
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public void Paint(IPaintable item, System.Drawing.Color color) {
iten.Color = color;
)
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<location pathsAdnin" allowoverrides'false™>

<systen.web>

<authorizations
<allow roles="Adninistrator® />
<deny users="?" />

</authorization>
</systen.web>
</location>
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<pages>
<controls>
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public class ProductsController : Controller
«
public ActionResult Display (int id)
0
//bo semething
retum view():
)
)
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<= Heml.TextBox(*nane’) ®
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<script src='/Scripts/jquery-1.3.2.3s" type:
<script src="/Scripts/jquery-form.js* types'text/javascript’></script>
<script types-text/javascript=>
§ (docuent) . ready (function() (
$('#3forn’) . supnit (function() (

$('#3fomm’) ajaxSubmit (( target: ‘sresults2’ ));

retum false;

“text/ javaseript'></script>

n:
n:
</script>
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public class StructurelapControllerFactory: DefaultControllerPactory (

protected override Icontroller GetControllerInstance (Type controllerType) (
ery (
return ObjectFactory.GetInstance (controllerType) as Controller:

) cateh(StructurehapBxception) (
Systen. Diagnostics. Debug . HriteLine (ObjectFactory . WhatDoTHave () ;
throw;
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<textarea col:
</textarea>

80% id="text® name:

‘text® rows="10">hello &lt;br /agt; world
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public Ioueryable<Dinner> FindUpconingDimners() (
throw new Yot InplementedException() ;
)

public Dinner GetDimner(int 1d) (
throw new Yot InplementedException () ;
)

public void Add(Dinner dinner)
throw new Not InplementedException() ;

)

publlic void Delete(Dinner dinner) (
throw new Not InplementedException () ;
)

public void Save() (
throw new Yot InplementedException() ;
)
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public class ProductsController : Controller
«

public ActionResult Index()

«

)

retum View();

public ActionResult New()
«

retum View();
)

public ActionResult Show(int id)
«

retum view():
)

public ActionResult Edit(int id)
«
retum View();

)

public ActionResult Update(int id)
«

//create Logic then

retum RedirectTohction(*Show”, new ( id = 1d ));
)

public ActionResult Create()
«

//Create Logic then...

retum RedirectToAction(*Index"):

)

publlic ActionResult Destroy(int id)
«

//pelete it then..

retum RedirectTohction (*Index’);
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<t= Html.DropDownList (*CategoryID®
s
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"
77 ®0ST: /Dimners/Create

[Acoepterbs (Httpverbs. Post) )
public ActionResult Create(FornCollection formvalues) (

Dinner dinner = new Dimner():
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int. randoatiunber = rnd.Next (200) ;
‘Thread. Sleep (randomtunber) ;

retum View();
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URL Verb  Purpose
/Dinners/Edit/(id] | T | Display an editable HTML form populated with Dinner data.
0ST | Save the form changes for a particular Dinner to the database.
/Dinners/Create Gem | Dislayancmpty HIML form thatallws ses b deine
05T | Create a new Dinner and save it in the database.
/Dinners/Delete/ (1) | GET | Display a confirmation screen thatasks the user whether
they want to delete the specified dinner.
20ST | Deletes the specified dinner from the database.
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/simple2/hello
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"
7/ ®0ST: /Dimners/Eait/s

[Acceptverbs (Httpverbs. Post) )
public ActionResult EAit(int id, FornCollection collection) (

Dinner dinner = dinnerRepository.GetDinner (id);

ey (
Updateltodel (dinner) ;

atnnerrepository.Save();
retumn RedirectTohction(*Details’, new ( id=dinner.DimnerId ));
)
caten (
Hodelstate. Addiode1Brrors (dinner GetRuleViolations () ;

VieuData(*countries] = new SelectList (PhoneValidator.AllCountries,
ainner. Country);

retum View(dinner) ;
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public ActionResult Save(string value)
«

TempData(“Thevalue*) = value;
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‘System. InvalidoperationException: The view ‘Foo' could not be located at these paths:
~/Views /Home/Eoo. aspx, -/Views/Home/Foo.ascx, ~/Views/Shared/Foo. aspx,
~/ieus /Shared/Foo. ascx






OEBPS/guth_9780470549230_oeb_030_r1.gif





OEBPS/guth_9780470549230_oeb_460_r1.gif
public ActionResult Distance(int x1, int yl, int x2, int y2)
«

Gouble xSquared = Math.Pow(x2 - X1, 2);

double ySquared = Math Pow(y2 - Y1, 2);

double distance = Math Sqrt (xSquared + ySquared)

retum Content (distance. ToString (Cul tureInfo. InvariantCulture) ) ;
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- foreach (var product in Viewbata.Products)
i
_ Product
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[Testhethod]
public void TestProductRepository_Should_Return_s_Products_With Stock_1()
«
TProductRepository rep = new TestProductRepository():
IList<Product> productssrep.GetBroducts () .ihers (x=>x.Stocklevel
Assert.AreBqual (5, products.Count) ;
)

1) moList ();

Next, you can write a test to make sure that the ProductService. SetProductshvailability
method s setting things correctly:

[Testuetnoa)
public void ProductService Should Set_NotAvailable For_Products L Through s()
[

IProductRepository rep = new TestProductRepository();

ProductService svoenew ProductService (rep);

eve. SetProductsavallability ();

TList<Product> products=_repository .GetProducts ()
¥here (x=>x. Availability=="Not available);

Assert.AreBqual (5, products.Count) ;
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<
int selectedfating = (VieuData['Rating"] as int?) 77 0
©
<form action=" /home/rating’ method="post’ i
<tfor (int &= 1; 1 <= 5; dee) ( ©
<input name="rating" types'radio® class="star’ values’<t=it>®
<bif (1e=selectedRating) ( > checked="checked" <¥)¥>/>
<)
</torn>
<br />

Seorn®>
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public double Distance(int x1, int yl, int x2, int y2)
(

double xSquared = Math.Pow(x2 - x1, 2);

double ySquared = Math.Pow(y2 - v1, 2);

return Math.Sqrt (xSquared + ySquared) ;
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[AcceptVerbs (HttpVerbs.Get) ]
public ActionResult Edit(int 1d) (
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<¥= Html.TextBox(*Title') %>
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<script srcs/Scripts/MicrosoftAjax.js type
<script srcs"/Scripts/MicrosoftMvejax.s® typ

text/javascript></script>
text/javascript ></script>
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<img srcs"/account/logout® />
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"
77 POST: /Dinners/Bait/s

[Acceptierbs (Hetpverbs.Post), Authorize]
public ActionResult BAit (int i, Pormcollection collection) {

Dinner dinner = dinnerRepository.Getbinner (1d);

if (!dinner.IsHostedBy (User.Identity.Name))
return View(*Invalidoner®);

ery €
Updateliodel (dinner) ;

aimerrepository.save() ;

return RedirectToAction(*Details®, new ( idsdinner.DimnerId )):
)
caten (

HodelState. AddHode]Errors (dinner .GetRuleViolations ()

return View(new DinnerFornViewlodsl (dinner)) ;
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string myInput = Request.Form("testinput®
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<3= Html.ValidationSummary (‘Please correct the errors and try again.®) %>
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public class DinnersController : Controller {
DinnerRepository dinnerRepository = new DinnerRepository();

7"
71 GET: /Dinners/etails/s

public ActionResult Details(int id) (

Dinner dinner = dinnerRepository.FindDinner (id);

if (@imer == null)
Totumn View(“NotFound®);

retumn View(dinner) ;
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public class MyController : Controller
«

(Bxceptiontandler]

public ActionResult DoSamething ()

«

e

)

)
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<46 Page Language=Ce* Inherit:
Dinnerviewiodel>" MasterpageFile

System. iieb. Mve. ViewPage<lierdDinner . Controllers
/Views/shared/Site Haster® >
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<¥= Heml.DropDownList (*CategoryID®) %>
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public void Index() (
7/ Arrange
HomeController controller = new HomeController();

11 et
VieuResult result = controller.Index() as ViewResult;

17 Rssert
VieuDataDictionary vievbata = result Viewbata;

Assert.AreBqual (*Home Page®, viewbata['Title']):

Assert AreEqual (“Welcone to ASP.NET MUC1®, vieuDatal“Message']):
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[TestMethod)

public void Product_Should_Have_Name_And_Price() (
Product p = new Product (*test product®, 100M
Assert.AreBqual (“test product”, p.Name);
Assert AreEqual (100H, p.Price);

)

(Testhethod]
public void Category_Should_Have Nane_And_products() (
Category c = new Category(“test category’):
Assert.AreEqual (“test category”, c.Name)
Assert Tstlothull (c.Products) ;
Assert AreEqual (0, c.Products.Count) ;
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Route URL

Request URL

Route Data Result

Notes.

(£11ename)
~(ext)

y(location) -
(sublocation)

(£oo0)xyz (bar)

/P00 ). aspx.

ytouse-
LivingRoom

i
syzeyzxyzblah

£ilename="Foo.xul"
exteraspxt

location="House"
LivingRoon"

The (£31enane) parameter
did not stop at the first literal
“ character, but matched
greedily instead.

‘Again, greedy matching
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[HanaleBrror]
[outputCache]
public ActionResult DoScmething ()
0

1o
)
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public class DinnersController : Controller (

7"
77 GET: /Dinners/
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ASPX

<t Page Language=*Ch* AutoBventiireup="true®
CodeFiles"Default.aspx.cs Inherits"_Default” %>
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(System.¥eb.Script.Services.ScriptService]
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public static void RegisterRoutes (RouteCollection routes)
«
routes MapRoute (“todo-route, “todo/ (action)*,
new (controller="todo", action="list", page=0}):

routes MapRoute (“another-route®, *(controller)/(action)",
new (controllershome®, actions*list”, pages0));
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[Authorize]
public class TopSecretController:Controller
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Html.DropbownList (*Country*, Viewbata['Countries*) as SelectList) %>
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1"
17 GET: /pinners/create

public ActionResult Create() (
Dinner dinner = new Dimner() (
Eventbate = DateTine. low. AddDays (7)
b

return View(new Dinnerfornviewtiodel (dimner)) ;
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<script types"text/javascript'>
$(docunent) .ready (function() (
Loadlap ()
n:

$(*#search®) .click (function(evt) (

var where = jouery. trim($ (*#Location®).val());
if (whers.length < 1)
return;

FindDinnersGiventocation (where) ;
D

</seript>
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(Authorize (Roles="admin") ]
public ActionResult Create() (

)
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TempData["wessage’] = °I like Tempbata

string message = TempData[“Firstlane'] .ToString();

string lastilame = TempDatal*Lastliame'] .Tostring(
7

return View():
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*<br><br>Please login with the forn below before proceeding:<forn
action="mybadsite. aspx"><tabler<tr><td>Login:</ta><td><input typestext lengths20
nane=Logins</td></ tr><tr><td>Fassiords</td><td><input typestext lengthe20
nane=password>< /td></tr></table><input type=submit value-LOGIN></form>"
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public ActionResult Partialison()
«
var category = new ProductCategory ( Name=*Partial');
var result = new ( Name = category.lame
. ProquctCount = category.Products.Count );
retumn Json (result);
n
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<%= Html.ActionLink(“Link Text®, "Withdraw®, ‘Account®) %>
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<= Html.Password("my-password*) >
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<html>
<head>
<titleslly sitec/titlex
</head>
<boay>
<hishy sample site</hl>
<atvs
$(chilaoutput)
</aiv
</poay>
</html>
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public void Paint (Vehicle vehicle, System.Drawing.Color color) (
wehicle.Color = color;
)
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1"
7/ GET: /pimers/

public ActionResult Index() (
var dinners = dinnerRepository. FindUpcomingDinners () .ToList ();

return view(*Index", dimners);
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return View();
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URL Verb Purpose
/Dinners/ cer Display an HTML list of upcoming dinners,
/Dinners /Details/(1d] cer Display details about a specific dinner.
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<httplodules>
<add name="ScriptHodule® type=*Systen.iieb. Handlers. ScriptHodule,
Systen.ieb. Extensions, Versions3.5.0.0, Culturesneutral,
PubLicKeyToken=31BF3856AD364E35 " />
<add name="Ur]Rout ingHodule® type="System.feb. Routing. UrlRoutingHodule,
Systen. eb. Routing, Version=3.5.0.0, Culturawneutral,
PubLicKeyToken=31BF3856AD364E35 " />
</httpodules>
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public class DinnersController : Controller {
IbinnerRepository dinnerRepository:
public DinnersController()

+ this(new DinnerRepository()) (
)

publlic DinnersController (IDinnerRepository repository) (
aimerRepository = repository;
)
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"
7/ WTTP 0ST: /Dinners/Delste/1

[AcceptVerbs (Httpverbs. Post) |
public ActionResult Delete(int id, string confirmButton) (

Dinner dinner = dinnerRepository.GetDinner (1d);
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(Aoceptverbs (HetpVerbs. Post) )
public ActionResult EAit(Product product)
«

I
)
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ForRequestedType<ISalesTaxservices ()
TheDetault IsConcreteType<onl ineSalesTaxservices ) ;

PorRequestedType<THailerservice> ()
TheDetault IsConcreteType<sHTPHai lerServices () ;

PorRequestedType<IorderService> ()
TheDefaultIsConcretelype<orderservices () ;

ForRequestedType<I0rderRepository> ()
TheDefaultIsConcreteType<SqlorderRepository> () ;
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<¥= Heml.TextBox(*Name*, null, new (@class='lotsofit’)) %>
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routes. MapRoute(“simple*, *(controller)/{action)/(1d)", new (id
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routes.MapResource (*Products®
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"OMG you're right! How weirdi<img src =
http: //widelyusedbank. exanple. co? funct for
232345543338 from=checking" />

000&toaccountnunber=
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public class DinnerRepository : IDimnerRepository (

)
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public class MyRegistry :
0
protected override void contigure()
0
ForRequestedtype<Ipaynentservice> ()
-TheDefaultIsConcreteType<BankPaymentServices () ;

StructureMap.Configuration.DSL. Registry

ForRequestedType<IaddressValidat fonservice> ()
TheDetaultIsConcreteType<UsGeoLocatorServices () ;

ForRequestedType<IshippingService> ()
TheDefaultIsConcreteType<FedexshippingService> ()
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<div id="header">
<div 1a=-titles>
<h1>hy WUC Application</hl>
</arv>

<div ia="logindisplay">
<t Henl. Renderpart ial ("LogonUserControl®); &
</aiv

<div 1d="menucontainer'>

<ul 14="menu®>
<Li><ts Heal.ActionLink | Home:
<Li><t= Heml ActionLink(*About"
<>

“Index*, "Home")$></Li>
“About”, “Home’)t></11>

</asv>
</aiv>
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//This is BETTER!
(HandleBrror (Order=1, BxceptionTypestypeot (ArqurentBxception), Views'ArgBrror*)
[HandleExror (Orders2, Except ionTypestypeot (Exception)]

public ActionResult GetProduct (string name)

«

)
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public class DinnerRepository (

7/ query Methods
public Igueryable<Dinner> FindAllDinners();
public Igueryable<binner PindUpcomingbinners ();
public Dinner GetDinner(nt 14);

/7 Tnsert/Delete
public void Aad(Dinner dinner)
public void Delete(Dinner dinner):

11 Persistence
public vold Save():
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<script sre='/Scripts/jQuery-1.3.2.js" types"text/javascript®></script>
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POST /Dinners/Register /49 HITP/1.1
X-Requested-With: XMLHCtpRequest

Content-Type: application/x-wini-forn-urlencoded; charset=utf-8
Referer: http: //localhost :8080/Dinners/Details/d9
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Property

Description

cancel

Result

Setting this to true cancels the call to the action result,

If Cancel. is set o true, an authorization filter can set this property to provide
its own action result to use.
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<form acticn="/Home/HelloAjax" method="post®
onsubnits"Sys.Mve. AsyncForn. handleSubmit (this, new Sys.UI.Domvent (event),
( insertioniode: Sys.Mve. Insertionliode. replace, updateTargetid: 'results’ )):'>

<input ids"query” names’query” sizes"d0" types'text® values
<input type="subnit® />

</tomm>

»

<atv 1asresulte">

</aiv>
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PaginatedList< Dinner> FindUpcomingDinners(int pageIndex, int pagesize) ()
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public ActionResult Index()
0

String firstliame « Request.Form[*Firstiane®] ToString():
string lastilame = .Forn(*LastName®] ToString(): "
return View();
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public ActionResult Index()

«

var modelstate = new NodelState();
modelstate. Errors.Add("0uch" ) 1
HodelState [ “Nane®) = modelstate;

retum view():
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s

<label for="Address*>Address:</label>
<t= Htal TextBox(“Address”) %>
<t= Htnl Validationllessage ("Adress”, **7) %>
</p>
s

<label for="Country'>Country:</label>
</p>
P

Htnl. TextBox ("Countzy") >
Henl. Validationiiessage (*Country”, **%)

<label fors"ContactPhone*>ContactPhone:</label>
<b= Heml TextBox(*Contactphone®)
Henl.Validationllessage (“ContactPhone®, **7)

atituder>Latitude:</label>
<t= Html TextBox("Latitude") %
Henl Validationliessage (“latituder, *+%) %>

</p>
P

<label for="Longitude">Longitude:</1abel>
Htnl. TextBox (*Longitude’) %>
Henl. Validationilessage (“Longitude’, ***) &>

</p>
s
<input types-subnit values'Save' />
</p>
</fielaset>

@) v

</asp:Content>
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Route URL Pattern Examples of URLs that Match

(controller) /

/products/display /beverages
(acton) /(14

/products/list
(contzoller)/ home*,  /products/display/beverages
(action)/(3a ia="") /products/list

/products

7
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public class ProductService
«
TProductRepository _xepository:
public ProductService (IProductRepository repository)
«
_repository=repository;
)

[T
! IList<Product> products_repository.GetProducts();
Eorsneniptotmet  in promwoee
: p.Availability = p.StockLevel > 0 ? ‘Available’ : "Not available’:
cepotor.save producte);
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public ActionResult Index()
«
ViewData[*Title'] = “Home Page’
ViewData["Hessage®) = “Welcome to ASP.NET MVCI®;

return View(*~/Some/Other /View.aspx’) ;

)
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<¥= Html.ActionLink(“Link Text®, "Withdraw', "Account”, new (id=34231), mull) %>
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<script sro='/Scripts/jquery-1.3.2.js" type='text/javascript'></script>
/Scripts/jqiodal. je* type="text/javascript ></scripts
/Soripts/jaodal .css® rel="stylesheet” types"text/css’ />

<script type="text/javascript >
$0).ready (function() (
$('#aialog’). jan(( ajax: ‘/Remote.htm', trigger:
n:
</seript>
<a hrefa'#* class="trigger'>Click MEL</a>

erigger' ));

<aiv clas:
Loading
</aiv>

Saitindow” id="aialog™>
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retum RedirectToaction(Details®, new ( i

imner .DinnerI )):
)
caten (

Hodelstate. AddlodelErrors (dinner . GetRuleViolations () 1

retum View(new DinnerFornViewodel (dimner)) ;
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public TEnumerable<RuleViolation> GetRuleViolations() (
viela break;
)

partial void onvalidate (ChangeAction action) (
if (Tevalia)
throw new ApplicationBxception(*Rule violations prevent saving'):
)
)
public class Ruleviolation (

public string BrrorMessage ( get; private set; )
public string Propertylame ( get; private set; )

public Rulsviolation(string errorMessage) (
Errorliessage = errorliessage;
)

public RuleViolation(string errorMessage, string propertyllame) (
Errorliessage = errorliessage;
Propertyliane = propertyliame;
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DinnersController CreateDinnersControllerhs(string userName) (

var mock = new Hock<Controllercontext> ();
mock. SetupGet (p => p.HttpContext.User. Identity.Nane) .Returns (userlane)
mock.SetupGet (p => p.HttpContext. Request . IsAuthenticated) .Returns (true) ;

var controller = CreateDimnerscontroller();
controller.Controllercontext = mock.Objects

retumn controller;
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<%= Html.ValidationMessage(“EventDate®) %>
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public interface IRouteConstraint
«
bool Mateh (HttpContextBase httpContext, Route route, string parametertame,
RouteValuebictionary values, Routebirection routebirection):
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<input type=*hidden® value="012837udny31w90hjhf7u">
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public ActionResult List()
«
var products = new List<Product>();
for(int i = 0; i< 10; iss)
«
products.Add(new Product (Productiiane = "Product * + 1))
)
ViewData[“Products®] = products;
return view():
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public ActionResult Edit(int id) {
var product = new Product (Name = "ASP.NET MVC')

ViewData["Name*) = product Name;

return view():
)
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| @yacunetix |G
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You searched for*

Please login with the form below before proceeding:
Login:
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"
7/ GET: /Dinners/
" /Dinners?pages2

public ActionResult Index(int? page) (
const int pagesize = 10;
var upcomingDinners = dinnerRepository. PindUpconingDinners();
var paginatedDinners = upconingDinners.Skip((page 72 0) * pagesize)
-Take (pagesize)
ToList();

return View(paginatedDimners);
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<td><i= Html.Encode (p.ProductName) ¥></td>
<td<ts p.Uniterice te/td>

</te

@)

</table>

@) B
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public class Mycontroller : Controller
«

public ActionResult Action2() ()
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<3@ Master Language="C#" %>
<IDOCTYPE html PUBLIC °-//W3C//DTD XHTHL 1.0 Strict//EN"
"BEED: / /v w3 org/ TR /¥html1/DTD/xhtml1-strict .drd">

<html xmins:
<head>
<titleshy Club Site</title
<link types-text/ces® rel="Stylesheet® href
</head>

“BEtp: //inns. w3 0rg/1999 /xhtnl® xnl:lang="en® lang="en">

clubsite.css® />

<body>
<div 1ds"poster®>
<hl><a href="default.aspx*>Hy Club Site</a></hl>
<h2>My Club Site tag line or slogan</h2>
</aiv>
<div class="none’>
<a href="4content_start*>skip Repetitive Navigational Links</a></div>
<div 1d="navtop*>
<asp:SiteNapDatasource TDs"SiteMapDataSourcel” runats’server”
Showstart ingliode=" false />
<asp:Repeater ID="TopllavRepeat® runats*server"
DataSourcelD="SitelapDatasourcel >
<HeaderTenplate>
ul>
</Meadertemplate>
<Itenfenplate>
<1i>
<asp:HyperLink ID="HyperLinkl® runat="server® Texts'<ts
Eval(*Title') %' NavigateUrl='<i# Eval("Url’) &>’
ToolTip="<4# Bval(“Description) %> />
<>
</Ttemtenplate>
<Footertemplate>
<ru1>
</FooterTemplate>
</asp:Repeater>
</aiv>

<form id="forml® rumat="server">
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Request [—»| Routing | Contraler

1

Response «—ViewEngine f«—{ViewResult






OEBPS/guth_9780470549230_oeb_281_r1.gif
<%= Heml.ValidationSumeary() &>
<4 using (Htmd.BeginForn()) ( %>
<fielaset>

<aiv 1
<

“ainnerDiv>

[KTUL Form Elements Removed for Brevity]
</p>
o
<input types"subnit® valuesSave' />
</p>
</aiv>

<div ids"mapbiv'>
<t Heml.RenderPartial (*Map", Model.Dinner); >
</aiv>

</tieldset>
<script type="text/Javascript®>
§(docunent) . ready (function() (
§(*+Adaress*) .blur (function(evt) {
§(*sLatitude’) val("*);
§(*#Longitude") .val (") ;
var address = jouery.trim(§(“#Address’).val());
if (adaress.length < 1)
retumn;
FindaddressOniiap (address) ;
i
»n:
</script>

<4 )%
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<h2>Find a Dinner</h2>
<div id="mapDivieft >
<div 1d="searchBox™>

Bater your location: <
search® type:

Henl TextBox *Location’)
subnit® value=-Search® />

</arv>

<div 14="napDivRight >
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public AetionResult ListProducts()
«
//psendo code
TList<Product> products = SomeRepository.GetProducts();
retum View (products) ;
)
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<% using (Html.BeginForm()) ( %>
<tielasers
<t- Pields Onitted for Brevity —

s

submit® valu

<input typ: saver />

</p>
</ticlaset>

@) w
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var httpContextlock = new Mock<HttpContextBase>();
Bttpcontextliock. Expect (c => c.Request

AppRelat iveCurrentExecut onFilepath)

Returns (*~/product/1ist")
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RouteTable. Routes. Add (new Route(*fizzbin”,
new WebPornRouteHandler (*~/adnin/ secretpage. aspx’) )
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URL URL Parameter Values
/products/aisplay/123 (gixet) = products
(second) = display
(thira) = 123
/200/bar /baz (girst) = foo
(secona) = bar
(thira) = baz
/a-p/e-ase-t (girst) = "a.pt
(secona) = "c-a*

(thira) =

et
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[Authorize (Roles="Adnins, SuperAdmins®))
public class AdminController
«

//0n1y adnins should see this

public ActionResult Index()

«

return view():
)

//0nly Phil should do this.
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public ActionResult Delete(int id) (
Dimer dinner = dinnerRepository.GetDinner (1d);

if (@imner == null)
return View(“NotFound®);
else
return View(dinner) ;

)
”
7/ WITP POST: /Dinners /Delete/1

[Acoepterbs (Hetpverbs. Bost) |
publlic ActionResult Delete(int id, string contirmButton)

Dimer dinner = dinnerRepository.GetDinner (id);

1f (@mner == null)
retumn View(“NotPound®);

AinnerRepository.Delete (dinner)
QimnerRepository.save()

return View(“Deleted");
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public partial class Dimner (

publlic bool TsUserRegistered(string userliane) (
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using System.Heb. Routing;

"

protected void Application_Start(object sender, BventArgs e)
«

RouteTable. Routes . HapRoute
“Default
“home/ (act ion) /(1) "
new ( controller = "Home', action = “Index, id =






OEBPS/guth_9780470549230_oeb_335_r1.gif
7/ Arrange
var controller = CreateDimnerscontroller ();

11 et
var result = controller.Details(l);

17 Assert
Assert . TsInstanceofType (result, typeof (ViewResult)):

)

[Testhethod)
public void Detailshction_Should_Return NotPoundView_For_Bogusbimner() (

17 arrange
var controller = CreateDimnerscontroller();

/1 het
var result = controller.Details(s99) as ViewResult;

11 Bssert
Assert.AreBqual (“NotFound®, result.Viewliane);
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«
return View():
)

[Acoeptverbs (Httpverbs. Post) )
public ActionResult EAit(string id, Formcollection form)
«

//save the item and redirect.
)
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<input id=" Name' names’Name' type="text' values'ASP.NET MVC® />
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Teturn View(“Details®, dinner);
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1" /Dinners/Page/2
publlic ActionResult Tndex(int? page) (
const int pagesize = 10;
var upcomingbinners = dinnerRepository. PindUpconingDinners () ;
var paginatedbinners = new PaginatedLit<Dinner> (upeomingDinners,
page 22 0,
pagesize);

return View(paginateddimers) ;
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public static string UnorderedList<T>(this HtmlHelper html, IEnumerable<T> items) (
if (heml == mull)
«

throw new ArgumentiiullException (*html®

)

String ul = “eulst;
foreach (var item in items)
«
Wl 4= "<li>® 4 henl Encode(item.ToString()) + "</1i>";
)
return ul + *</ul>*
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<asp:Content ID="Title" ContentPlaceHolderID="head" runat:
Delete Confimation: <d<Htnl.Encode (Hodel.Title) %>
</asp:Content>

<asp:Content ID="Hain® ContentPlaceHolderID="HainContent" server®>

nz>

Delete Confirmation
</mas
<aiv>

<p>Please confirn you want to cancel the dimner titled:

<i> <tsHtnl.Bncods (Model.Title) 57 </i> </p>
</aiv
<t using (Heal.BeginForn()) ( %>

Delete />

</asp:Content>
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<a hrefs"<8sUrl.Action(AuthorUrl)3>"><t=AuthorUrlt></a>
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List<Route> _internalRoutes = new List<Route>();
public string Resource ( get; private set; )

public RestRoute(string resource)
«

this Resource = resource;

HapRoute (resource, *index”, "GET', mull);
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public class ProductsController :

«
public ActionResult List()
«
//Do something
retumn View():
)
)

Controller
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public OrderController ()
«
_paymentService = new BankPaymentService (userllame®, ‘password’);
Caddressvalidator = new USGeoLocatorService() ;
ehippingservice = new FedexshippingService() ;
salesTaxservice = new OnlineSalesTaxService (“usernane”, *password®);
TnailerService = new SUTPHailerService();
Corderservice = new orderservice (new SqlorderRepository() //
)
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<t= Html.Encode (ViewDatal Message"]) %>
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public
public
public
public

virtual
virtual
virtual
virtual

void OnActionExecuted (ActionExecutedContext filterContext);
void OnAct lonExecuting (ActionExecutingContext filtexcontext):
void OnResultExecuted (ResultExecutedContext filterContext):

void OnResultExecuting (ResultExecutingContext filtexcontext):
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public class DinnerRepository (

private NerdDinnerDatacontext db = new NerdDinnerDataContext();
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RouteCollection routes = new RouteCollection():

Mychpplication. RegisterRoutes (routes) ;

var httpcontexthiock = new HockeHttpContextBase>();

BttpContextiiock. Bipect (¢ => c.Request
AppRelativeCurrentExecut ionFi lePath) .Returns (*~/product /1ist ") ;

I7act
RouteData routeData = routes.GetRouteData (httpcontexthock.Object) ;

I/assext
Assert.Tallotiiull (routeData, *Should have found the route');
hssert . AreEqual ("product”, routeData.values(*Cantroller']);
hssert AreEqual (“list", routeData.Values[‘action*]);
Assert AreEqual (", routeData.Values(*id"]);
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You've been blocked by the NoAuth filter.






OEBPS/guth_9780470549230_oeb_025_r1.gif
POETET T IPEN AERCHEREIEY)
BT ey F=E1]

5 o e G
& @ s
e

110 otsconicv s s - - 0 = 40230 3,
P oy

eatine P
oSt DTt
RSN S g
o NemaTat






OEBPS/guth_9780470549230_oeb_777_r1.gif
protected void Buttonl Click(object sender, Eventhrgs e)
«
Session[*session_nessage*] = *This is a test';
Response.Redirect (*/Home/", true);
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<asp:Content ID="Title" ContentPlaceHolderID="TitleContent® runat="server'>
Edit: <t=Htnl.Encode(Hodel .Dinner.Title) 3>
</asp:content>

Bait* ContentPlaceHolderID="HainContent" runa

<asp:Content 1 server'>
<h2>Eait Dinner</h2>
<t Heml RenderPartial (“DinnerForn’); 3>

</asp:Content>
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map. connect ' :controller/:action/:id'
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1"
77 ceT: /pinners/

public ActionResult Index() (

var dinners = dinnerRepository.FindUpconingDinners () ToList ();

return View(diners) ;
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<script src="/Scripts/AjaxControlToolkit.ExtenderBase.BaseScripts. js*
types"text/Javascript ></script>

<script srce* /Scripts/AjaxControlToolkit Comnon. Common. Js*
type="text/Javascript-></script>

<script srce/Scripts/AjaxcontrolToolkit. Animation. Animations. js*
types"text/javascript*></script>
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1/ Perform HTTP redirect to details page for the saved Dinner
retum RedirectToAction(*Details®, new  id = dinner.DimerID });
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"
77 GET: /Dinners/petails/s

public ActionResult Details(int id) (
Dinner dinner = dinnerRepository.GetDimer (1d) ;

if (@inner == null)
retum View(“NotFound®):

retum View(dinner) ;
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public class Productservice(

publlic void SetProductsivailability()
«
HYDAL dalenew NYDAL();

TList<Product> products=dal.GetProducts();
foreach (Product p in products)
«

p-Availability = p.Stocklevel > 0 2 “Available® : “Not available’
)
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if (String. IehullorEnpty (Hostedsy))

Yield return new RuleViolation(*HostedBy required”, ‘Hostedsy')

i (String.Tenllorempty (Address))
vield return new RuleViolation(*Address required", "Address’):

$f (String.TenullorEmpty (Country))
vield return new RuleViolation("Country required", "Country'):

if (String. IshullorEupty (ContactPhone) )
vield return new RuleViolation("Phonet required’, -ContactPhone’)

if (!PhoneValidator. IsValidllunber (ContactPhone, Country))
vie1d return new RuleViolation("Phonet does not match country”,

vield break;
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function callbackUpdateNapDinners (layer, resultsArray,
blaces, hasttors, VEErrorliessage) (

§("saimerList") .empty ();
Clearliap();
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»>
<label for="Title*>Dinner Title:</label>
<t= Heml.TextBox(*Title*, Model.Dimner.Title) ¥
<3= Heml Validationliessage("Titler, "+*) %>
</p>
P
<label fors"Country*>Country:</label>
Henl DropbownList (*Country”, Model.Countries) ¥
Heml.Validationlessage (*Country”, **%) %>
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public interface IView
«

7/ Wethods

v0id Render (ViewContext viewContext, Textiriter writer):
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<= Html.RadioButton('color®, ‘red') %>
Htnl . RadioButton(*color”, ‘blue’, true) %>
<t= Hem RadicButton(color®, “green) &>
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<t= Ajax.Actionlink(*click’, “DoSomething’, new Ajaxoptions()) ¥
<div 1d="some-aiv"></div>
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/proauct /bolts.aspx
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<%= Html.ActionLink(“Link Text®, "AnotherAction®) %>
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‘query=Hello¥20Ajax!&X-Requested-With=XMLHt tpRequest.
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[Authorize (Users="NinjaBob, Supemman®) |
public class TopSecretController:Controller
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<html xmlns="http://wiw.w3.org/1999 /xhtml® xml:lang="en’ lang="en'>
<head>
<titlesly Club Sitec/title
toxt/css* re

‘Styleshest* href="content/clubsite.css® />
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public class DinnerRepository (
private NerdDinnerDataContext db = new NerdDinnerDataContext();

7"
/7 query Methods

public Igueryable<Dinner> PindUpconingDinners() (
retum fron dimner in db.Dinners
where dinner .EventDate > DateTine.Now
orderby dimner.Eventbate
select amner;
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ViewData|“product*)
return View();
)
)
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MyClass instance = new MyClass (Northwind.Instance);
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public class Simple2Controller : Controller
«
public void Goodbye (string id)
«
Response. firite("Goodbye * + HEtpUEility.HemlEncode (id));
)
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<3 Htnl.RenderPartial (*DinnerForm®) %>
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public interface IViewEngine
«
ViewmngineResult FindpartialView(Controllercontext controllercontext,
string partialViewtiane) ;
ViewEngineResult FindView(Controllercontext controllerContext, string viewlame,
string nastexrliane) ;
void ReleaseView(Controllercontext controllercontext, IView view:

)
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<asp:Content ID="Title® ContentPlaceHolderID="TitleContent runat
<t= Htnl.Encode (Model.Title) %>
</asp:Content>

<asp:Content ID="details" ContentPlaceHolderID="MainContent’ runats"server'>
<atv idedinnerDive>

<nz><
s

Heml Encode (Model Title) ¥></h2>

<strongihen: </strong>
Hodel.EventDate . ToshortDateString () >

<strong></strong>
Hodel.EventDate  ToshortTineString () %>

</p>
P
<strong>iere:</strong>
Htnl. Encodo (Hodel .Address) >,
Henl.Encode (Model Country) %>

</p>

o
<strong>Description:</strong>
<t= Heml Encods (Hodel .Description) 3>

</p>

P

<strong>organizer:</strong>
Htnl.Bncode (Model HostedBy) ¥

(3= Htnl Encode (Hodel.ContactPhone) 3>)
</p>

<4 HemlRenderPartial ("RSVEStatus'); ¥
<4 HemlRenderPartial (*EditAndDeletelinks"); %>

</atv>
<aiv ids"napDiv'>

<t Htnl Renderpartial ("map’); %>
</atv>

</asp:Content>





OEBPS/guth_9780470549230_oeb_514_r1.gif
public void RenderPartial (string partialviewtiame) :

public void RenderPartial (string partialVieuliame, object model);

public void RenderPartial (string partialViewliame, ViewbataDictionary viewbata):

public void RenderPartial (string partialVieliame, object model,
ViewbataDictionary viewData) :
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(Authorize)
public class UsersController
«
public ActionResult ManageProfile()
«
I
return View();
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Option

Description

Instancescope. Hetplontext

Instancescope. Hybrid

Instancescope. PerRequest

Instancescope. Singleton

Instancescope. ThreadLocal

Keeps the instance cached for the lifetime of the
Hetpcontext

Does the same as He epcontext, however it compensates if
the Hetpcontext is not present

Keeps the object alive only for the length of the current
HetpRequest

Manages the instantiation of the object and treats it as
asingleton

Manages a single instance per thread in your application
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var routes = new RouteCollection();
Globalapplication. RegisterRoutes (routes);

//irite tests to verify your routes here..
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(AttributeUsage (AttributeTargets.Class | AttributeTargets.Method, Inherited = true,
Allowltiple = false)]

public class LogItAttribute : FilterAttribute, IExceptionFilter

[
public void OnBxception (ExceptionContext filtercontext)
«

var trace = £ilterContext.HttpContext.Trace;

trace.firite(*Action * + (string) filterContext.RouteData.Values(‘action’] +
“called.", “Message'):

if (filtercontext Exception
«

trace.irite(filterContext Bxception. Message, “Exceptiont!!
)

null)

)
3
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public class DinnersController : Controller (
DinnerRepository dinnerRepository = new DinnerRepository():

7"
7/ GET: /Dimners/

public ActionResult Index() (
var aimners = dinnerRepository. FindUpcomingDinners () .ToList ();
return View(dinners);

)

7"
77 GET: /Dinners/Details/2

public ActionResult Details(int i4) (
Dinner dinner = dinnerRepository.GetDinner (i) ;
if (@tmer == null)
retumn View(“NotPound®);

else
return View(dinner) :

)

7"
/1 GET: /Dimners/Eait/2

public ActionResult Edit(int i) (
Dinner dinner = dinnerRepository.GetDinner (1d);
retumn View(dinner)

)

"
7/ ®0ST: /Dimners/eait/2

[Rcceptverbs (Httpverbs. Bost) |
public ActionResult Edit(int id, FormCollection formvalues) (
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Directory

Purpose

Jcontrollers
Jiodels
Ivieus
/seripts

/content

/hpp_Data

Where you put Controller classes that handle URL requests

Where you put clas

S that represent and manipulate data
Where you put UI template files that are responsible for rendering output
Where you put JavaSeript library files and scripts (js)

Where you put CS8 and image files, and other non-dynamic/non-JavaScript
content

Where you store data files you want to read/write.
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Dioniction]
public string GetSensitiveInformation()
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public abstract class ActionSelectorhttribute : Attribute
0
public abstract bool IsValidPorRequest (ControllerContext controllerContext
. MethodTno methodInto);
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1"
7/ GET: /Dinners/Eait/s

(Ruthorize]
public ActionResult Edit(int i) (

Dinner dinner = dinnerRepository.GetDinner (1d);

if (‘dinner. IsHostedBy (User. Identity.Name))
zetum View(“Invalidowner®) ;

retum View(new DinnerPornViewtodel (dimner)) ;
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Property Description

canceled Indicates whether or not another flter canceled the action.

Exception fan exception was thrown before the current filter was called, this property
contains that exception.

ExceptionHandled  Setting this to true indicates to the action invoker (and other action filters)
that the exception has been handled and that the result may be exceuted.

Result ‘The action result returned by the action method (or another action

filter). The filter can modify or replace this result.
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[Testiethod)
public void UnorderedListWithNullThrowsArgunentException ()
«
Assert.Throws<ArgumenthullException> () =>
MyHelpers.UnorderedList (null, new int() ( ))
)
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<div i

‘TSVpmSg®>
< 1€ (Request. Ishuthenticated) ( t
< i€ (Hodel.TsUserRegistered (Context .User . Tdentity Nane)) ( 3>
<po¥ou are registered for this eventi</p>
@) else (>
<4= Max.ActionLink( "RSVP for this event,
“Register®, "RSVE"

new ( id=Model.DinnerID ),
new Afaxoptions ( UpdateTargetId='rsvpmeg® )] %

ERRS
@) else (>

<a hrefe" /Account /Logen®>Logen</a> to RSV for this event
@ e

</aiv
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"
77 WYTP GET: /Dinners/Delete/l

public ActionResult Delete(int id) (
Dimer dinner = dinnerRepository.GetDinner (id);
if (@inner == mull)
return View(“NotPound®);

else
return View(dinner)
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(Testiethod]
public void AboutReturnsAboutview()
«
HoneController controller = new HomeController();
VieuResult result = controller.About() as ViewResult;

Assert.AreEqual(“About”, result.Viewlame):
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Dooe R

My MVC Application
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<span class="field-validation-error">Ouch</span>
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Q  {eitle)-(author)
Q  sook(title)and(foo)
Q  (filename) . (ext]
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Key Value

Controller home

Action list
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Henl RouteLink (*Link Text”, new (actions*AnotherAction’)) %
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DinnerRepository dinnerRepository = new DinnerRepository():

1/ Retrieve specific dimer by its DimnerID
Dimner dinner = dimnerRepository.GetDinner (s);
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public class HomeController : Controller
«
public ActionResult Index()
«
VieuData["Title
VieuDatal "Message’] =

“Hone Page";
Welcome to ASP.NET MVCI;

return view():
)
)
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[Testhethod]
public void OrderController_Does _Not_Redirect To_ReceiptView ifhen_Payment Denied()
«

//a mock service that alvays denies the transaction

TPaynentservice paynentservice = new AlvaysDenyPaymentService();

//a mock service that alvays validates the address
ThddressValidator addressValidator = new
Aluaysvalidaterddressvalidator ();

//a mock service that returns simple shipping calculations
IShippingService shippingService = new TestShippingService()

//static class that reports tax rates based on state
ISalesTaxRepository taxRepository=new USStateTaxRepository():
TSalesTaxservice taxService = new SalesTaxService (taxRepository);

//Stubbed mailer service that sends email to a List<Haller>
//aes not use SuTR
THatlerservice mailerService = new TestMailerservice():

TorderRepository orderRepository = new TestOrderRepository():
TorderService orderservicesnew OrderService (orderRepository):

oxdercontroller controllersnew OrderController(
paymentservice,
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n
77 GET: /Dinners/create
(Authorize]

public ActionResult Create() (

)

"
77 ®0ST: /Dimners/Create

[Acoepterbs (HetpVerbs. Post) , Authorize]
publlic ActionResult Create(Dimner dinnerTocreate) (
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public void RegisterRoutes (RouteCollection routes)
«

routes. IgnoreRoute " (resource) .axd/ (*pathInto} ") ;

routes.HapRoute(
"pefault, 17 Route name
*(controller}/(action) /(id)", 7/ URL w/ parans
new ( controller="Home®, action="Index’, id="* ) // Param defaults
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input-validation-error
«
border: 1px solid +££0000;
background-color: #ffesse;
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public class IsPostedFromThisSiteAttribute : AuthorizeAttribute
«

public override void OnAuthorize(AuthorizationContext filtercontext)
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public interface IController
«

void Execute (RequestContext requestContext):
)
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where p.Productliane. StartsWith(query)
select p).ToList():

)

4f (Request . IshjaxRequest ()) (
return View("ProductSearchResults”, products);
Jelse(

retumn View(products) ;

)
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[TestClass)
public class DimnerTest (

[Testethoa)
public void Diner_Should Not_Be_Valid_ihen_Some_Properties_Incorrect () (

//Arrange
Dimer dinner = new Dimner() (
Title = “Test titler,

Country = "usa’,
ContactPhone = “BOGUS*
)

11 Act
bool isvalid = dinner.IsValid;

//Rssert
Assert. IsFalse (isvalid) ;
)

[Testhethod)
public voia Dinner_Should_Be_Valid When All_roperties_Correct() (

//Arange
Dimer dinner = new Dinner (
Title = “Test title®,
Description = *Some description’,
BventDate = DateTime.liow,
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First, you can use standard <¢ &> syntax:

<«
int total = 0;
foreach(var item in items)
«

total

ten. Quant it

IS
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<t= Heml TextBox("Longitude’) 1>
<t= Htnl Validationliessage (“Longitude®, "**) %>

</p>

P

<input type="subnit® value="Save® />
</p>
</fielaset>
@) e

</asp:Content>





